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Using the Installer for Computer
Vision System Toolbox Product

• “Install Computer Vision System Toolbox Support Packages” on page 1-2
• “OCR Language Data” on page 1-5
• “OpenCV Interface” on page 1-8
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Install Computer Vision System Toolbox Support Packages

This example shows how to add third-party data files. After you complete this process,
you can use the data with the Computer Vision System Toolbox™ product.

1 In a MATLAB® Command Window, type:

visionSupportPackages

2 In the Support Package Installer, follow the instructions for installation. For more
information about the options on a particular screen, click Help.

3 At Select support package to install select the data you want to add:

• Computer Vision System Toolbox OCR Language Data

• Computer Vision System Toolbox OpenCV Interface
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4 Accept or change the installation folder and click Next.

Note: You must have write privileges for the Installation folder.

5 Follow the remaining prompts to download and install the support package.

The installation process adds one or both of these items:
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• Computer Vision System Toolbox OCR Language Data
• Computer Vision System Toolbox OpenCV Interface

When a new version of MATLAB software is released, repeat this process to check for
updates. You can also check for updates between releases.

More About
• “OCR Language Data”
• “OpenCV Interface”
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OCR Language Data

Install OCR Language Data

Use the visionSupportPackages function to launch the Support Package Installer.
Follow the steps in the “Install Computer Vision System Toolbox Support Packages”
directions.

Pretrained Language Data and the ocr function

The OCR Language Data support package contains pretrained language data files from
the OCR Engine page, tesseract-ocr, to use with the ocr function. After you install the
pretrained language data files, you can specify one or more additional languages using
the Language property of the ocr function. Use the appropriate language string with the
property.

txt = ocr(img,'Language','Finnish');

List of OCR language data in support package

• 'Afrikaans'

• 'Albanian'

• 'AncientGreek'

• 'Arabic'

• 'Azerbaijani'

• 'Basque'

• 'Belarusian'

• 'Bengali'

• 'Bulgarian'

• 'Catalan'

• 'Cherokee'

• 'ChineseSimplified'

• 'ChineseTraditional'

• 'Croatian'

• 'Czech'

http://code.google.com/p/tesseract-ocr/
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• 'Danish'

• 'Dutch'

• 'English'

• 'Esperanto'

• 'EsperantoAlternative'

• 'Estonian'

• 'Finnish'

• 'Frankish'

• 'French'

• 'Galician'

• 'German'

• 'Greek'

• 'Hebrew'

• 'Hindi'

• 'Hungarian'

• 'Icelandic'

• 'Indonesian'

• 'Italian'

• 'ItalianOld'

• 'Japanese'

• 'Kannada'

• 'Korean'

• 'Latvian'

• 'Lithuanian'

• 'Macedonian'

• 'Malay'

• 'Malayalam'

• 'Maltese'

• 'MathEquation'

• 'MiddleEnglish'
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• 'MiddleFrench'

• 'Norwegian'

• 'Polish'

• 'Portuguese'

• 'Romanian'

• 'Russian'

• 'SerbianLatin'

• 'Slovakian'

• 'Slovenian'

• 'Spanish'

• 'SpanishOld'

• 'Swahili'

• 'Swedish'

• 'Tagalog'

• 'Tamil'

• 'Telugu'

• 'Thai'

• 'Turkish'

• 'Ukrainian'

See Also
ocr | visionSupportPackages

More About
• “Install Computer Vision System Toolbox Support Packages”
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OpenCV Interface

Install OpenCV Interface Files

The OpenCV Support package helps you integrate your OpenCV C++ code into
MATLAB. It lets you build MEX files that calls OpenCV functions. Use the
visionSupportPackages function to launch the Support Package Installer. Follow the
steps in the “Install Computer Vision System Toolbox Support Packages” directions.

Support Package Contents

The Computer Vision System Toolbox OpenCV Interface support package installs all
the files you need in the visionopencv folder. To find the path to this folder, type the
following command:

which mexOpenCV.m

The visionopencv folder contains:
example folder: Template Matching, Foreground Detector, and Oriented FAST and
Rotated BRIEF (ORB) examples. Each subfolder contains a README.txt file with step-
by-step instructions.
opencv folder: OpenCV header files, library files (for Windows® only), and OpenCV
license file.
registry folder: Registration files.
mexOpenCV.m file: Function to build MEX files.
README.txt file: Help file.

Create an OpenCV MEX file

Call the mexOpenCV function with your source file.

>> mexOpenCV yourfile.cpp

For help creating MEX files, type the following at the MATLAB command prompt:

help mexOpenCV

OpenCV Examples

The OpenCV Interface support package includes three examples. Each example subfolder
contains all the files you need to run the example. To run an example, you must call the
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mexOpenCV function with one of the supplied source files. Each example subfolder also
contains a README.txt file with specific instructions.

Template Matching

To run the Template Matching example, follow these steps:

1 Change your current working folder to the example/TemplateMatching folder.
2 Create the MEX-file from the source file:

mexOpenCV matchTemplateOCV.cpp

3 Run the test script, which uses the generated MEX-file:

testMatchTemplate.m

Foreground Detector

To run the Foreground Detector example, follow these steps:

1 Change your current working folder to the example/ForegroundDetector folder.
2 Create the MEX-file from the source file:

mexOpenCV backgroundSubtractorOCV.cpp

3 Run the test script, which uses the generated MEX-file:

testBackgroundSubtractor.m

Detect ORB Features

To run the Oriented FAST and Rotated BRIEF (ORB) Detector example, follow these
steps:

1 Change your current working folder to the example/ORB folder.
2 Create the MEX-file for the detector from the source file:

mexOpenCV detectORBFeaturesOCV.cpp

3 Create the MEX-file for the extractor from the source file:

mexOpenCV extractORBFeaturesOCV.cpp

4 Run the test script, which uses the generated MEX-files:

testORBFeaturesOCV.m
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See Also
visionSupportPackages

More About
• “Install Computer Vision System Toolbox Support Packages”

External Web Sites
• Using OpenCV with MATLAB

http://www.mathworks.com/videos/using-opencv-with-matlab-97710.html
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Input, Output, and Conversions

Learn how to import and export videos, and perform color space and video image
conversions.

• “Export to Video Files” on page 2-2
• “Import from Video Files” on page 2-4
• “Batch Process Image Files” on page 2-6
• “Display a Sequence of Images” on page 2-8
• “Partition Video Frames to Multiple Image Files” on page 2-11
• “Combine Video and Audio Streams” on page 2-15
• “Import MATLAB Workspace Variables” on page 2-17
• “Transmit Audio and Video Content Over Network” on page 2-19
• “Resample Image Chroma” on page 2-21
• “Convert Intensity to Binary Images” on page 2-25
• “Convert R'G'B' to Intensity Images” on page 2-35
• “Process Multidimensional Color Video Signals” on page 2-39
• “Video Formats” on page 2-44
• “Image Formats” on page 2-46
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Export to Video Files

The Computer Vision System Toolbox blocks enable you to export video data from your
Simulink® model. In this example, you use the To Multimedia File block to export a
multimedia file from your model. This example also uses Gain blocks from the Math
Operations Simulink library.

You can open the example model by typing

ex_export_to_mmf

at the MATLAB command line.

1 Run your model.
2 You can view your video in the To Video Display window.

By increasing the red, green, and blue color values, you increase the contrast of the
video. The To Multimedia File block exports the video data from the Simulink model to a
multimedia file that it creates in your current folder.

This example manipulated the video stream and exported it from a Simulink model to a
multimedia file. For more information, see the To Multimedia File block reference page.

Setting Block Parameters for this Example

The block parameters in this example were modified from default values as follows:
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Block Parameter

Gain The Gain blocks are used to increase the red, green, and blue
values of the video stream. This increases the contrast of the
video:

• Main pane, Gain = 1.2
• Signal Attributes pane, Output data type = Inherit:

Same as input

To Multimedia File The To Multimedia File block exports the video to a
multimedia file:

• Output file name = my_output.avi
• Write = Video only
• Image signal = Separate color signals

Configuration Parameters

You can locate the Model Configuration Parameters by selecting Model
Configuration Parameters from the Simulation menu. For this example, the
parameters on the Solver pane, are set as follows:

• Stop time = 20
• Type = Fixed-step
• Solver = Discrete (no continuous states)
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Import from Video Files

In this example, you use the From Multimedia File source block to import a video stream
into a Simulink model and the To Video Display sink block to view it. This procedure
assumes you are working on a Windows platform.

You can open the example model by typing

ex_import_mmf

at the MATLAB command line.

1 Run your model.
2 View your video in the To Video Display window that automatically appears when

you start your simulation.

Note: The video that is displayed in the To Video Display window runs at the frame
rate that corresponds to the input sample time. To run the video as fast as Simulink
processes the video frames, use the Video Viewer block.

You have now imported and displayed a multimedia file in the Simulink model. In the
“Export to Video Files” on page 2-2 example you can manipulate your video stream and
export it to a multimedia file.

For more information on the blocks used in this example, see the From Multimedia File
and To Video Display block reference pages.
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Setting Block Parameters for this Example

The block parameters in this example were modified from default values as follows:

Block Parameter

From Multimedia
File

Use the From Multimedia File block to import the multimedia
file into the model:

• If you do not have your own multimedia file, use the default
vipmen.avi file, for the File name parameter.

• If the multimedia file is on your MATLAB path, enter the
filename for the File name parameter.

• If the file is not on your MATLAB path, use the Browse
button to locate the multimedia file.

• Set the Image signal parameter to Separate color
signals.

By default, the Number of times to play file parameter
is set to inf. The model continues to play the file until the
simulation stops.

To Video Display Use the To Video Display block to view the multimedia file.

• Image signal: Separate color signals

Set this parameter from the Settings menu of the display
viewer.

Configuration Parameters

You can locate the Model Configuration Parameters by selecting Model
Configuration Parameters from the Simulation menu. For this example, the
parameters on the Solver pane, are set as follows:

• Stop time = 20
• Type = Fixed-step
• Solver = Discrete (no continuous states)
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Batch Process Image Files

A common image processing task is to apply an image processing algorithm to a series of
files. In this example, you import a sequence of images from a folder into the MATLAB
workspace.

Note: In this example, the image files are a set of 10 microscope images of rat prostate
cancer cells. These files are only the first 10 of 100 images acquired.

1 Specify the folder containing the images, and use this information to create a list of
the file names, as follows:

fileFolder = fullfile(matlabroot,'toolbox','images','imdemos');

dirOutput = dir(fullfile(fileFolder,'AT3_1m4_*.tif'));

fileNames = {dirOutput.name}'

2 View one of the images, using the following command sequence:

I = imread(fileNames{1});

imshow(I);

text(size(I,2),size(I,1)+15, ...

    'Image files courtesy of Alan Partin', ...

    'FontSize',7,'HorizontalAlignment','right');

text(size(I,2),size(I,1)+25, ....

    'Johns Hopkins University', ...

    'FontSize',7,'HorizontalAlignment','right');

3 Use a for loop to create a variable that stores the entire image sequence. You can use
this variable to import the sequence into Simulink.

for i = 1:length(fileNames)

    my_video(:,:,i) = imread(fileNames{i});

end

For additional information about batch processing, see the “Batch Processing Image Files
in Parallel” example in the Image Processing Toolbox™.
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Configuration Parameters

You can locate the Model Configuration Parameters by selecting Model
Configuration Parameters from the Simulation menu. For this example, the
parameters on the Solver pane, are set as follows:

• Stop time = 10
• Type = Fixed-step
• Solver = Discrete (no continuous states)
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Display a Sequence of Images

This example displays a sequence of images, which were saved in a folder, and then
stored in a variable in the MATLAB workspace. At load time, this model executes the
code from the “Batch Process Image Files” on page 2-6 example, which stores images in a
workspace variable.

You can open the example model by typing

ex_display_sequence_of_images

at the MATLAB command line.

1 The Video From Workspace block reads the files from the MATLAB workspace. The
Signal parameter is set to the name of the variable for the stored images. For this
example, it is set to my_video.

2 The Video Viewer block displays the sequence of images.
3 Run your model. You can view the image sequence in the Video Viewer window.
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4 Because the Video From Workspace block's Sample time parameter is set to 1 and
the Stop time parameter in the configuration parameters, is set to 10, the Video
Viewer block displays 10 images before the simulation stops.

Pre-loading Code

To find or modify the pre-loaded code, select File > Model Properties > Model
Properties. Then select the Callbacks tab. For more details on how to set-up callbacks,
see “Callbacks for Customized Model Behavior”.
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Configuration Parameters

You can locate the Model Configuration Parameters by selecting Model
Configuration Parameters from the Simulation menu. For this example, the
parameters on the Solver pane, are set as follows:

• Stop time = 10
• Type = Fixed-step
• Solver = Discrete (no continuous states)
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Partition Video Frames to Multiple Image Files
In this example, you use the To Multimedia File block, the Enabled Subsystem block, and
a trigger signal, to save portions of one AVI file to three separate AVI files.

You can open the example model with the link below or by typing

ex_vision_partition_video_frames_to_multiple_files

at the MATLAB command line.

1 Run your model.
2 The model saves the three output AVI files in your current folder.
3 View the resulting files by typing the following commands at the MATLAB command

prompt:

implay output1.avi

implay output2.avi

implay output3.avi 

4 Press the Play button.

For more information on the blocks used in this example, see the From Multimedia File,
Insert Text, Enabled Subsystem, and To Multimedia File block reference pages.

Setting Block Parameters for this Example

The block parameters in this example were modified from default values as follows:

Block Parameter

From Multimedia File The From Multimedia File block imports an AVI file into the
model.

• Cleared Inherit sample time from file checkbox.
Insert Text The example uses the Insert Text block to annotate the video

stream with frame numbers. The block writes the frame
number in green, in the upper-left corner of the output video
stream.

• Text: 'Frame %d'
• Color: [0 1 0]
• Location: [10 10]
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Block Parameter

To Multimedia File The To Multimedia File blocks send the video stream to three
separate AVI files. These block parameters were modified as
follows:

• Output file name: output1.avi, output2.avi, and
output3.avi, respectively

• Write: Video only
Counter The Counter block counts the number of video frames. The

example uses this information to specify which frames are
sent to which file. The block parameters are modified as
follows:

• Number of bits: 8
• Sample time: 1/30

Bias The bias block adds a bias to the input. The block parameters
are modified as follows:

• Bias: 1
Compare to Constant The Compare to Constant block sends frames 1 to 9 to the first

AVI file. The block parameters are modified as follows:

• Operator: <
• Constant value: 10

Compare to
Constant1
Compare to
Constant2

The Compare to Constant1 and Compare to Constant2
blocks send frames 10 to 19 to the second AVI file. The block
parameters are modified as follows:

• Operator: >=
• Constant value: 10

The Compare to Constant2 block parameters are modified as
follows:

• Operator: <
• Constant value: 20
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Block Parameter

Compare to
Constant3

The Compare to Constant3 block send frames 20 to 30 to the
third AVI file. The block parameters are modified as follows:

• Operator: >=
• Constant value: 20

Compare to
Constant4

The Compare to Constant4 block stopa the simulation
when the video reaches frame 30. The block parameters are
modified as follows:

• Operator: ==
• Constant value: 30
• Output data type mode: boolean

Using the Enabled Subsystem Block

Each To Multimedia File block gets inserted into one Enabled Subsystem block, and
connected to it's input. You can do this, by double-clicking the Enabled Subsystem blocks,
then click-and-drag a To Multimedia File block into it.

Each enabled subsystem should look similar to the subsystem shown in the following
figure.
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Configuration Parameters

You can locate the Model Configuration Parameters by selecting Model
Configuration Parameters from the Simulation menu. For this example, the
parameters on the Solver pane, are set as follows:

• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)
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Combine Video and Audio Streams

In this example, you use the From Multimedia File blocks to import video and audio
streams into a Simulink model. You then write the audio and video to a single file using
the To Multimedia File block.

You can open the example model by typing

ex_combine_video_and_audio_streams

on the MATLAB command line.

1 Run your model. The model creates a multimedia file called output.avi in your
current folder.

2 Play the multimedia file using a media player. The original video file now has an
audio component to it.

Setting Up the Video Input Block

The From Multimedia File block imports a video file into the model. During import, the
Inherit sample time from file check box is deselected, which enables the Desired
sample time parameter. The other default parameters are accepted.

The From Multimedia File block used for the input video file inherits its sample time
from the vipmen.avi file. For video signals, the sample time equals the frame period.
The frame period is defined as 1/(frame rate). Because the input video frame rate is 30
frames per second (fps), the block sets the frame period to 1/30 or 0.0333 seconds per
frame.

Setting Up the Audio Input Block

The From Multimedia File1 block imports an audio file into the model.

The Samples per audio frame parameter is set to 735. This output audio frame size
is calculated by dividing the frequency of the audio signal (22050 samples per second) by
the frame rate (approximately 30 frames per second).

You must adjust the audio signal frame period to match the frame period of the video
signal. The video frame period is 0.0333 seconds per frame. Because the frame period is
also defined as the frame size divided by frequency, you can calculate the frame period of
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the audio signal by dividing the frame size of the audio signal (735 samples per frame) by
the frequency (22050 samples per second) to get 0.0333 seconds per frame.
frame period = (frame size)/(frequency)
frame period = (735  samples per frame)/(22050 samples per second)
frame period = 0.0333 seconds per frame
Alternatively, you can verify that the frame period of the audio and video signals is the
same using a Simulink Probe block.

Setting Up the Output Block

The To Multimedia File block is used to output the audio and video signals to a single
multimedia file. The Video and audio option is selected for the Write parameter and
One multidimensional signal for the Image signal parameter. The other default
parameters are accepted.

Configuration Parameters

You can locate the Configuration Parameters by selecting Model Configuration
Parameters from the Simulation menu. The parameters, on the Solver pane, are set
as follows:

• Stop time = 10
• Type = Fixed-step
• Solver = Discrete (no continuous states)
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Import MATLAB Workspace Variables

You can import data from the MATLAB workspace using the Video From Workspace
block, which is created specifically for this task.
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Use the Signal parameter to specify the MATLAB workspace variable from which to
read. For more information about how to use this block, see the Video From Workspace
block reference page.



 Transmit Audio and Video Content Over Network

2-19

Transmit Audio and Video Content Over Network

MATLAB and Simulink support network streaming via the Microsoft® MMS protocol
(which is also known as the ASF, or advanced streaming format, protocol). This ability
is supported on Windows operating systems. If you are using other operating systems,
you can use UDP to transport your media streams. If you are using Simulink, use the To
Multimedia File and From Multimedia File blocks. If you are using MATLAB, use the
VideoFileWriter and the VideoFileReader System objects. It is possible to encode
and view these streams with other applications.

In order to view an MMS stream generated by MATLAB, you should use Internet
Explorer®, and provide the URL (e.g. "mms://127.0.0.1:81") to the stream which you
wish to read. If you wish to create an MMS stream which can be viewed by MATLAB,
download the Windows Media® Encoder or Microsoft Expression Encoder application,
and configure it to produce a stream on a particular port (e.g. 81). Then, specify that URL
in the Filename field of the From Multimedia File block or VideoFileReader System
object™.

You cannot send and receive MMS streams from the same process. If you wish to send
and receive, the sender or the receiver must be run in rapid accelerator mode or compiled
as a separate application using Simulink Coder™.

If you run the “Transmit Audio and Video Over a Network” on page 2-19 example
with sendReceive set to 'send', you can open up Internet Explorer and view the
URL on which you have set up a server. By default, you should go to the following URL:
mms://127.0.0.1:80. If you run this example with sendReceive set to 'receive',
you will be able to view a MMS stream on the local computer on port 81. This implies
that you will need to set up a stream on this port using software such as the Windows
Media Encoder (which may be downloaded free of charge from Microsoft).

Transmit Audio and Video Over a Network

This example shows how to specify parameters to transmit audio and video over a
network.

Specify the sendReceive parameter to either ‘send’ to write the stream to the network
or ‘receive’ to read the stream from the network.

    sendReceive = 'send';

    url = 'mms://127.0.0.1:81';
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    filename = 'vipmen.avi';

Either send or receive the stream, as specified.

if strcmpi(sendReceive, 'send')

    % Create objects

    hSrc = vision.VideoFileReader(filename);

    hSnk = vision.VideoFileWriter;

    % Set parameters

    hSnk.FileFormat = 'WMV';

    hSnk.AudioInputPort = false;

    hSnk.Filename = url;

    % Run loop. Ctrl-C to exit

    while true

        data = step(hSrc);

        step(hSnk, data);

    end

else

    % Create objects

    hSrc = vision.VideoFileReader;

    hSnk = vision.DeployableVideoPlayer;

    % Set parameters

    hSrc.Filename = url;

    % Run loop. Ctrl-C to exit

    while true

        data = step(hSrc);

        step(hSnk, data);

    end

end
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Resample Image Chroma

In this example, you use the Chroma Resampling block to downsample the Cb and Cr
components of an image. The Y'CbCr color space separates the luma (Y') component of an
image from the chroma (Cb and Cr) components. Luma and chroma, which are calculated
using gamma corrected R, G, and B (R', G', B') signals, are different quantities than
the CIE chrominance and luminance. The human eye is more sensitive to changes in
luma than to changes in chroma. Therefore, you can reduce the bandwidth required for
transmission or storage of a signal by removing some of the color information. For this
reason, this color space is often used for digital encoding and transmission applications.

You can open the example model by typing

ex_vision_resample_image_chroma

on the MATLAB command line.

1 Define an RGB image in the MATLAB workspace. To do so, at the MATLAB
command prompt, type:

I= imread('autumn.tif');

This command reads in an RGB image from a TIF file. The image I is a 206-by-345-
by-3 array of 8-bit unsigned integer values. Each plane of this array represents the
red, green, or blue color values of the image.

2 To view the image this array represents, at the MATLAB command prompt, type:
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 imshow(I)

3 Configure Simulink to display signal dimensions next to each signal line. Select
Display > Signals & Ports > Signal Dimensions.

4 Run your model. The recovered image appears in the Video Viewer window. The
Chroma Resampling block has downsampled the Cb and Cr components of an image.

5 Examine the signal dimensions in your model. The Chroma Resampling block
downsamples the Cb and Cr components of the image from 206-by-346 matrices
to 206-by-173 matrices. These matrices require less bandwidth for transmission
while still communicating the information necessary to recover the image after it is
transmitted.

Setting Block Parameters for This Example

The block parameters in this example are modified from default values as follows:

Block Parameter

Image from
Workspace

Import your image from the MATLAB workspace. Set the Value
parameter to I.

Image Pad Change dimensions of the input I array from 206-by-345-by-3 to
206-by-346-by-3. You are changing these dimensions because the
Chroma Resampling block requires that the dimensions of the
input be divisible by 2. Set the block parameters as follows:

• Method = Symmetric
• Add columns to = Right
• Number of added columns = 1
• Add row to = No padding

The Image Pad block adds one column to the right of each plane of
the array by repeating its border values. This padding minimizes
the effect of the pixels outside the image on the processing of the
image.

Note When you process video streams, be aware that it is
computationally expensive to pad every video frame. You should
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Block Parameter

change the dimensions of the video stream before you process it
with Computer Vision System Toolbox blocks.

Selector, Selector1,
Selector2

Separate the individual color planes from the main signal. Such
separation simplifies the color space conversion section of the
model. Set the Selector block parameters as follows:

Selector1

• Number of input dimensions = 3
• Index 1 = Select all
• Index 2 = Select all
• Index 3 = Index vector (dialog) and  Index = 1

Selector2

• Number of input dimensions = 3
• Index 1 = Select all
• Index 2 = Select all
• Index 3 = Index vector (dialog) and  Index = 2

Selector2

• Number of input dimensions = 3
• Index 1 = Select all
• Index 2 = Select all
• Index 3 = Index vector (dialog) and  Index = 3

Color Space
Conversion

Convert the input values from the R'G'B' color space to the Y'CbCr
color space. The prime symbol indicates a gamma corrected signal.
Set the Image signal parameter to Separate color signals.

Chroma Resampling Downsample the chroma components of the image from the 4:4:4
format to the 4:2:2 format. Use the default parameters. The
dimensions of the output of the Chroma Resampling block are
smaller than the dimensions of the input. Therefore, the output
signal requires less bandwidth for transmission.
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Block Parameter

Chroma
Resampling1

Upsample the chroma components of the image from the 4:2:2
format to the 4:4:4 format. Set the Resampling parameter to
4:2:2 to 4:4:4.

Color Space
Conversion1

Convert the input values from the Y'CbCr color space to the R'G'B'
color space. Set the block parameters as follows:

• Conversion = Y'CbCr to R'G'B'
• Image signal = Separate color signals

Video Viewer Display the recovered image. Select File>Image signal to set
Image signal to Separate color signals.

Configuration Parameters

Open the Configuration dialog box by selecting Model Configuration Parameters
from the Simulation menu. Set the parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)
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Convert Intensity to Binary Images

Binary images contain Boolean pixel values that are either 0 or 1. Pixels with the
value 0 are displayed as black; pixels with the value 1 are displayed as white. Intensity
images contain pixel values that range between the minimum and maximum values
supported by their data type. Binary images can contain only 0s and 1s, but they are not
binary images unless their data type is Boolean.“Thresholding Intensity Images Using
Relational Operators” on page 2-25

Thresholding Intensity Images Using Relational Operators

You can use the Relational Operator block to perform a thresholding operation that
converts your intensity image to a binary image. This example shows you how to
accomplish this task.

You can open the example model by typing

ex_vision_thresholding_intensity

on the MATLAB command line.

1 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From File Computer Vision System Toolbox >

Sources
1

Video Viewer Computer Vision System Toolbox >
Sinks

2

Relational Operator Simulink > Logic and Bit Operations 1
Constant Simulink > Sources 1

2 Use the Image from File block to import your image. In this example the image file
is a 256-by-256 matrix of 8-bit unsigned integer values that range from 0 to 255. Set
the File name parameter to rice.png

3 Use the Video Viewer1 block to view the original intensity image. Accept the default
parameters.

4 Use the Constant block to define a threshold value for the Relational Operator block.
Since the pixel values range from 0 to 255, set the Constant value parameter to
128. This value is image dependent.
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5 Use the Relational Operator block to perform a thresholding operation that converts
your intensity image to a binary image. Set the Relational Operator parameter
to >. If the input to the Relational Operator block is greater than 128, its output is a
Boolean 1; otherwise, its output is a Boolean 0.

6 Use the Video Viewer block to view the binary image. Accept the default parameters.
7 Connect the blocks as shown in the following figure.

8 Set the configuration parameters. Open the Configuration dialog box by selecting
Simulation > Model Configuration Parameters menu. Set the parameters as
follows:
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• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

9 Run your model.

The original intensity image appears in the Video Viewer1 window.

The binary image appears in the Video Viewer window.
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Note: A single threshold value was unable to effectively threshold this image due
to its uneven lighting. For information on how to address this problem, see “Correct
Nonuniform Illumination”.

You have used the Relational Operator block to convert an intensity image to a
binary image. For more information about this block, see the Relational Operator
block reference page in the Simulink documentation. For additional information, see
“Converting Between Image Types” in the Image Processing Toolbox documentation.



 Convert Intensity to Binary Images

2-29

Thresholding Intensity Images Using the Autothreshold Block

In the previous topic, you used the Relational Operator block to convert an intensity
image into a binary image. In this topic, you use the Autothreshold block to accomplish
the same task. Use the Autothreshold block when lighting conditions vary and the
threshold needs to change for each video frame.

Note: Running this example requires a DSP System Toolbox™ license.

ex_vision_autothreshold

1 If the model you created in “Thresholding Intensity Images Using Relational
Operators” on page 2-25 is not open on your desktop, you can open the model by
typing

ex_vision_thresholding_intensity

at the MATLAB command prompt.
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2 Use the Image from File block to import your image. In this example the image file
is a 256-by-256 matrix of 8-bit unsigned integer values that range from 0 to 255. Set
the File name parameter to rice.png

3 Delete the Constant and the Relational Operator blocks in this model.
4 Add an Autothreshold block from the Conversions library of the Computer Vision

System Toolbox into your model.
5 Use the Autothreshold block to perform a thresholding operation that converts your

intensity image to a binary image. Select the Output threshold check box. This
block outputs the calculated threshold value at the Th port.
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6 Add a Display block from the Sinks library of the DSP System Toolbox library.
Connect the Display block to the Th output port of the Authothreshold block.

Your model should look similar to the following figure:

7 Double-click the Image From File block. On the Data Types pane, set the Output
data type parameter to double.
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8 If you have not already done so, set the configuration parameters. Open the
Configuration dialog box by selecting Model Configuration Parameters from the
Simulation menu. Set the parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

9 Run the model.

The original intensity image appears in the Video Viewer1 window.

The binary image appears in the Video Viewer window.
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In the model window, the Display block shows the threshold value, calculated by the
Autothreshold block, that separated the rice grains from the background.
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You have used the Autothreshold block to convert an intensity image to a binary image.
For more information about this block, see the Autothreshold block reference page in the
Computer Vision System Toolbox Reference. To open an example model that uses this
block, type vipstaples at the MATLAB command prompt.
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Convert R'G'B' to Intensity Images

The Color Space Conversion block enables you to convert color information from the
R'G'B' color space to the Y'CbCr color space and from the Y'CbCr color space to the R'G'B'
color space as specified by Recommendation ITU-R BT.601-5. This block can also be used
to convert from the R'G'B' color space to intensity. The prime notation indicates that the
signals are gamma corrected.

Some image processing algorithms are customized for intensity images. If you want to
use one of these algorithms, you must first convert your image to intensity. In this topic,
you learn how to use the Color Space Conversion block to accomplish this task. You can
use this procedure to convert any R'G'B' image to an intensity image:

ex_vision_convert_rgb

1 Define an R'G'B' image in the MATLAB workspace. To read in an R'G'B' image from
a JPG file, at the MATLAB command prompt, type

I= imread('greens.jpg'); 

I is a 300-by-500-by-3 array of 8-bit unsigned integer values. Each plane of this
array represents the red, green, or blue color values of the image.

2 To view the image this matrix represents, at the MATLAB command prompt, type

imshow(I)
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3 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From Workspace Computer Vision System Toolbox >

Sources
1

Color Space Conversion Computer Vision System Toolbox >
Conversions

1

Video Viewer Computer Vision System Toolbox >
Sinks

2

4 Use the Image from Workspace block to import your image from the MATLAB
workspace. Set theValue parameter to I.
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5 Use the Color Space Conversion block to convert the input values from the R'G'B'
color space to intensity. Set the Conversion parameter to R'G'B' to intensity.

6 View the modified image using the Video Viewer block. View the original image
using the Video Viewer1 block. Accept the default parameters.

7 Connect the blocks so that your model is similar to the following figure.

8 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = 0
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• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

9 Run your model.

The image displayed in the Video Viewer window is the intensity version of the
greens.jpg image.

In this topic, you used the Color Space Conversion block to convert color information
from the R'G'B' color space to intensity. For more information on this block, see the Color
Space Conversion block reference page.
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Process Multidimensional Color Video Signals

The Computer Vision System Toolbox software enables you to work with color images
and video signals as multidimensional arrays. For example, the following model passes a
color image from a source block to a sink block using a 384-by-512-by-3 array.

ex_vision_process_multidimensional
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You can choose to process the image as a multidimensional array by setting the Image
signal parameter to One multidimensional signal in the Image From File block
dialog box.

The blocks that support multidimensional arrays meet at least one of the following
criteria:

• They have the Image signal parameter on their block mask.
• They have a note in their block reference pages that says, “This block supports

intensity and color images on its ports.”
• Their input and output ports are labeled “Image”.
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You can also choose to work with the individual color planes of images or video signals.
For example, the following model passes a color image from a source block to a sink block
using three separate color planes.

ex_vision_process_individual
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To process the individual color planes of an image or video signal, set the Image signal
parameter to Separate color signals in both the Image From File and Video Viewer
block dialog boxes.
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Note: The ability to output separate color signals is a legacy option. It is recommend that
you use multidimensional signals to represent color data.

If you are working with a block that only outputs multidimensional arrays, you can
use the Selector block to separate the color planes. For an example of this process, see
Measure an Angle Between Lines. If you are working with a block that only accepts
multidimensional arrays, you can use the Matrix Concatenation block to create a
multidimensional array. For an example of this process, see Find the Histogram of an
Image.
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Video Formats
Video data is a series of images over time. Video in binary or intensity format is a series
of single images. Video in RGB format is a series of matrices grouped into sets of three,
where each matrix represents an R, G, or B plane.

Defining Intensity and Color

Video data is a series of images over time. Video in binary or intensity format is a series
of single images. Video in RGB format is a series of matrices grouped into sets of three,
where each matrix represents an R, G, or B plane.

The values in a binary, intensity, or RGB image can be different data types. The data
type of the image values determines which values correspond to black and white as well
as the absence or saturation of color. The following table summarizes the interpretation
of the upper and lower bound of each data type. To view the data types of the signals
at each port, from the Display menu, point to Signals & Ports, and select Port Data
Types.

Data Type Black or Absence of Color White or Saturation of Color
Fixed point Minimum data type value Maximum data type value
Floating point 0 1

Note The Computer Vision System Toolbox software considers any data type other than
double-precision floating point and single-precision floating point to be fixed point.

For example, for an intensity image whose image values are 8-bit unsigned integers, 0 is
black and 255 is white. For an intensity image whose image values are double-precision
floating point, 0 is black and 1 is white. For an intensity image whose image values are
16-bit signed integers, -32768 is black and 32767 is white.

For an RGB image whose image values are 8-bit unsigned integers, 0 0 0 is black,
255 255 255 is white, 255 0 0 is red, 0 255 0 is green, and 0 0 255 is blue. For an
RGB image whose image values are double-precision floating point, 0 0 0 is black,
1 1 1 is white, 1 0 0 is red, 0 1 0 is green, and 0 0 1 is blue. For an RGB image
whose image values are 16-bit signed integers, -32768 -32768 -32768 is black,
32767 32767 32767 is white, 32767 -32768 -32768 is red, -32768 32767 -32768 is green,
and -32768 -32768 32767 is blue.
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Video Data Stored in Column-Major Format

The MATLAB technical computing software and Computer Vision System Toolbox blocks
use column-major data organization. The blocks' data buffers store data elements from
the first column first, then data elements from the second column second, and so on
through the last column.

If you have imported an image or a video stream into the MATLAB workspace using a
function from the MATLAB environment or the Image Processing Toolbox, the Computer
Vision System Toolbox blocks will display this image or video stream correctly. If you
have written your own function or code to import images into the MATLAB environment,
you must take the column-major convention into account.
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Image Formats

In the Computer Vision System Toolbox software, images are real-valued ordered sets
of color or intensity data. The blocks interpret input matrices as images, where each
element of the matrix corresponds to a single pixel in the displayed image. Images can be
binary, intensity (grayscale), or RGB. This section explains how to represent these types
of images.

Binary Images

Binary images are represented by a Boolean matrix of 0s and 1s, which correspond to
black and white pixels, respectively.

For more information, see “Binary Images” in the Image Processing Toolbox
documentation.

Intensity Images

Intensity images are represented by a matrix of intensity values. While intensity images
are not stored with colormaps, you can use a gray colormap to display them.

For more information, see “Grayscale Images” in the Image Processing Toolbox
documentation.

RGB Images

RGB images are also known as a true-color images. With Computer Vision System
Toolbox blocks, these images are represented by an array, where the first plane
represents the red pixel intensities, the second plane represents the green pixel
intensities, and the third plane represents the blue pixel intensities. In the Computer
Vision System Toolbox software, you can pass RGB images between blocks as three
separate color planes or as one multidimensional array.

For more information, see “Truecolor Images” in the Image Processing Toolbox
documentation.
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• “Display, Stream, and Preview Videos” on page 3-2
• “Annotate Video Files with Frame Numbers” on page 3-4
• “Draw Shapes and Lines” on page 3-7
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Display, Stream, and Preview Videos

In this section...

“View Streaming Video in MATLAB” on page 3-2
“Preview Video in MATLAB” on page 3-2
“View Video in Simulink” on page 3-2

View Streaming Video in MATLAB

Basic Video Streaming

Use the video player vision.VideoPlayer System object when you require a simple
video display in MATLAB for streaming video.

Code Generation Supported Video Streaming Object

Use the deployable video player vision.DeployableVideoPlayer System object
as a basic display viewer designed for optimal performance. This object supports code
generation on all platforms.

Preview Video in MATLAB

Use the Image Processing Toolbox implay function to view and represent videos as
variables in the MATLAB workspace. It is a full featured video player with toolbar
controls. The implay player enables you to view videos directly from files without having
to load all the video data into memory at once.

You can open several instances of the implay function simultaneously to view multiple
video data sources at once. You can also dock these implay players in the MATLAB
desktop. Use the figure arrangement buttons in the upper-right corner of the Sinks
window to control the placement of the docked players.

View Video in Simulink

Code Generation Supported Video Streaming Block

Use the To Video Display block in your Simulink model as a simple display viewer
designed for optimal performance. This block supports code generation for the Windows
platform.
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Simulation Control and Video Analysis Block

Use the Video Viewer block when you require a wired-in video display with simulation
controls in your Simulink model. The Video Viewer block provides simulation control
buttons directly from the player interface. The block integrates play, pause, and step
features while running the model and also provides video analysis tools such as pixel
region viewer.

View Video Signals Without Adding Blocks

The implay function enables you to view video signals in Simulink models without
adding blocks to your model. You can open several instances of the implay player
simultaneously to view multiple video data sources at once. You can also dock these
players in the MATLAB desktop. Use the figure arrangement buttons in the upper-right
corner of the Sinks window to control the placement of the docked players.

Set Simulink simulation mode to Normal to use implay. implay does not work when
you use “Accelerating Simulink Models”.

Use implay to view a Simulink signal:

1 Open a Simulink model.
2 Open an implay player by typing implay on the MATLAB command line.
3 Run the Simulink model.
4 Select the signal line you want to view.
5 On the implay toolbar, select File > Connect to Simulink Signal  or click the

 icon.

The video appears in the player window.
6 You can use multiple implay players to display different Simulink signals.

Note: During code generation, the Simulink Coder does not generate code for the implay
player.



3 Display and Graphics

3-4

Annotate Video Files with Frame Numbers

You can use the vision.TextInserter System object in MATLAB, or theInsert Text
block in a Simulink model, to overlay text on video streams. In this Simulink model
example, you add a running count of the number of video frames to a video using the
Insert Text block. The model contains the From Multimedia File block to import the
video into the Simulink model, a Frame Counter block to count the number of frames in
the input video, and two Video Viewer blocks to view the original and annotated videos.

You can open the example model by typing

ex_vision_annotate_video_file_with_frame_numbers

on the MATLAB command line.

1 Run your model.
2 The model displays the original and annotated videos.
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Color Formatting

For this example, the color format for the video was set to Intensity, and therefore the
color value for the text was set to a scaled value. If instead, you set the color format to
RGB, then the text value must satisfy this format, and requires a 3-element vector.

Inserting Text

Use the Insert Text block to annotate the video stream with a running frame count. Set
the block parameters as follows:

• Main pane, Text = ['Frame count' sprintf('\n') 'Source frame: %d']
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• Main pane, Color value = 1
• Main pane, Location [x y] = [2 85]
• Font pane, Font face = LucindaTypewriterRegular

By setting the Text parameter to ['Frame count' sprintf('\n') 'Source
frame: %d'], you are asking the block to print Frame count on one line and the
Source frame: on a new line. Because you specified %d, an ANSI C printf-style format
specification, the Variables port appears on the block. The block takes the port input in
decimal form and substitutes this input for the %d in the string. You used the Location
[x y] parameter to specify where to print the text. In this case, the location is 85 rows
down and 2 columns over from the top-left corner of the image.

Configuration Parameters

Set the configuration parameters. Open the Configuration dialog box by selecting Model
Configuration Parameters from the Simulation menu. Set the parameters as follows:

• Solver pane, Stop time = inf
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)
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Draw Shapes and Lines

When you specify the type of shape to draw, you must also specify it’s location on the
image. The table shows the format for the points input for the different shapes.

Rectangle

Shape PTS input Drawn Shape

Single Rectangle Four-element row vector
[x y width height] where

• x and y are the one-based coordinates of
the upper-left corner of the rectangle.

• width and height are the width, in
pixels, and height, in pixels, of the
rectangle. The values of width and
height must be greater than 0.
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Shape PTS input Drawn Shape

M Rectangles M-by-4 matrix

x y width height

x y width height

x y width heightM M M M

1 1 1 1

2 2 2 2

M M M M

È

Î

Í
ÍÍ
Í
Í

˘

˚

˙
˙
˙
˙

where each row of the matrix corresponds
to a different rectangle and is of the same
form as the vector for a single rectangle.

Line and Polyline

You can draw one or more lines, and one or more polylines. A polyline contains a series of
connected line segments.



 Draw Shapes and Lines

3-9

Shape PTS input Drawn Shape

Single Line Four-element row vector [x1 y1 x2 y2]
where

• x1 and y1 are the coordinates of the
beginning of the line.

• x2 and y2 are the coordinates of the end
of the line.

M Lines M-by-4 matrix

x y x y

x y x y

x y x yM M M M

11 11 12 12

21 21 22 22

1 1 2 2

M M M M

È

Î

Í
Í
Í
Í

˘

˚

˙
˙
˙
˙

where each row of the matrix corresponds
to a different line and is of the same form
as the vector for a single line.
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Shape PTS input Drawn Shape

Single Polyline with
(L-1) Segments

Vector of size 2L, where L is the number
of vertices, with format, [x1, y1, x2,
y2, ..., xL, yL].

• x1 and y1 are the coordinates of the
beginning of the first line segment.

• x2 and y2 are the coordinates of the
end of the first line segment and the
beginning of the second line segment.

• xL and yL are the coordinates of the end
of the (L-1)th line segment.

The polyline always contains (L-1) number
of segments because the first and last
vertex points do not connect. The block
produces an error message when the
number of rows is less than two or not a
multiple of two.
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Shape PTS input Drawn Shape

M Polylines with
(L-1) Segments

2L-by-N matrix

x y x y x y

x y x y x y

x y x y

L L

L L

M M M M

11 11 12 12 1 1

21 21 22 22 2 2

1 1 2 2

L

L

M M M M O M M

L xx yML ML

È

Î

Í
Í
Í
Í

˘

˚

˙
˙
˙
˙

where each row of the matrix corresponds
to a different polyline and is of the same
form as the vector for a single polyline.
When you require one polyline to contain
less than (L–1) number of segments, fill the
matrix by repeating the coordinates of the
last vertex.

The block produces an error message if the
number of rows is less than two or not a
multiple of two.
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Polygon

You can draw one or more polygons.

Shape PTS input Drawn Shape

Single Polygon with
L line segments

Row vector of size 2L, where L is the
number of vertices, with format, [x1 y1 x2
y2 ... xL yL] where

• x1 and y1 are the coordinates of the
beginning of the first line segment.

• x2 and y2 are the coordinates of the
end of the first line segment and the
beginning of the second line segment.

• xL and yL are the coordinates of the
end of the (L-1)th line segment and the
beginning of the Lth line segment.

The block connects [x1 y1] to [xL yL] to
complete the polygon. The block produces
an error if the number of rows is negative
or not a multiple of two.
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Shape PTS input Drawn Shape

M Polygons with the
largest number of
line segments in any
line being L

M-by-2L matrix

x y x y x y

x y x y x y

x y x y

L L

L L

M M M M

11 11 12 12 1 1

21 21 22 22 2 2

1 1 2 2

L

L

M M M M O M M

L xx yML ML

È

Î

Í
Í
Í
Í

˘

˚

˙
˙
˙
˙

where each row of the matrix corresponds
to a different polygon and is of the same
form as the vector for a single polygon. If
some polygons are shorter than others,
repeat the ending coordinates to fill the
polygon matrix.

The block produces an error message if the
number of rows is less than two or is not a
multiple of two.
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Circle

You can draw one or more circles.

Shape PTS input Drawn Shape

Single Circle Three-element row vector
[x y radius] where

• x and y are coordinates for the center of
the circle.

• radius is the radius of the circle, which
must be greater than 0.
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Shape PTS input Drawn Shape

M Circles M-by-3 matrix

x y radius

x y radius

x y radiusM M M

1 1 1

2 2 2

M M M

È

Î

Í
Í
Í
Í

˘

˚

˙
˙
˙
˙

where each row of the matrix corresponds
to a different circle and is of the same form
as the vector for a single circle.
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• “Detect Edges in Images” on page 4-2
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• “Measure Angle Between Lines” on page 4-13
• “Single Camera Calibration App” on page 4-21
• “Stereo Calibration App” on page 4-48
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Detect Edges in Images

This example shows how to find the edges of rice grains in an intensity image. It finds
the pixel locations where the magnitude of the gradient of intensity exceeds a threshold
value. These locations typically occur at the boundaries of objects.

Open the Simulink model.

ex_vision_detect_edges_in_image

Set block parameters.

Block Parameter setting

Image From File • File name to rice.png.
• Output data type to single.

Edge Detection Use the Edge Detection block to find the
edges in the image.

• Output type = Binary image and
gradient components
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Block Parameter setting

• Select the Edge thinning check box.
Video Viewer and Video Viewer1 View the original and binary images.

Accept the default parameters for both
viewers.

2-D Minimum and 2-D Minimum1 Find the minimum value of Gv and Gh
matrices. Set the Mode parameters to
Value for both of these blocks.

Subtract and Subtract1 Subtract the minimum values from each
element of the Gv and Gh matrices. This
process ensures that the minimum value
of these matrices is 0. Accept the default
parameters.

2-D Maximum and 2-D Maximum1 Find the maximum value of the new Gv
and Gh matrices. Set the Mode parameters
to Value for both of these blocks.

Divide and Divide1 Divide each element of the Gv and Gh
matrices by their maximum value. This
normalization process ensures that these
matrices range between 0 and 1. Accept the
default parameters.

Video Viewer2 and Video Viewer3 View the gradient components of the
image. Accept the default parameters.

Set configuration parameters.

Open the Configuration dialog box by selecting Model Configuration Parameters
from the Simulation menu. The parameters are set as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)
• Diagnostics pane, Automatic solver parameter selection: = none

Run your model and view edge detection results.

The Video Viewer window displays the original image.
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The Video Viewer1 window displays the edges of the rice grains in white and the
background in black.
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The Video Viewer2 window displays the intensity image of the vertical gradient
components of the image. You can see that the vertical edges of the rice grains are darker
and more well defined than the horizontal edges.
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The Video Viewer3 window displays the intensity image of the horizontal gradient
components of the image. In this image, the horizontal edges of the rice grains are more
well defined.
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The Edge Detection block convolves the input matrix with the Sobel kernel. This
calculates the gradient components of the image that correspond to the horizontal
and vertical edge responses. The block outputs these components at the Gh and Gv
ports, respectively. Then the block performs a thresholding operation on the gradient
components to find the binary image. The binary image is a matrix filled with 1s and 0s.
The nonzero elements of this matrix correspond to the edge pixels and the zero elements
correspond to the background pixels. The block outputs the binary image at the Edge
port.

The matrix values at the Gv and Gh output ports of the Edge Detection block are double-
precision floating-point. These matrix values need to be scaled between 0 and 1 in order
to display them using the Video Viewer blocks. This is done with the Statistics and Math
Operation blocks.
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Run the model faster by double-clicking the Edge Detection block and clear the Edge
thinning check box.

Your model runs faster because the Edge Detection block is more efficient when you clear
the Edge thinning check box. However, the edges of rice grains in the Video Viewer
window are wider.

Close the model.

bdclose('ex_vision_detect_edges_in_image');
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Detect Lines in Images

This example shows you how to find lines within images and enables you to detect,
measure, and recognize objects. You use the Hough Transform, Find Local Maxima, Edge
Detectionand Hough Lines blocks to find the longest line in an image.

You can open the model for this example by typing

ex_vision_detect_lines

at the MATLAB command line.

The Video Viewer blocks display the original image, the image with all edges found, and
the image with the longest line annotated.
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The Edge Detection block finds the edges in the intensity image. This process improves
the efficiency of the Hough Lines block by reducing the image area over which the block
searches for lines. The block also converts the image to a binary image, which is the
required input for the Hough Transform block.

For additional examples of the techniques used in this section, see the following list of
examples. You can open these examples by typing the title at the MATLAB command
prompt:

Example MATLAB Simulink model-based

Lane Departure Warning
System

videoldws vipldws

Rotation Correction videorotationcorrection viphough

Setting Block Parameters

Block Parameter setting

Hough Transform The Hough Transform block computes the
Hough matrix by transforming the input
image into the rho-theta parameter space.
The block also outputs the rho and theta
values associated with the Hough matrix.
The parameters are set as follows:

• Theta resolution (radians) = pi/360
• Select the Output theta and rho

values check box.
Find Local Maxima The Find Local Maxima block finds the

location of the maximum value in the
Hough matrix. The block parameters are
set as follows:

• Maximum number of local maxima
= 1

• Input is Hough matrix spanning
full theta range

Selector The Selector blocks separate the indices of
the rho and theta values, which the Find
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Block Parameter setting

Local Maxima block outputs at the Idx
port. The rho and theta values correspond
to the maximum value in the Hough
matrix. The Selector blocks parameters are
set as follows:

• Number of input dimensions:  1
• Index mode = One-based
• Index Option = Index vector

(port)

• Input port size = 2
Variable Selector The Variable Selector blocks index into the

rho and theta vectors and determine the
rho and theta values that correspond to
the longest line in the original image. The
parameters of the Variable Selector blocks
are set as follows:

• Select = Columns
• Index mode = One-based

Hough Lines The Hough Lines block determines where
the longest line intersects the edges of the
original image.

• Sine value computation method =
Trigonometric function

Draw Shapes The Draw Shapes block draws a white line
over the longest line on the original image.
The coordinates are set to superimpose
a line on the original image. The block
parameters are set as follows:

• Shape = Lines
• Border color = White
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Configuration Parameters

Set the configuration parameters. Open the Configuration dialog box by selecting Model
Configuration Parameters from the Simulation menu. Set the parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = discrete (no continuous states)
• Solver pane, Fixed-step size (fundamental sample time): = 0.2
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Measure Angle Between Lines

The Hough Transform, Find Local Maxima, and Hough Lines blocks enable you to find
lines in images. With the Draw Shapes block, you can annotate images. In the following
example, you use these capabilities to draw lines on the edges of two beams and measure
the angle between them.

Running this example requires a DSP System Toolbox license.

ex_vision_measure_angle_btwn_lines

1 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From File Computer Vision System Toolbox > Sources 1
Color Space
Conversion

Computer Vision System Toolbox >
Conversions

1

Edge Detection Computer Vision System Toolbox > Analysis &
Enhancement

1

Hough Transform Computer Vision System Toolbox > Transforms 1
Hough Lines Computer Vision System Toolbox > Transforms 1
Find Local Maxima Computer Vision System Toolbox > Statistics 1
Draw Shapes Computer Vision System Toolbox > Text &

Graphics
1

Video Viewer Computer Vision System Toolbox > Sinks 3
Submatrix DSP System Toolbox > Math Functions

> Matrices and Linear Algebra > Matrix
Operations

4

Selector Simulink > Signal Routing 4
MATLAB Function Simulink > User-Defined Functions 1
Terminator Simulink > Sinks 1
Display Simulink > Sinks 1

2 Use the Image From File block to import an image into the Simulink model. Set the
parameters as follows:
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• File name = gantrycrane.png
• Sample time = 1

3 Use the Color Space Conversion block to convert the RGB image into the Y'CbCr
color space. You perform this conversion to separate the luma information from the
color information. Accept the default parameters.

Note: In this example, you segment the image using a thresholding operation that
performs best on the Cb channel of the Y'CbCr color space.

4 Use the Selector and Selector1 blocks to separate the Y' (luminance) and Cb
(chrominance) components from the main signal.

The Selector block separates the Y' component from the entire signal. Set its block
parameters as follows:

• Number of input dimensions = 3
• Index mode = One-based
• 1 Index Option = Select all
• 2 Index Option = Select all
• 3 Index Option = Index vector (dialog), Index = 1

The Selector1 block separates the Cb component from the entire signal. Set its block
parameters as follows:

• Number of input dimensions = 3
• Index mode = One-based
• 1 Index Option = Select all
• 2 Index Option = Select all
• 3 Index Option = Index vector (dialog), Index = 2

5 Use the Submatrix and Submatrix1 blocks to crop the Y' and Cb matrices to a
particular region of interest (ROI). This ROI contains two beams that are at an angle
to each other. Set the parameters as follows:

• Starting row = Index
• Starting row index = 66
• Ending row = Index
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• Ending row index = 150
• Starting column = Index
• Starting column index = 325
• Ending column = Index
• Ending column index = 400

6 Use the Edge Detection block to find the edges in the Cb portion of the image. This
block outputs a binary image. Set the Threshold scale factor parameter to 1.

7 Use the Hough Transform block to calculate the Hough matrix, which gives you an
indication of the presence of lines in an image. Select the Output theta and rho
values checkbox.

Note: In step 11, you find the theta and rho values that correspond to the peaks in
the Hough matrix.

8 Use the Find Local Maxima block to find the peak values in the Hough matrix. These
values represent potential lines in the input image. Set the parameters as follows:

• Neighborhood size = [11 11]
• Select the Input is Hough matrix spanning full theta range checkbox.
• Uncheck the Output variable size signal checkbox.

Because you are expecting two lines, leave the Maximum number of local
maxima (N) parameter set to 2.

9 Use the Submatrix2 block to find the indices that correspond to the theta values of
the two peak values in the Hough matrix. Set the parameters as follows:

• Starting row = Index
• Starting row index = 2
• Ending row = Index
• Ending row index = 2

The Idx port of the Find Local Maxima block outputs a matrix whose second row
represents the One-based indices of the theta values that correspond to the peaks
in the Hough matrix. Now that you have these indices, you can use a Selector block
to extract the corresponding theta values from the vector output of the Hough
Transform block.
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10 Use the Submatrix3 block to find the indices that correspond to the rho values of the
two peak values in the Hough matrix. Set the parameters as follows:

• Ending row = Index
• Ending row index = 1

The Idx port of the Find Local Maxima block outputs a matrix whose first row
represents the One-based indices of the rho values that correspond to the peaks in
the Hough matrix. Now that you have these indices, you can use a Selector block to
extract the corresponding rho values from the vector output of the Hough Transform
block.

11 Use the Selector2 and Selector3 blocks to find the theta and rho values that
correspond to the peaks in the Hough matrix. These values, output by the
Hough Transform block, are located at the indices output by the Submatrix2 and
Submatrix3 blocks. Set both block parameters as follows:

• Index mode = One-based
• 1 Index Option = Index vector (port)
• Input port size = -1

You set the Index mode to One-based because the Find Local Maxima block
outputs One-based indices at the Idx port.

12 Use the Hough Lines block to find the Cartesian coordinates of lines that are
described by rho and theta pairs. Set the Sine value computation method
parameter to Trigonometric function.

13 Use the Draw Shapes block to draw the lines on the luminance portion of the ROI.
Set the parameters as follows:

• Shape = Lines
• Border color = White

14 Use the MATLAB Function block to calculate the angle between the two lines. Copy
and paste the following code into the block:

function angle = compute_angle(theta) 

% Compute the angle value in degrees 

angle = abs(theta(1)-theta(2))*180/pi;

% Always return an angle value less than 90 degrees 

if (angle>90)
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    angle = 180-angle;  

end

15 Use the Display block to view the angle between the two lines. Accept the default
parameters.

16 Use the Video Viewer blocks to view the original image, the ROI, and the annotated
ROI. Accept the default parameters.

17 Connect the blocks as shown in the following figure.

18 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

19 Run the model.

The Video Viewer window displays the original image.
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The Video Viewer1 window displays the ROI where two beams intersect.
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The Video Viewer2 window displays the ROI that has been annotated with two white
lines.
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The Display block shows a value of 58, which is the angle in degrees between the two
lines on the annotated ROI.

You have now annotated an image with two lines and measured the angle between them.
For additional information, see the Hough Transform, Find Local Maxima, Hough Lines,
and Draw Shapes block reference pages.
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Single Camera Calibration App

In this section...

“Camera Calibrator Overview” on page 4-21
“Open the Camera Calibrator” on page 4-22
“Prepare the Pattern, Camera, and Images” on page 4-23
“Add Images” on page 4-26
“Calibrate” on page 4-35
“Evaluate Calibration Results” on page 4-37
“Improve Calibration” on page 4-42
“Export Camera Parameters” on page 4-45

Camera Calibrator Overview

You can use the camera calibrator to estimate camera intrinsics, extrinsics, and lens
distortion parameters. You can use these camera parameters for various computer vision
applications. These applications include removing the effects of lens distortion from an
image, measuring planar objects, or reconstructing 3-D scenes from multiple cameras.

Single Camera Calibration Workflow

add imagesadd calibrateprepare images evaluate improve export

Follow this workflow to calibrate your camera using the app:

1 Prepare images, camera, and calibration pattern.
2 Load images.
3 Calibrate the camera.
4 Evaluate calibration accuracy.
5 Adjust parameters to improve accuracy (if necessary).
6 Export the parameters object.
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In some cases, the default values work well, and you do not need to make any
improvements before exporting parameters. If you do need to make improvements,
you can use the camera calibration functions in MATLAB. For a list of functions, see
“Geometric Camera Calibration”.

Open the Camera Calibrator

• MATLAB Toolstrip: Open the Apps tab, under Image Processing and Computer
Vision, click the app icon.

• MATLAB command prompt: Enter cameraCalibrator
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Prepare the Pattern, Camera, and Images

For best results, use between 10 and 20 images of the calibration pattern. The calibrator
requires at least three images. Use uncompressed images or lossless compression
formats such as PNG. The calibration pattern and the camera setup must satisfy a set of
requirements to work with the calibrator. For greater calibration accuracy, follow these
instructions for preparing the pattern, setting up the camera, and capturing the images.

Prepare the Checkerboard Pattern

The Camera Calibrator app uses a checkerboard pattern. A checkerboard pattern is a
convenient calibration target. If you want to use a different pattern to extract key points,
you can use the camera calibration MATLAB functions directly. See “Geometric Camera
Calibration” for the list of functions.

You can print (from MATLAB) and use the checkerboard pattern provided. The
checkerboard pattern you use must not be square. One side must contain an even
number of squares and the other side must contain an odd number of squares. Therefore,
the pattern contains two black corners along one side and two white corners on the
opposite side. This criteria enables the app to determine the orientation of the pattern.
The calibrator assigns the longer side to be the x-direction.

To prepare the checkerboard pattern:

1 Attach the checkerboard printout to a flat surface. Imperfections on the surface can
affect the accuracy of the calibration.

2 Measure one side of the checkerboard square. You need this measurement for
calibration. The size of the squares can vary depending on printer settings.
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3 To improve the detection speed, set up the pattern with as little background clutter
as possible.

Camera Setup

To properly calibrate your camera, follow these rules:

• Keep the pattern in focus, but do not use autofocus.
• Do not change zoom settings between images. Otherwise the focal length changes.

Capture Images

For best results, use at least 10 to 20 images of the calibration pattern. The calibrator
requires at least three images. Use uncompressed images or images in lossless
compression formats such as PNG. For greater calibration accuracy:

• Capture the images of the pattern at a distance roughly equal to the distance from
your camera to the objects of interest. For example, if you plan to measure objects
from 2 meters, keep your pattern approximately 2 meters from the camera.

• Place the checkerboard at an angle less than 45 degrees relative to the camera plane.
• Do not modify the images. For example, do not crop them.
• Do not use autofocus or change the zoom between images.
• Capture the images of a checkerboard pattern at different orientations relative to the

camera.
• Capture enough different images of the pattern so that you have covered as much

of the image frame as possible. Lens distortion increases radially from the center of
the image and sometimes is not uniform across the image frame. To capture this lens
distortion, the pattern must appear close to the edges.
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The Calibrator works with a range of checkerboard square sizes. As a general rule, your
checkerboard should fill at least 20% of the captured image. For example, the preceding
images were taken with a checkerboard square size of 108 mm.



4 Registration and Stereo Vision

4-26

Add Images

To begin calibration, you must add images. You can add saved images from a folder or
add images directly from a camera. The calibrator analyze the images to ensure they
meet the calibrator requirements and then detects the points.

Add Images from File

Click the Add images, button, and select From file. You can add images from multiple
folders by clicking Add images for each folder.

Acquire Live Images

To begin calibration, you must add images. You can acquire images live from a Webcam
using the MATLAB Webcam support. You must have the MATLAB Support Package for
USB Webcams installed to use this feature. See “Install the Webcam Support Package”
for information on installing the support package.

1 To add live images, click the Add Images arrow and select From camera.



 Single Camera Calibration App

4-27

2 The Image Capture tab opens. If you have only one Webcam connected to your
system, it is selected by default and a live preview window opens. If you have
multiple cameras connected and want to use a different one, select the camera in the
Camera list.

3 You can set properties for the camera to control the image. Click the Camera
Properties field to open a list of your camera’s properties. This list varies,
depending on your device.
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Use the sliders or drop-downs to change any available property settings. The
Preview window updates dynamically when you change a setting. When you are
done setting properties, click outside of the box to dismiss the properties list.

4 Enter a location for the acquired image files in the Save Location field by typing
the path to the folder or using the Browse button. You must have permission to
write to the folder you select.

5 Set your capture parameters.
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In the Capture Interval field, use the text box or slider to set the number of
seconds between image captures. The default is 5 seconds, the minimum is 1 second,
and the maximum is 60 seconds.

In the Number of images to capture field, use the text box or slider to set the
number of image captures. The default is 20 images, the minimum is 2 images, and
the maximum is 100 images.

In the default configuration, a total of 20 images are captured, one every 5 seconds.
6 It is helpful to dock the Preview window in the center of the tool. Move it from the

right panel into the middle panel by dragging the banner. It then docks in the middle
as shown here.
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7 The Preview window shows the live images streamed as RGB data. After you adjust
any device properties and capture settings, use the Preview window as a guide to
line up the camera to acquire the checkerboard pattern image you wish to capture.

8 Click the Capture button. The number of images you set are captured and
the thumbnails of the snapshots appear in the Data Browser panel. They are
automatically named incrementally and are captured as .png files.

You can optionally stop the image capture before the designated number of images
are captured by clicking Stop Capture.
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When you are capturing images of a checkerboard, after the designated number of
images are captured, a message displays with the size of the checkerboard square.
Click OK.
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The Detection Results are then calculated and displayed. For example:
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9 Click OK in the Detection Results dialog box.
10 When you have finished acquiring live images, you can click Close Image Capture

to close the Image Capture tab and return to the Calibration tab.

Analyze Images

After you select the images, in the Checkerboard Square Size dialog box, enter the length
of one side of a square from the checkerboard pattern.

The calibrator attempts to detect a checkerboard in each of the added images. An
Analyzing Images progress bar window appears, indicating detection progress.
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If any of the images are rejected, the Detection Results window appears, which contains
diagnostic information. The results indicate how many total images were processed, and
how many were accepted, rejected, or skipped The calibrator skips duplicate images.

To view the rejected images, click view images. The calibrator rejects duplicate images.
It also rejects images where the entire checkerboard could not be detected. Possible
reasons for no detection are a blurry image or an extreme angle of the pattern. Detection
takes longer with larger images and with patterns that contain a large number of
squares.

View Images and Detected Points

The Data Browser pane displays a list of images with IDs. These images contain a
detected pattern. To view an image, select it from the Data Browser pane.
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The Image pane displays the checkerboard image with green circles to indicate detected
points. You can verify the corners were detected correctly using the zoom controls on the
View tab. The yellow square indicates the (0,0) origin. The X and Y arrows indicate the
checkerboard axes orientation.

Calibrate

Once you are satisfied with the accepted images, click Calibrate. The default calibration
settings assume the minimum set of camera parameters. Start by running the calibration
with the default settings. After evaluating the results, you can try to improve calibration
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accuracy by adjusting the settings and adding or removing images, and then calibrate
again.

Calibration Algorithm

The calibration algorithm assumes a pinhole camera model:
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• (X,Y,Z): world coordinates of a point
• (x,y): image coordinates of the corresponding image point in pixels
• w: arbitrary homogeneous coordinates scale factor
• K: camera intrinsic matrix, defined as:
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The coordinates [cx cy] represent the optical center (the principal point), in pixels.
When the x and y axis are exactly perpendicular, the skew parameter, s, equals 0.

fx = F*sx
fy = F*sy
F, is the focal length in world units, typically expressed in millimeters.
[sx, sy] are the number of pixels per world unit in the x and y direction respectively.
fx and fy are expressed in pixels.

• R: matrix representing the 3-D rotation of the camera
• t: translation of the camera relative to the world coordinate system

The camera calibration algorithm estimates the values of the intrinsic parameters, the
extrinsic parameters, and the distortion coefficients. Camera calibration involves these
steps:

1 Solve for the intrinsics and extrinsics in closed form, assuming that lens distortion is
zero. [1]
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2 Estimate all parameters simultaneously, including the distortion coefficients, using
nonlinear least-squares minimization (Levenberg–Marquardt algorithm). Use the
closed-form solution from the preceding step as the initial estimate of the intrinsics
and extrinsics. Set the initial estimate of the distortion coefficients to zero. [1][2]

Evaluate Calibration Results

You can evaluate calibration accuracy by examining the reprojection errors and the
camera extrinsics, and by viewing the undistorted image. For best calibration results, use
all three methods of evaluation.

Examine Reprojection Errors

The reprojection errors are the distances in pixels between the detected and the
reprojected points. The Camera Calibrator app calculates reprojection errors by
projecting the checkerboard points from world coordinates, defined by the checkerboard,
into image coordinates. The app then compares the reprojected points to the
corresponding detected points. As a general rule, reprojection errors of less than one pixel
are acceptable.
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The Camera Calibrator app displays, in pixels, the reprojection errors as a bar graph and
as a scatter plot. You can toggle between them using the button on the display. You can
identify the images that adversely contribute to the calibration from either one of the
graphs. You can then select and remove those images from the list in the Data Browser
pane.

Bar Graph
The bar graph displays the mean reprojection error per image, along with the overall
mean error. The bar labels correspond to the image IDs. The highlighted bar corresponds
to the selected image.
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Select an image in one of these ways:

• Clicking the corresponding bar in the graph.
• Select the image from the list in the Data Browser pane.

Scatter Plot
The scatter plot displays the reprojection errors for each point. The plus markers
correspond to the points in the selected image. An accurate calibration typically results
in a compact cloud of points. Outliers indicate potential issues with the corresponding
images. To improve accuracy, consider removing those images.
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Examine Extrinsic Parameter Visualization

The 3-D extrinsic parameters plot provides a camera-centric view of the patterns and
a pattern-centric view of the camera. The camera-centric view is helpful if the camera
was stationary when the images were captured. The pattern-centric view is helpful if
the pattern was stationary. Click the button on the display to toggle between the two
visuals. Click and drag a graph to rotate it. Click a checkerboard or a camera to select
it. The highlighted data in the visualizations correspond to the selected image in the
list. Examine the relative positions of the pattern and the camera to see if they match
what you expect. For example, a pattern that appears behind the camera indicates a
calibration error.
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View Undistorted Image

To view the effects of removing lens distortion, in the Image pane, click the Show
Undistorted. If the calibration was accurate, the distorted lines in the image become
straight.
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It is important to check the undistorted images even if the reprojection errors are low. If
the pattern covers only a small percentage of the image, the distortion estimation might
be incorrect, even though the calibration resulted in few reprojection errors.

Improve Calibration

To improve the calibration, you can remove high-error images, add more images, or
modify the calibrator settings.

Add or Remove Images

Consider adding more images if:

• You have less than 10 images.
• The patterns do not cover enough of the image frame.
• The patterns do not have enough variation in orientation with respect to the camera.

Consider removing images if the images:

• Have a high mean reprojection error
• Are blurry
• Contain a checkerboard at an angle greater than 45 degrees relative to the camera

plane
• Contain incorrectly detected checkerboard points
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Change the Number of Radial Distortion Coefficients

You can specify 2 or 3 radial distortion coefficients by selecting the corresponding radio
button from the Options section. Radial distortion occurs when light rays bend more
near the edges of a lens than they do at its optical center. The smaller the lens, the
greater the distortion.

The radial distortion coefficients model this type of distortion. The distorted points are
denoted as (xdistorted, ydistorted):
xdistorted = x(1 + k1*r2 + k2*r4 + k3*r6)
ydistorted= y(1 + k1*r2 + k2*r4 + k3*r6)
.

• x, y: undistorted pixel locations
• k1, k2, and k3: radial distortion coefficients of the lens
• r2: x2 + y2

Typically, two coefficients are sufficient for calibration. For severe distortion, such as in
wide-angle lenses, select 3 Coefficents to include k3.

The undistorted pixel locations are in normalized image coordinates, with the origin at
the optical center. The coordinates are expressed in world units.

Compute Skew

When you select the Compute Skew check box, the calibrator estimates the image axes
skew. Some camera sensors contain imperfections that cause the x- and y-axis of the
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image to not be perpendicular. You can model this defect using a skew parameter. If you
do not select the check box, the image axes are assumed to be perpendicular, which is the
case for most modern cameras.

Compute Tangential Distortion

Tangential distortion occurs when the lens and the image plane are not parallel. The
tangential distortion coefficients model this type of distortion.

camera lens

vertical plane

zero tangential distortion

lens and sensor are parallel

camera
sensor

camera lens

tangential distortion

lens and sensor are not parallel

camera
sensor

vertical plane

The distorted points are denoted as (xdistorted, ydistorted):
xdistorted = x + [2 * p1 * y + p2 * (r2 + 2 * x2)]
ydistorted = y + [p1 * (r2 + 2*y2) + 2 * p2 * x]
.

• x, y: undistorted pixel locations
• p1 and p2: tangential distortion coefficients of the lens
• r2 = x2 + y2

The undistorted pixel locations are in normalized image coordinates, with the origin at
the optical center. The coordinates are in world units.
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When you select the Compute Tangential Distortion check box, the calibrator
estimates the tangential distortion coefficients. Otherwise, the calibrator sets the
tangential distortion coefficients to zero.

Export Camera Parameters

When you are satisfied with calibration accuracy, click Export Camera Parameters.
You can save and export the camera parameters to an object or generate the camera
parameters as a MATLAB script.

Export Camera Parameters

Click Export Camera Parameters to create a cameraParameters object in your
workspace. The object contains the intrinsic and extrinsic parameters of the camera,
and the distortion coefficients. You can use this object for various computer vision tasks,
such as image undistortion, measuring planar objects, and 3-D reconstruction. See
“Measuring Planar Objects with a Calibrated Camera”. You can optionally export the
cameraCalibrationErrors object, which contains the standard errors of estimated
camera parameters.
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Generate MATLAB Script

Click Generate MATLAB script to save your camera parameters to a MATLAB script,
enabling you to reproduce the steps from your calibration session.
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See Also
cameraParameters | stereoParameters | Camera Calibrator |
detectCheckerboardPoints | estimateCameraParameters |
generateCheckerboardPoints | showExtrinsics | showReprojectionErrors |
Stereo Camera Calibrator | undistortImage

Related Examples
• “Evaluating the Accuracy of Single Camera Calibration”
• “Measuring Planar Objects with a Calibrated Camera”
• “Stereo Calibration and Scene Reconstruction”
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• “Depth Estimation From Stereo Video”
• “Sparse 3-D Reconstruction From Two Views”
• “Uncalibrated Stereo Image Rectification”
• Checkerboard pattern

More About
• “Stereo Calibration App”

External Web Sites
• Camera Calibration with MATLAB

http://www.mathworks.com/videos/camera-calibration-with-matlab-81233.html
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Stereo Calibration App
In this section...

“Stereo Camera Calibrator Overview” on page 4-48
“Stereo Camera Calibration Workflow” on page 4-48
“Open the Stereo Camera Calibrator” on page 4-49
“Image, Camera, and Pattern Preparation” on page 4-50
“Add Image Pairs” on page 4-54
“Calibrate” on page 4-57
“Evaluate Calibration Results” on page 4-58
“Improve Calibration” on page 4-62
“Export Camera Parameters” on page 4-65

Stereo Camera Calibrator Overview

You can use the Stereo Camera Calibrator app to calibrate a stereo camera, which you
can then use to recover depth from images. A stereo system consists of two cameras:
camera 1 and camera 2. The app estimates the parameters of each of the two cameras. It
also calculates the position and orientation of camera 2 relative to camera 1.

The app produces an object containing the stereo camera parameters. You can use this
object to rectify stereo images using the rectifyStereoImages function, reconstruct
the 3-D scene using the reconstructScene function, or compute 3-D locations
corresponding to matching pairs of image points using the triangulate function.

The suite of calibration functions used by the Stereo Camera Calibrator app provide
the workflow for stereo system calibration. You can use them directly in the MATLAB
workspace. For a list of functions, see “Geometric Camera Calibration”.

Stereo Camera Calibration Workflow

add imagesadd calibrateprepare images evaluate improve export
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Follow this workflow to calibrate your stereo camera using the app:

1 Prepare images, camera, and calibration pattern.
2 Load image pairs.
3 Calibrate the stereo camera.
4 Evaluate calibration accuracy.
5 Adjust parameters to improve accuracy (if necessary).
6 Export the parameters object.

In some cases, the default values work well, and you do not need to make any
improvements before exporting parameters. If you do need to make improvements,
you can use the camera calibration functions in MATLAB. For a list of functions, see
“Geometric Camera Calibration”.

Open the Stereo Camera Calibrator

• MATLAB Toolstrip: Open the Apps tab, under Image Processing and Computer
Vision, click the app icon.

• MATLAB command prompt: Enter stereoCameraCalibrator
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Image, Camera, and Pattern Preparation

For best results, use between 10 and 20 images of the calibration pattern. The calibrator
requires at least three images. Use uncompressed images or lossless compression
formats such as PNG. The calibration pattern and the camera setup must satisfy a set of
requirements to work with the calibrator. For greater calibration accuracy, follow these
instructions for preparing the pattern, setting up the camera, and capturing the images.
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Prepare the Checkerboard Pattern

The Camera Calibrator app uses a checkerboard pattern, which is a convenient
calibration target. If you want to use a different pattern to extract key points, you
can use the camera calibration MATLAB functions directly. See “Geometric Camera
Calibration” for the list of functions.

You can print (from MATLAB) and use the checkerboard pattern provided. The
checkerboard pattern you use must not be square. One side must contain an even
number of squares and the other side must contain an odd number of squares. Therefore,
the pattern contains two black corners along one side and two white corners on the
opposite side. This criteria enables the app to determine the orientation of the pattern.
The calibrator assigns the longer side to be the x-direction.

To prepare the checkerboard pattern:

1 Attach the checkerboard printout to a flat surface. Imperfections on the surface can
affect the accuracy of the calibration.

2 Measure one side of the checkerboard square. You need this measurement for
calibration. The size of the squares can vary depending on printer settings.
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3 To improve the detection speed, set up the pattern with as little background clutter
as possible.

Camera Setup

To properly calibrate your camera, follow these rules:

• Keep the pattern in focus, but do not use auto-focus.
• Do not change zoom settings between images, otherwise the focal length changes.

Capture Images

For best results, use at least 10 to 20 images of the calibration pattern. The calibrator
requires at least three images. Use uncompressed images or images in lossless
compression formats such as PNG. For greater calibration accuracy:

• Capture the images of the pattern at a distance roughly equal to the distance from
your camera to the objects of interest. For example, if you plan to measure objects
from 2 meters, keep your pattern approximately 2 meters from the camera.

• Place the checkerboard at an angle less than 45 degrees relative to the camera plane.
• Do not modify the images. For example, do not crop them.
• Do not use autofocus or change the zoom between images.
• Capture the images of a checkerboard pattern at different orientations relative to the

camera.
• Capture enough different images of the pattern so that you have covered as much

of the image frame as possible. Lens distortion increases radially from the center of
the image and sometimes is not uniform across the image frame. To capture this lens
distortion, the pattern must appear close to the edges.
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Specific to stereo camera calibration:

• Make sure the checkerboard pattern is fully visible in both images of each stereo pair.
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• Keep the pattern stationary for each image pair. Any motion of the pattern between
taking image 1 and image 2 of the pair negatively affects the calibration.

• To create a stereo display, or anaglyph, position the two cameras approximately 55
mm apart. This distance represents the average distance between human eyes.

• For greater reconstruction accuracy at longer distances, position your cameras farther
apart.

Add Image Pairs

To begin calibration, click Add images to add two sets of stereo images of the
checkerboard. You can add images from multiple folders by clicking Add images. Select
the locations for the images corresponding to camera 1 and camera 2. Enter the length of
one side of a square from the checkerboard pattern.
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Size of checkerboard square

Analyze Images

The calibrator attempts to detect a checkerboard in each of the added images. An
Analyzing Images progress bar window appears, indicating detection progress.
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If any of the image pairs are rejected, the Detection Results window appears, which
contains diagnostic information. The results indicate how many total image pairs were
processed, and how many were accepted, rejected, or skipped The calibrator skips
duplicate images.

To view the rejected images, click view images. The calibrator rejects duplicate images.
It also rejects images where the entire checkerboard could not be detected. Possible
reasons for no detection are a blurry image or an extreme angle of the pattern. Detection
takes longer with larger images and with patterns that contain a large number of
squares.

View Images and Detected Points

The Data Browser pane displays a list of image pairs with IDs. These image pairs
contain a detected pattern. To view an image, select it from the Data Browser pane.
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The Image pane displays the checkerboard image pair with green circles to indicate
detected points. You can verify the corners were detected correctly using the zoom
controls on the View tab. The yellow square indicates the (0,0) origin. The X and Y
arrows indicate the checkerboard axes orientation.

Calibrate

Once you are satisfied with the accepted image pairs, click Calibrate. The default
calibration settings assume the minimum set of camera parameters. Start by running the
calibration with the default settings. After evaluating the results, you can try to improve



4 Registration and Stereo Vision

4-58

calibration accuracy by adjusting the settings and adding or removing images, and then
calibrate again.

Evaluate Calibration Results

You can evaluate calibration accuracy by examining the reprojection errors and the
camera extrinsics, and by viewing the undistorted image. For best calibration results, use
all three methods of evaluation.

Examine Reprojection Errors

The reprojection errors are the distances in pixels between the detected and the
reprojected points. The Stereo Camera Calibrator app calculates reprojection
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errors by projecting the checkerboard points from world coordinates, defined by the
checkerboard, into image coordinates. The app then compares the reprojected points to
the corresponding detected points. As a general rule, reprojection errors of less than one
pixel are acceptable.

reprojection error

points reprojected

using stereo parameters

points detected

from image pairs

detected points

d

airsrs
poinpopopopo

usinusus

world coordinates of

checkerboard points

stereoParameters

dededededetect

The Stereo Camera Calibrator app displays, in pixels, the reprojection errors as a
bar graph and as a scatter plot. You can toggle between them using the button on the
display. You can identify the image pairs that adversely contribute to the calibration
from either one of the graphs. You can then select and remove those images from the list
in the Data Browser pane.

Bar Graph
The bar graph displays the mean reprojection error per image, along with the overall
mean error. The bar labels correspond to the image pair IDs. The highlighted pair of bars
corresponds to the selected image pair.
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Select an image pair in one of these ways:

• Clicking the corresponding bar in the graph.
• Select the image pair from the list in the Data Browser pane.

Examine Extrinsic Parameter Visualization

The 3-D extrinsic parameters plot provides a camera-centric view of the patterns and
a pattern-centric view of the camera. The camera-centric view is helpful if the camera
was stationary when the images were captured. The pattern-centric view is helpful if
the pattern was stationary. Click the button on the display to toggle between the two
visuals. Click and drag a graph to rotate it. Click a checkerboard or a camera to select
it. The highlighted data in the visualizations correspond to the selected image in the
list. Examine the relative positions of the pattern and the camera to see if they match
what you expect. For example, a pattern that appears behind the camera indicates a
calibration error.
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Show Rectified Images

To view the effects of stereo rectification, in the Image pane, click Show Rectified. If
the calibration was accurate, the images become undistorted and row-aligned.
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It is important to check the rectified images even if the reprojection errors are low.
Sometimes, if the pattern only covers a small percentage of the image, the calibration
achieves low reprojection errors, but the distortion estimation is incorrect. An example of
this type of incorrect estimation for single camera calibration is shown below.

Improve Calibration

To improve the calibration, you can remove high-error image pairs, add more image
pairs, or modify the calibrator settings.

Add and Remove Image Pairs

Consider adding more image pairs if:

• You have less than 10 image pairs.
• The patterns do not cover enough of the image frame.
• The patterns in your image pairs do not have enough variation in orientation with

respect to the camera.

YConsider removing image pairs if the images:

• Have a high mean reprojection error.
• Are blurry.
• Contain a checkerboard at an angle greater than 45 degrees relative to the camera

plane.
• Contain incorrectly detected checkerboard points.
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Change the Number of Radial Distortion Coefficients

You can specify 2 or 3 radial distortion coefficients by selecting the corresponding radio
button from the Options section. Radial distortion occurs when light rays bend more
near the edges of a lens than they do at its optical center. The smaller the lens, the
greater the distortion.

The radial distortion coefficients model this type of distortion. The distorted points are
denoted as (xdistorted, ydistorted):
xdistorted = x(1 + k1*r2 + k2*r4 + k3*r6)
ydistorted= y(1 + k1*r2 + k2*r4 + k3*r6)
.

• x, y: undistorted pixel locations
• k1, k2, and k3: radial distortion coefficients of the lens
• r2: x2 + y2

Typically, two coefficients are sufficient for calibration. For severe distortion, such as in
wide-angle lenses, select 3 Coefficents to include k3.

Compute Skew

When you select the Compute Skew check box, the calibrator estimates the image axes
skew. Some camera sensors contain imperfections that cause the x- and y-axis of the
image to not be perpendicular. You can model this defect using a skew parameter. If you
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do not select the check box, the image axes are assumed to be perpendicular, which is the
case for most modern cameras.

Compute Tangential Distortion

Tangential distortion occurs when the lens and the image plane are not parallel. The
tangential distortion coefficients model this type of distortion.

camera lens

vertical plane

zero tangential distortion

lens and sensor are parallel

camera
sensor

camera lens

tangential distortion

lens and sensor are not parallel

camera
sensor

vertical plane

The distorted points are denoted as (xdistorted, ydistorted):
xdistorted = x + [2 * p1 * y + p2 * (r2 + 2 * x2)]
ydistorted = y + [p1 * (r2 + 2*y2) + 2 * p2 * x]
.

• x, y: undistorted pixel locations
• p1 and p2: tangential distortion coefficients of the lens
• r2 = x2 + y2

The undistorted pixel locations are in normalized image coordinates, with the origin at
the optical center. The coordinates are in world units.
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When you select the Compute Tangential Distortion check box, the calibrator
estimates the tangential distortion coefficients. Otherwise, the calibrator sets the
tangential distortion coefficients to zero.

Export Camera Parameters

When you are satisfied with calibration accuracy, click Export Camera Parameters.
You can save and export the camera parameters to an object or generate the camera
parameters as a MATLAB script.

Export Camera Parameters

Click Export Camera Parameters to create a stereoParameters object in your
workspace. The object contains the intrinsic and extrinsic parameters of the camera,
and the distortion coefficients. You can use this object for various computer vision
tasks, such as image undistortion, measuring planar objects, and 3-D reconstruction.
See “Stereo Calibration and Scene Reconstruction”. You can optionally export the
stereoCalibrationErrors object, which contains the standard errors of estimated
stereo parameters.
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Generate MATLAB Script

You can also generate a MATLAB script which allows you save and reproduce the steps
from your calibration session.

References

[1] Zhang, Z. “A Flexible New Technique for Camera Calibration”. IEEE Transactions on
Pattern Analysis and Machine Intelligence.Vol. 22, No. 11, 2000, pp. 1330–1334.

[2] Heikkila, J, and O. Silven. “A Four-step Camera Calibration Procedure with Implicit
Image Correction.” IEEE International Conference on Computer Vision and
Pattern Recognition. 1997.

See Also
cameraParameters | stereoParameters | Camera Calibrator |
detectCheckerboardPoints | estimateCameraParameters |
generateCheckerboardPoints | showExtrinsics | showReprojectionErrors |
Stereo Camera Calibrator | undistortImage

Related Examples
• “Evaluating the Accuracy of Single Camera Calibration”
• “Measuring Planar Objects with a Calibrated Camera”
• “Stereo Calibration and Scene Reconstruction”
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• “Depth Estimation From Stereo Video”
• “Sparse 3-D Reconstruction From Two Views”
• “Uncalibrated Stereo Image Rectification”
• Checkerboard pattern

More About
• “Single Camera Calibration App”

External Web Sites
• Camera Calibration with MATLAB

http://www.mathworks.com/videos/camera-calibration-with-matlab-81233.html
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• “Point Feature Types” on page 5-2
• “Local Feature Detection and Extraction” on page 5-7
• “Label Images for Classification Model Training” on page 5-28
• “Train a Cascade Object Detector” on page 5-35
• “Troubleshoot ocr Function Results” on page 5-50
• “Create a Custom Feature Extractor” on page 5-51
• “Image Retrieval with Bag of Visual Words” on page 5-55
• “Image Classification with Bag of Visual Words” on page 5-59
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Point Feature Types

Image feature detection is a building block of many computer vision tasks, such as
image registration, tracking, and object detection. The Computer Vision System Toolbox
includes a variety of functions for image feature detection. These functions return points
objects that store information specific to particular types of features, including (x,y)
coordinates (in the Location property). You can pass a points object from a detection
function to a variety of other functions that require feature points as inputs. The
algorithm that a detection function uses determines the type of points object it returns.

Functions That Return Points Objects

Points Object Returned By Type of Feature

detectFASTFeatures

Features from accelerated
segment test (FAST)
algorithm
Uses an approximate
metric to determine
corners.[1]
detectMinEigenFeatures

Minimum eigenvalue
algorithm
Uses minimum eigenvalue
metric to determine corner
locations. [4]

cornerPoints

detectHARRISFeatures

Harris-Stephens algorithm
More efficient than the
minimum eigenvalue
algorithm.[3]

Corners
Single-scale detection
Point tracking, image registration
with little or no scale change, corner
detection in scenes of human origin,
such as streets and indoor scenes.

BRISKPoints detectBRISKFeatures

Binary Robust Invariant
Scalable Keypoints
(BRISK) algorithm [6]
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Points Object Returned By Type of Feature

Corners
Multiscale detection
Point tracking, image registration,
handles changes in scale and rotation,
corner detection in scenes of human
origin, such as streets and indoor
scenes

SURFPoints detectSURFFeatures

Speeded-up robust features
(SURF) algorithm[11]

Blobs
Multiscale detection
Object detection and image
registration with scale and rotation
changes

MSERRegions detectMSERFeatures

Maximally stable extremal
regions (MSER) algorithm

[7] [8] [9] [10]

Regions of uniform intensity
Multi-scale detection
Registration, wide baseline stereo
calibration, text detection, object
detection. Handles changes to scale
and rotation. More robust to affine
transforms in contrast to other
detectors.
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Functions That Accept Points Objects

Function Description

Extract interest point descriptors
Method Feature Vector
BRISK The function sets the Orientation property of

the validPoints output object to the orientation of
the extracted features, in radians.

FREAK The function sets the Orientation property of
the validPoints output object to the orientation of
the extracted features, in radians.

SURF The function sets the Orientation property of
the validPoints output object to the orientation of
the extracted features, in radians.

When you use an MSERRegions object with
the SURF method, the Centroid property
of the object extracts SURF descriptors.
The Axes property of the object selects
the scale of the SURF descriptors such
that the circle representing the feature
has an area proportional to the MSER
ellipse area. The scale is calculated as
1/4*sqrt((majorAxes/2).*(minorAxes/2))

and saturated to 1.6, as required by the
SURFPoints object.

Block Simple square neighbhorhood.

The Block method extracts only the
neighborhoods fully contained within the image
boundary. Therefore, the output, validPoints,
can contain fewer points than the input POINTS.

extractFeatures

Auto The function selects the Method based on the
class of the input points and implements:
The FREAK method for a cornerPoints input
object.
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Function Description

The SURF method for a SURFPoints or
MSERRegions input object.
The FREAK method for a BRISKPoints input
object.

For an M-by-2 input matrix of [x y] coordinates,
the function implements the Block method.

extractHOGFeaturesExtract histogram of oriented gradients (HOG) features
estimateGeometricTransformEstimate geometric transform from matching point pairs
triangulate 3-D locations of undistorted matching points in stereo images
estimateFundamentalMatrixEstimate fundamental matrix from corresponding points in stereo

images
estimateUncalibratedRectificationUncalibrated stereo rectification
insertMarker Insert markers in image or video
showMatchedFeaturesDisplay corresponding feature points
undistortPoints Correct point coordinates for lens distortion
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Related Examples
• “Detect BRISK Points in an Image and Mark Their Locations”
• “Find Corner Points in an Image Using the FAST Algorithm”
• “Find Corner Points Using the Harris-Stephens Algorithm”
• “Find Corner Points Using the Eigenvalue Algorithm”
• “Find MSER Regions in an Image”
• “Detect SURF Interest Points in a Grayscale Image”
• “Automatically Detect and Recognize Text in Natural Images”
• “Object Detection in a Cluttered Scene Using Point Feature Matching”
• “Image Search Using Point Features”
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Local Feature Detection and Extraction

Local features and their descriptors, which are a compact vector representations of a
local neighborhood, are the building blocks of many computer vision algorithms. Their
applications include image registration, object detection and classification, tracking, and
motion estimation. Using local features enables these algorithms to better handle scale
changes, rotation, and occlusion. The Computer Vision System Toolbox™ provides the
FAST, Harris, and Shi & Tomasi methods for detecting corner features, and the SURF
and MSER methods for detecting blob features. The toolbox includes the SURF, FREAK,
BRISK, and HOG descriptors. You can mix and match the detectors and the descriptors
depending on the requirements of your application.

What Are Local Features?

Local features refer to a pattern or distinct structure found in an image, such as a point,
edge, or small image patch. They are usually associated with an image patch that differs
from its immediate surroundings by texture, color, or intensity. What the feature actually
represents does not matter, just that it is distinct from its surroundings. Examples of
local features are blobs, corners, and edge pixels.

Example of Corner Detection

I = imread('circuit.tif');

corners = detectFASTFeatures(I,'MinContrast',0.1);

J = insertMarker(I,corners,'circle');

imshow(J);
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Benefits and Applications of Local Features

Local features let you find image correspondences regardless of occlusion, changes in
viewing conditions, or the presence of clutter. In addition, the properties of local features
make them suitable for image classification, such as in “Image Classification with Bag of
Visual Words”.

Local features are used in two fundamental ways:

• To localize anchor points for use in image stitching or 3-D reconstruction.
• To represent image contents compactly for detection or classification, without

requiring image segmentation.

Application MATLAB Examples

Image registration and stitching “Feature Based Panoramic Image Stitching”
Object detection “Object Detection in a Cluttered Scene Using Point

Feature Matching”
Object recognition “Digit Classification Using HOG Features”
Object tracking “Face Detection and Tracking Using the KLT

Algorithm”
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Application MATLAB Examples

Image category recognition “Image Category Classification Using Bag of
Features”

Finding geometry of a stereo
system

“Uncalibrated Stereo Image Rectification”

3-D reconstruction “Sparse 3-D Reconstruction From Two Views”
Image retrieval “Image Search Using Point Features”

What Makes a Good Local Feature?

Detectors that rely on gradient-based and intensity variation approaches detect good
local features. These features include edges, blobs, and regions. Good local features
exhibit the following properties:

• Repeatable detections:
When given two images of the same scene, most features that the detector finds in
both images are the same. The features are robust to changes in viewing conditions
and noise.

• Distinctive:
The neighborhood around the feature center varies enough to allow for a reliable
comparison between the features.

• Localizable:
The feature has a unique location assigned to it. Changes in viewing conditions do not
affect its location.

Feature Detection and Feature Extraction

Feature detection selects regions of an image that have unique content, such as corners
or blobs. Use feature detection to find points of interest that you can use for further
processing. These points do not necessarily correspond to physical structures, such as
the corners of a table. The key to feature detection is to find features that remain locally
invariant so that you can detect them even in the presence of rotation or scale change.

Feature extraction involves computing a descriptor, which is typically done on regions
centered around detected features. Descriptors rely on image processing to transform a
local pixel neighborhood into a compact vector representation. This new representation
permits comparison between neighborhoods regardless of changes in scale or orientation.
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Descriptors, such as SIFT or SURF, rely on local gradient computations. Binary
descriptors, such as BRISK or FREAK, rely on pairs of local intensity differences, which
are then encoded into a binary vector.

Choose a Feature Detector and Descriptor

Select the best feature detector and descriptor by considering the criteria of your
application and the nature of your data. The first table helps you understand the general
criteria to drive your selection. The next two tables provide details on the detectors and
descriptors available in Computer Vision System Toolbox.

Considerations for Selecting a Detector and Descriptor

Criteria Suggestion

 
 
 

Type of features in your image Use a detector appropriate for your data.
For example, if your image contains
an image of bacteria cells, use the blob
detector rather than the corner detector. If
your image is an aerial view of a city, you
can use the corner detector to find man-
made structures.

 

Context in which you are using the
features:

• Matching key points
• Classification

The HOG and SURF descriptors are
suitable for classification tasks. In contrast,
binary descriptors, such as BRISK and
FREAK, are typically used for finding point
correspondences between images, which
are used for registration.

Type of distortion present in your image Choose a detector and descriptor that
addresses the distortion in your data.
For example, if there is no scale change
present, consider a corner detector that
does not handle scale. If your data contains
a higher level of distortion, such as
scale and rotation, then use the more
computationally intensive SURF feature
detector and descriptor.

Performance requirements:

• Real-time performance required

Binary descriptors are generally faster
but less accurate than gradient-based
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Criteria Suggestion

• Accuracy versus speed descriptors. For greater accuracy, use
several detectors and descriptors at the
same time.

Choose a Detection Function Based on Feature Type

Detector Feature Type Function Scale Independent

FAST [1] Corner detectFASTFeaturesNo
Minimum eigenvalue
algorithm[4]

Corner detectMinEigenFeaturesNo

Corner detector [3] Corner detectHarrisFeaturesNo
SURF [11] Blob detectSURFFeaturesYes
BRISK [6] Corner detectBRISKFeaturesYes
MSER [8] Region with uniform

intensity
detectMSERFeaturesYes

Note: Detection functions return objects that contain information about the features.
The extractHOGFeatures and extractFeatures functions use these objects to create
descriptors.

Choose a Descriptor Method

Invariance Typical UseDescriptor Binary Function
and Method Scale Rotation Finding

Point
Correspondences

Classification

HOG No extractHOGFeatures(I, ...)No No No Yes
SURF No extractFeatures(I,

'Method','SURF')
Yes Yes Yes Yes

FREAK Yes extractFeatures(I,
'Method','FREAK')

Yes Yes Yes No

BRISK Yes extractFeatures(I,
'Method','BRISK')

Yes Yes Yes No
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Invariance Typical UseDescriptor Binary Function
and Method Scale Rotation Finding

Point
Correspondences

Classification

• Block
• Simple

pixel
neighborhood
around
a
keypoint

No extractFeatures(I,
'Method','Block')

No No Yes Yes

Note:

• The extractFeatures function provides different extraction methods to best match
the requirements of your application. When you do not specify the 'Method' input for

the extractFeatures function, the function automatically selects the method based
on the type of input point class.

• Binary descriptors are fast but less precise in terms of localization. They are
not suitable for classification tasks. The extractFeatures function returns a
binaryFeatures object. This object enables the Hamming-distance-based matching
metric used in the matchFeatures function.

Use Local Features

Registering two images is a simple way to understand local features. This example
finds a geometric transformation between two images. It uses local features to find well-
localized anchor points.

Display two images.

The first image is the original image.

original = imread('cameraman.tif');

figure;

imshow(original);
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The second image, is the original image rotated and scaled.

scale = 1.3;

J = imresize(original,scale);

theta = 31;

distorted = imrotate(J,theta);

figure

imshow(distorted)
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Detect matching features between the original and distorted image.

Detecting the matching SURF features is the first step in determining the transform
needed to correct the distorted image.

ptsOriginal  = detectSURFFeatures(original);
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ptsDistorted = detectSURFFeatures(distorted);

Extract features and compare the detected blobs between the two images.

The detection step found several roughly corresponding blob structures in both images.
Compare the detected blob features. This process is facilitated by feature extraction,
which determines a local patch descriptor.

[featuresOriginal,validPtsOriginal]  = extractFeatures(original,ptsOriginal);

[featuresDistorted,validPtsDistorted] = extractFeatures(distorted,ptsDistorted);

It is possible that not all of the original points were used to extract descriptors. Points
might have been rejected if they were too close to the image border. Therefore, the valid
points are returned in addition to the feature descriptors.

The patch size used to compute the descriptors is determined during the feature
extraction step. The patch size corresponds to the scale at which the feature is detected.
Regardless of the patch size, the two feature vectors, featuresOriginal and
featuresDistorted, are computed in such a way that they are of equal length. The
descriptors enable you to compare detected features, regardless of their size and rotation.

Find candidate matches.

Obtain candidate matches between the features by inputting the descriptors to the
matchFeatures function. Candidate matches imply that the results can contain some
invalid matches. Two patches that match can indicate like features but might not be
a correct match. A table corner can look like a chair corner, but the two features are
obviously not a match.

indexPairs = matchFeatures(featuresOriginal,featuresDistorted);

Find point locations from both images.

Each row of the returned indexPairs contains two indices of candidate feature matches
between the images. Use the indices to collect the actual point locations from both
images.

matchedOriginal  = validPtsOriginal(indexPairs(:,1));

matchedDistorted = validPtsDistorted(indexPairs(:,2));

Display the candidate matches.

figure

showMatchedFeatures(original,distorted,matchedOriginal,matchedDistorted)
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title('Candidate matched points (including outliers)')

Analyze the feature locations.

If there are a sufficient number of valid matches, remove the false matches.
An effective technique for this scenario is the RANSAC algorithm. The
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estimateGeometricTransform function implements M-estimator sample consensus
(MSAC), which is a variant of the RANSAC algorithm. MSAC finds a geometric
transform and separates the inliers (correct matches) from the outliers (spurious
matches).

[tform, inlierDistorted,inlierOriginal] = estimateGeometricTransform(matchedDistorted,matchedOriginal,'similarity');

Display the matching points.

figure

showMatchedFeatures(original,distorted,inlierOriginal,inlierDistorted)

title('Matching points (inliers only)')

legend('ptsOriginal','ptsDistorted')
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Verify the computed geometric transform.

Apply the computed geometric transform to the distorted image.

outputView = imref2d(size(original));

recovered  = imwarp(distorted,tform,'OutputView',outputView);
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Display the recovered image and the original image.

figure

imshowpair(original,recovered,'montage')

Image Registration Using Multiple Features

This example builds on the results of the "Use Local Features" example. Using more
than one detector and descriptor pair enables you to combine and reinforce your results.
Multiple pairs are also useful for when you cannot obtain enough good matches (inliers)
using a single feature detector.

Load the original image.

original = imread('cameraman.tif');

figure;

imshow(original);

text(size(original,2),size(original,1)+15, ...

    'Image courtesy of Massachusetts Institute of Technology', ...

    'FontSize',7,'HorizontalAlignment','right');
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Scale and rotate the original image to create the distorted image.

scale = 1.3;

J = imresize(original, scale);

theta = 31;

distorted = imrotate(J,theta);

figure

imshow(distorted)
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Detect the features in both images. Use the BRISK detectors first, followed by the SURF
detectors.

ptsOriginalBRISK  = detectBRISKFeatures(original, 'MinContrast', 0.01);

ptsDistortedBRISK = detectBRISKFeatures(distorted, 'MinContrast', 0.01);
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ptsOriginalSURF  = detectSURFFeatures(original);

ptsDistortedSURF = detectSURFFeatures(distorted);

Extract descriptors from the original and distorted images. The BRISK features use the
FREAK descriptor by default.

[featuresOriginalFREAK,  validPtsOriginalBRISK]  = extractFeatures(original,  ptsOriginalBRISK);

[featuresDistortedFREAK, validPtsDistortedBRISK] = extractFeatures(distorted, ptsDistortedBRISK);

[featuresOriginalSURF,  validPtsOriginalSURF]  = extractFeatures(original,  ptsOriginalSURF);

[featuresDistortedSURF, validPtsDistortedSURF] = extractFeatures(distorted, ptsDistortedSURF);

Determine candidate matches by matching FREAK descriptors first, and then SURF
descriptors. To obtain as many feature matches as possible, start with detector and
matching thresholds that are lower than the default values. Once you get a working
solution, you can gradually increase the thresholds to reduce the computational load
required to extract and match features.

indexPairsBRISK = matchFeatures(featuresOriginalFREAK, featuresDistortedFREAK, 'MatchThreshold', 40, 'MaxRatio', 0.8);

indexPairsSURF = matchFeatures(featuresOriginalSURF, featuresDistortedSURF);

Obtain candidate matched points for BRISK and SURF.

matchedOriginalBRISK  = validPtsOriginalBRISK(indexPairsBRISK(:,1));

matchedDistortedBRISK = validPtsDistortedBRISK(indexPairsBRISK(:,2));

matchedOriginalSURF  = validPtsOriginalSURF(indexPairsSURF(:,1));

matchedDistortedSURF = validPtsDistortedSURF(indexPairsSURF(:,2));

Visualize the BRISK putative matches.

figure

showMatchedFeatures(original, distorted, matchedOriginalBRISK, matchedDistortedBRISK)

title('Putative matches using BRISK & FREAK')

legend('ptsOriginalBRISK','ptsDistortedBRISK')
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Combine the candiate matched BRISK and SURF local features. Use the Location
property to combine the point locations from BRISK and SURF features.

matchedOriginalXY  = [matchedOriginalSURF.Location; matchedOriginalBRISK.Location];

matchedDistortedXY = [matchedDistortedSURF.Location; matchedDistortedBRISK.Location];
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Determine the inlier points and the geometric transform of the BRISK and SURF
features.

[tformTotal,inlierDistortedXY,inlierOriginalXY] = estimateGeometricTransform(matchedDistortedXY,matchedOriginalXY,'similarity');

Display the results. The result provides several more matches than the example that
used a single feature detector.

figure

showMatchedFeatures(original,distorted,inlierOriginalXY,inlierDistortedXY)

title('Matching points using SURF and BRISK (inliers only)')

legend('ptsOriginal','ptsDistorted')
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Compare the original and recovered image.

outputView = imref2d(size(original));

recovered  = imwarp(distorted,tformTotal,'OutputView',outputView);

figure;
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imshowpair(original,recovered,'montage')
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Related Examples
• “Detect BRISK Points in an Image and Mark Their Locations”
• “Find Corner Points in an Image Using the FAST Algorithm”
• “Find Corner Points Using the Harris-Stephens Algorithm”
• “Find Corner Points Using the Eigenvalue Algorithm”
• “Find MSER Regions in an Image”
• “Detect SURF Interest Points in a Grayscale Image”
• “Automatically Detect and Recognize Text in Natural Images”
• “Object Detection in a Cluttered Scene Using Point Feature Matching”
• “Image Search Using Point Features”
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Label Images for Classification Model Training

In this section...

“Description” on page 5-28
“Open the Training Image Labeler” on page 5-28
“App Controls” on page 5-28
“Example” on page 5-32

Description

The Training Image Labeler provides an easy way to label positive samples that the
trainCascadeObjectDetector function uses to create a cascade classifier. Using this
app, you can:

• Interactively specify rectangular regions of interest (ROIs).
• Using the ROIs, you can detect objects of interest in target images with the

vision.CascadeObjectDetector System object.
• You can load multiple images at one time, draw ROIs, and then

export the ROI information in the appropriate format for the
trainCascadeObjectDetector. The labeler app supports all image data formats
that the trainCascadeObjectDetector function uses.

Open the Training Image Labeler

• MATLAB Toolstrip: Open the Apps tab, under Image Processing and Computer
Vision, click the app icon.

• MATLAB command prompt: Enter trainingImageLabeler

App Controls

You can add an unlimited number of images to the Data Browser. You can then select,
remove, and create ROIs, and save your session. When you are done, you can export the
ROI information to an XML file.



 Label Images for Classification Model Training

5-29

 Add Images

Use the Add Images icon to select and add images to the Data Browser. You can add
more images at any time during your editing session. The source images remain in the
folder where they were originally located. The app does not make copies of the original
images or move them. If you rotate the images in the Data Browser, the app overwrites
the images in their original location with the modified orientation.

The app provides a list of image thumbnails that you loaded for the session. Next to each
thumbnail, you see the file name and number of ROIs created in that image.

 Specify Regions of Interest

After you have loaded images, you can delineate ROIs. You can switch between images
and continue creating ROIs. Drag the cursor over the object in the image that you want
to identify for an ROI. You can modify the size of an ROI by clicking either the corner
or side grips. To copy and paste an ROI, left-click within it’s border to select it. You can
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select one or more ROIs to move or to copy and paste. To delete an ROI, click the red x-
box, , in the upper-right corner.

 Remove, Rotate, and Sort Images

You can remove, rotate, or sort the images. Right-click any image to access these
options. To select multiple images, press Ctrl+click. To select consecutive images, press
Shift+click. To sort images by the number of ROIs, from least amount of ROIs contained
in each image, right-click any image and select Sort list by number of ROIs.

 New Session

When you start a new session, you can save the current session before clearing it.
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 Open Session

You can open a new session to replace or add to the current session. The app loads the
selected .MAT session file. To replace your current session, from the Open Session
options, select Open an existing session. To combine multiple sessions, select Add
session to the current session.

 Save Session

You can name and save your session to a .MAT file. The default name is
LabelingSession. The saved session file contains all the required information to reload
the session in the state that you saved it. It contains the paths to the original images,
the coordinates for the ROI bounding boxes for each image, file names, and logical
information to record the state of the files.

 Export ROIs

When you click the Export ROIs button, the app exports the ROI information to the
MATLAB workspace in a 1-by-M structure, where M represents the number of images.
The structure contains two fields. One field stores the image file location and the other
field stores the corresponding ROI information for each image. You are prompted to
name the variable or to accept the default positiveInstances name. The first field,
imageFileName, contains the full path and file name of the images. The app does not
copy and resave images, so the stored path refers to the original image and folder that
you loaded the images from. The second field, objectBoundingBoxes, contains the ROI [x,
y, width, height] information.
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Example

Train a Five-Stage Stop-Sign Detector

This example shows how to set up and train a five-stage, stop-sign detector, using 86
positive samples. The default value for TruePositiveRate is 0.995.

Step 1: Load the positive samples data from a MAT file. File names and bounding boxes
are contained in the array of structures labeled 'data'.

load('stopSigns.mat');

Step 2: Add the image directory to the MATLAB path.

imDir = fullfile(matlabroot,'toolbox','vision','visiondata','stopSignImages');

addpath(imDir);

Step 3: Specify folder with negative images.

negativeFolder = fullfile(matlabroot,'toolbox','vision','visiondata','non_stop_signs');

Step 4: Train the detector.

trainCascadeObjectDetector('stopSignDetector.xml',data,negativeFolder,'FalseAlarmRate',0.2,'NumCascadeStages',5);

Computer Vision software returns the following message:
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Notice that all 86 positive samples were used to train each stage. This is because the
true-positive rate is very high relative to the number of positive samples.

See Also
vision.CascadeObjectDetector | imrect | insertObjectAnnotation |
trainCascadeObjectDetector | Training Image Labeler

More About
• “Train a Cascade Object Detector”
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External Web Sites
• Cascade Training GUI

http://www.mathworks.com/matlabcentral/fileexchange/39627
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Train a Cascade Object Detector

In this section...

“Why Train a Detector?” on page 5-35
“What Kinds of Objects Can You Detect?” on page 5-35
“How Does the Cascade Classifier Work?” on page 5-36
“Create a Cascade Classifier Using the trainCascadeObjectDetector” on page
5-37
“Troubleshooting” on page 5-41
“Examples” on page 5-42

Why Train a Detector?

The vision.CascadeObjectDetector System object comes with several pretrained
classifiers for detecting frontal faces, profile faces, noses, eyes, and the upper body.
However, these classifiers are not always sufficient for a particular application.
Computer Vision System Toolbox provides the trainCascadeObjectDetector function
to train a custom classifier.

What Kinds of Objects Can You Detect?

The Computer Vision System Toolbox cascade object detector can detect object categories
whose aspect ratio does not vary significantly. Objects whose aspect ratio remains
approximately fixed include faces, stop signs, and cars viewed from one side.

The vision.CascadeObjectDetector System object detects objects in images by
sliding a window over the image. The detector then uses a cascade classifier to decide
whether the window contains the object of interest. The size of the window varies to
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detect objects at different scales, but its aspect ratio remains fixed. The detector is very
sensitive to out-of-plane rotation, because the aspect ratio changes for most 3-D objects.
Thus, you need to train a detector for each orientation of the object. Training a single
detector to handle all orientations will not work.

How Does the Cascade Classifier Work?

The cascade classifier consists of stages, where each stage is an ensemble of weak
learners. The weak learners are simple classifiers called decision stumps. Each stage is
trained using a technique called boosting. Boosting provides the ability to train a highly
accurate classifier by taking a weighted average of the decisions made by the weak
learners.

Each stage of the classifier labels the region defined by the current location of the sliding
window as either positive or negative. Positive indicates that an object was found and
negative indicates no objects were found. If the label is negative, the classification of this
region is complete, and the detector slides the window to the next location. If the label
is positive, the classifier passes the region to the next stage. The detector reports an
object found at the current window location when the final stage classifies the region as
positive.

The stages are designed to reject negative samples as fast as possible. The assumption is
that the vast majority of windows do not contain the object of interest. Conversely, true
positives are rare and worth taking the time to verify.

• A true positive occurs when a positive sample is correctly classified.
• A false positive occurs when a negative sample is mistakenly classified as positive.
• A false negative occurs when a positive sample is mistakenly classified as negative.

To work well, each stage in the cascade must have a low false negative rate. If a stage
incorrectly labels an object as negative, the classification stops, and you cannot correct
the mistake. However, each stage can have a high false positive rate. Even if the detector
incorrectly labels a nonobject as positive, you can correct the mistake in subsequent
stages.

The overall false positive rate of the cascade classifier is fs, where f is the false positive
rate per stage in the range (0 1), and s is the number of stages. Similarly, the overall
true positive rate is ts, where t is the true positive rate per stage in the range (0 1]. Thus,
adding more stages reduces the overall false positive rate, but it also reduces the overall
true positive rate.



 Train a Cascade Object Detector

5-37

Create a Cascade Classifier Using the
trainCascadeObjectDetector

Cascade classifier training requires a set of positive samples and a set of negative
images. You must provide a set of positive images with regions of interest specified to
be used as positive samples. You can use the Training Image Labeler to label objects of
interest with bounding boxes. The Training Image Labeler outputs an array of structs
to use for positive samples. You also must provide a set of negative images from which
the function generates negative samples automatically. To achieve acceptable detector
accuracy, set the number of stages, feature type, and other function parameters.

Considerations when Setting Parameters

Select the function parameters to optimize the number of stages, the false positive rate,
the true positive rate, and the type of features to use for training. When you set the
parameters, consider these tradeoffs.
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Condition Consideration

A large training set (in the thousands). Increase the number of stages and set a
higher false positive rate for each stage.

A small training set. Decrease the number of stages and set a
lower false positive rate for each stage.

To reduce the probability of missing an
object.

Increase the true positive rate. However,
a high true positive rate can prevent you
from achieving the desired false positive
rate per stage, making the detector more
likely to produce false detections.

To reduce the number of false detections. Increase the number of stages or decrease
the false alarm rate per stage.

Feature Types Available for Training

Choose the feature that suits the type of object detection you need. The
trainCascadeObjectDetector supports three types of features: Haar, local binary
patterns (LBP), and histograms of oriented gradients (HOG). Haar and LBP features are
often used to detect faces because they work well for representing fine-scale textures. The
HOG features are often used to detect objects such as people and cars. They are useful for
capturing the overall shape of an object. For example, in the following visualization of the
HOG features, you can see the outline of the bicycle.

You might need to run the trainCascadeObjectDetector function multiple times to
tune the parameters. To save time, you can use LBP or HOG features on a small subset
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of your data. Training a detector using Haar features takes much longer. After that, you
can run the Haar features to see if the accuracy improves.

Supply Positive Samples

To create positive samples easily, you can use the Training Image Labeler app. The
Training Image Labeler provides an easy way to label positive samples by interactively
specifying rectangular regions of interest (ROIs).

You can also specify positive samples manually in one of two ways. One way is to specify
rectangular regions in a larger image. The regions contain the objects of interest. The
other approach is to crop out the object of interest from the image and save it as a
separate image. Then, you can specify the region to be the entire image. You can also
generate more positive samples from existing ones by adding rotation or noise, or by
varying brightness or contrast.

Supply Negative Images

Negative samples are not specified explicitly. Instead, the
trainCascadeObjectDetector function automatically generates negative samples
from user-supplied negative images that do not contain objects of interest. Before
training each new stage, the function runs the detector consisting of the stages already
trained on the negative images. Any objects detected from these image are false positives,
which are used as negative samples. In this way, each new stage of the cascade is trained
to correct mistakes made by previous stages.
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As more stages are added, the detector's overall false positive rate decreases, causing
generation of negative samples to be more difficult. For this reason, it is helpful to supply
as many negative images as possible. To improve training accuracy, supply negative
images that contain backgrounds typically associated with the objects of interest. Also,
include negative images that contain nonobjects similar in appearance to the objects of
interest. For example, if you are training a stop-sign detector, include negative images
that contain road signs and shapes similar to a stop sign.

Choose the Number of Stages

There is a trade-off between fewer stages with a lower false positive rate per stage or
more stages with a higher false positive rate per stage. Stages with a lower false positive
rate are more complex because they contain a greater number of weak learners. Stages
with a higher false positive rate contain fewer weak learners. Generally, it is better to
have a greater number of simple stages because at each stage the overall false positive
rate decreases exponentially. For example, if the false positive rate at each stage is 50%,
then the overall false positive rate of a cascade classifier with two stages is 25%. With
three stages, it becomes 12.5%, and so on. However, the greater the number of stages, the
greater the amount of training data the classifier requires. Also, increasing the number
of stages increases the false negative rate. This increase results in a greater chance of
rejecting a positive sample by mistake. Set the false positive rate (FalseAlarmRate) and
the number of stages, (NumCascadeStages) to yield an acceptable overall false positive
rate. Then you can tune these two parameters experimentally.

Training can sometimes terminate early. For example, suppose that training stops after
seven stages, even though you set the number of stages parameter to 20. It is possible
that the function cannot generate enough negative samples. If you run the function
again and set the number of stages to seven, you do not get the same result. The results
between stages differ because the number of positive and negative samples to use for
each stage is recalculated for the new number of stages.
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Training Time of Detector

Training a good detector requires thousands of training samples. Large amounts of
training data can take hours or even days to process. During training, the function
displays the time it took to train each stage in the MATLAB Command Window. Training
time depends on the type of feature you specify. Using Haar features takes much longer
than using LBP or HOG features.

Troubleshooting

What if you run out of positive samples?

The trainCascadeObjectDetector function automatically determines the number
of positive samples to use to train each stage. The number is based on the total number
of positive samples supplied by the user and the values of the TruePositiveRate and
NumCascadeStages parameters.

The number of available positive samples used to train each stage depends on the true
positive rate. The rate specifies what percentage of positive samples the function can
classify as negative. If a sample is classified as a negative by any stage, it never reaches
subsequent stages. For example, suppose you set the TruePositiveRate to 0.9, and
all of the available samples are used to train the first stage. In this case, 10% of the
positive samples are rejected as negatives, and only 90% of the total positive samples are
available for training the second stage. If training continues, then each stage is trained
with fewer and fewer samples. Each subsequent stage must solve an increasingly more
difficult classification problem with fewer positive samples. With each stage getting fewer
samples, the later stages are likely to overfit the data.

Ideally, use the same number of samples to train each stage. To do so, the number of
positive samples used to train each stage must be less than the total number of available
positive samples. The only exception is that when the value of TruePositiveRate times
the total number of positive samples is less than 1, no positive samples are rejected as
negatives.

The function calculates the number of positive samples to use at each stage using the
following formula:
number of positive samples = floor(totalPositiveSamples / (1 + (NumCascadeStages - 1)
* (1 - TruePositiveRate)))
This calculation does not guarantee that the same number of positive samples are
available for each stage. The reason is that it is impossible to predict with certainty
how many positive samples will be rejected as negatives. The training continues as long
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as the number of positive samples available to train a stage is greater than 10% of the
number of samples the function determined automatically using the preceding formula.
If there are not enough positive samples the training stops and the function issues a
warning. The function also outputs a classifier consisting of the stages that it had trained
up to that point. If the training stops, you can add more positive samples. Alternatively,
you can increase TruePositiveRate. Reducing the number of stages can also work, but
such reduction can also result in a higher overall false alarm rate.

What to do if you run out of negative samples?

The function calculates the number of negative samples used at each stage. This
calculation is done by multiplying the number of positive samples used at each stage by
the value of NegativeSamplesFactor.

Just as with positive samples, there is no guarantee that the calculated
number of negative samples are always available for a particular stage. The
trainCascadeObjectDetector function generates negative samples from the negative
images. However, with each new stage, the overall false alarm rate of the cascade
classifier decreases, making it less likely to find the negative samples.

The training continues as long as the number of negative samples available to train a
stage is greater than 10% of the calculated number of negative samples. If there are
not enough negative samples, the training stops and the function issues a warning. It
outputs a classifier consisting of the stages that it had trained up to that point. When the
training stops, the best approach is to add more negative images. Alternatively, you can
reduce the number of stages or increase the false positive rate.

Examples

Train a Five-Stage Stop-Sign Detector

This example shows you how to set up and train a five-stage, stop-sign detector, using 86
positive samples. The default value for TruePositiveRate is 0.995.

Step 1: Load the positive samples data from a MAT-file. File names and bounding boxes
are contained in the array of structures labeled 'data'.

load('stopSigns.mat');

Step 2: Add the image directory to the MATLAB path.

imDir = fullfile(matlabroot,'toolbox','vision','visiondata','stopSignImages');
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addpath(imDir);

Step 3: Specify the folder with negative images.

negativeFolder = fullfile(matlabroot,'toolbox','vision','visiondata','non_stop_signs');

Step 4: Train the detector.

trainCascadeObjectDetector('stopSignDetector.xml',data,negativeFolder,'FalseAlarmRate',0.2,'NumCascadeStages',5);

Computer Vision System Toolbox software returns the following message:

All 86 positive samples were used to train each stage. This high rate occurs because the
true positive rate is very high relative to the number of positive samples.
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Train a Five-Stage Stop-Sign Detector with a Decreased True Positive Rate

This example shows you how to train a stop-sign detector on the same data set as the
first example, (steps 1–3), but with the TruePositiveRate decreased to 0.98.

Step 4: Train the detector.

trainCascadeObjectDetector('stopSignDetector_tpr0_98.xml',data,negativeFolder,'FalseAlarmRate',0.2,'NumCascadeStages', 5,'TruePositiveRate', 0.98);

Only 79 of the total 86 positive samples were used to train each stage. This lowered rate
occurs because the true positive rate was low enough for the function to start rejecting
some of the positive samples as false negatives.
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Train a Ten-Stage Stop-Sign Detector

This example shows you how to train a stop-sign detector on the same data set as the
first example, (steps 1–3), but with the number of stages increased to 10.

Step 4: Train the detector.

trainCascadeObjectDetector('stopSignDetector_10stages.xml',data,negativeFolder,'FalseAlarmRate',0.2,'NumCascadeStages',10);
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In this case, NegativeSamplesFactor was set to 2, therefore the number of negative
samples used to train each stage was 172. Notice that the function generated only 33
negative samples for stage 6 and was not able to train stage 7 at all. This condition
occurs because the number of negatives in stage 7 was less than 17, (roughly half of the
previous number of negative samples). The function produced a stop-sign detector with
6 stages, instead of the 10 previously specified. The resulting overall false alarm rate is
0.27=1.28e-05, while the expected false alarm rate is 1.024e-07.

At this point, you can add more negative images, reduce the number of stages, or
increase the false positive rate. For example, you can increase the false positive rate,
FalseAlarmRate, to 0.5. The expected overall false-positive rate in this case is 0.0039.

Step 4: Train the detector.

trainCascadeObjectDetector('stopSignDetector_10stages_far0_5.xml',data,negativeFolder,'FalseAlarmRate',0.5,'NumCascadeStages',10);
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This time the function trains eight stages before the threshold reaches the overall false
alarm rate of 0.000587108 and training stops.

More About
• “Label Images for Classification Model Training”

External Web Sites
• Cascade Training GUI

http://www.mathworks.com/matlabcentral/fileexchange/39627
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Troubleshoot ocr Function Results

Performance Options with the ocr Function

If your ocr results are not what you expect, try one or more of the following options:

• Increase image size 2-to-4 times larger.
• If the characters in the image are too close together or their edges are touching, use

morphology to thin out the characters. Using morphology to thin out the characters
separates the characters.

• Use binarization to check for non-uniform lighting issues. Use the graythresh and
im2bw functions to binarize the image. If the characters are not visible in the results
of the binarization, it indicates a potential non-uniform lighting issue. Try top hat,
using the imtophat function, or other techniques that deal with removing non-
uniform illumination.

• Use the region of interest roi option to isolate the text. Specify the roi manually or
use text detection.

• If your image looks like a natural scene containing words, like a street scene, rather
than a scanned document, try setting the TextLayout property to either 'Block' or
'Word'.

See Also
ocrText | graythresh | im2bw | imtophat | ocr | visionSupportPackages

More About
• “Install Computer Vision System Toolbox Support Packages”
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Create a Custom Feature Extractor

You can use the bag-of-features (BoF) framework with many different types of
image features. To use a custom feature extractor instead of the default speeded-
up robust features (SURF) feature extractor, use the CustomExtractor property of a
bagOfFeatures object.

Example of a Custom Feature Extractor

This example shows how to write a custom feature extractor function for
bagOfFeatures. You can open this example function file and use it as a template by
typing the following command at the MATLAB command prompt:

edit('exampleBagOfFeaturesExtractor.m')

• Step 1. Define the image sets.
• Step 2. Create a new extractor function file.
• Step 3. Preprocess the image.
• Step 4. Select a point location for feature extraction.
• Step 5. Extract features.
• Step 6. Compute the feature metric.

Define the image sets

You can use imageSet to define a collection of images. For example:

setDir = fullfile(toolboxdir('vision'),'visiondata','imageSets');

imgSets = imageSet(setDir,'recursive');

Create a new extractor function file

The extractor function must be specified as a function handle:

extractorFcn = @exampleBagOfFeaturesExtractor;

bag = bagOfFeatures(imgSets,'CustomExtractor',extractorFcn)

exampleBagOfFeaturesExtractor is a MATLAB function. For example:

function [features,featureMetrics] = exampleBagOfFeaturesExtractor(img)

...

You can also specify the optional location output:
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function [features,featureMetrics,location] = exampleBagOfFeaturesExtractor(img)

...

The function must be on the path or in the current working folder.

Argument Input/Output Description

img Input • Binary, grayscale, or truecolor image.
• The input image is from the image set that was

originally passed into bagOfFeatures.
features Output • An M-by-N numeric matrix of image features,

where M is the number of features and N is the
length of each feature vector.

• The feature length, N, must be greater than zero
and be the same for all images processed during
the bagOfFeatures creation process.

• If you cannot extract features from an image,
supply an empty feature matrix and an empty
feature metrics vector. Use the empty matrix
and vector if, for example, you did not find any
keypoints for feature extraction.

• Numeric, real, and nonsparse.
featureMetrics Output • An M-by-1 vector of feature metrics indicating the

strength of each feature vector.
• Used to apply the 'SelectStrongest' criteria in

bagOfFeatures framework.
• Numeric, real, and nonsparse.

location Output • An M-by-2 matrix of 1-based [x y] values.
• The [x y] values can be fractional.
• Numeric, real, and nonsparse.

Preprocess the image

Input images can require preprocessing before feature extraction. To extract SURF
features and to use the detectSURFFeatures or detectMSERFeatures functions, the
images must be grayscale. If the images are not grayscale, you can convert them using
the rgb2gray function.
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[height,width,numChannels] = size(I);

if numChannels > 1

    grayImage = rgb2gray(I);

else

    grayImage = I;

end

Select a point location for feature extraction

Use a regular spaced grid of point locations. Using the grid over the image allows for
dense SURF feature extraction. The grid step is in pixels.

gridStep = 8;

gridX = 1:gridStep:width;

gridY = 1:gridStep:height;

[x,y] = meshgrid(gridX,gridY);

gridLocations = [x(:) y(:)];

You can manually concatenate multiple SURFPoints objects at different scales to
achieve multiscale feature extraction.

multiscaleGridPoints = [SURFPoints(gridLocations,'Scale',1.6);

    SURFPoints(gridLocations,'Scale',3.2);

    SURFPoints(gridLocations,'Scale',4.8);

    SURFPoints(gridLocations,'Scale',6.4)];

Alternatively, you can use a feature detector, such as detectSURFFeatures or
detectMSERFeatures, to select point locations.

multiscaleSURFPoints = detectSURFFeatures(I);

Extract features

Extract features from the selected point locations. By default, bagOfFeatures extracts
upright SURF features.

features = extractFeatures(grayImage,multiscaleGridPoints,'Upright',true);

Compute the feature metric

The feature metrics indicate the strength of each feature. Larger metric values are
assigned to stronger features. Use feature metrics to identify and remove weak features
before using bagOfFeatures to learn the visual vocabulary of an image set. Use the
metric that is suitable for your feature vectors.
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For example, you can use the variance of the SURF features as the feature metric.

featureMetrics = var(features,[],2);

If you used a feature detector for the point selection, then use the detection metric
instead.

featureMetrics = multiscaleSURFPoints.Metric;

You can optionally return the feature location information. The feature location
can be used for spatial or geometric verification image search applications. See the
“Geometric Verification Using estimateGeometricTransform Function” example. The
retrieveImages and indexImages functions are used for content-based image
retrieval systems.

if nargout > 2

    varargout{1} = multiscaleGridPoints.Location;

end
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Image Retrieval with Bag of Visual Words

You can use the Computer Vision System Toolbox functions to search by image, also
known as a content-based image retrieval (CBIR) system. CBIR systems are used
to retrieve images from a collection of images that are similar to a query image. The
application of these types of systems can be found in many areas such as a web-based
product search, surveillance, and visual place identification. First the system searches a
collection of images to find the ones that are visually similar to a query image.

The retrieval system uses a bag of visual words, a collection of image descriptors, to
represent your data set of images. Images are indexed to create a mapping of visual
words. The index maps each visual word to their occurrences in the image set. A
comparison between the query image and the index provides the images most similar to
the query image. By using the CBIR system workflow, you can evaluate the accuracy for
a known set of image search results.
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Type of feature for retrieval?

Create image set
imgSet = imageSet(imageFolder)

non-SURF
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 .

 .

 .{
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visual words

query image

imageIDs = retrieveImages(queryImage, imageIndex)

[imageIDs, scores]  = retrieveImages(queryImage, imageIndex)
[imageIDs, scores, imageWords]  = retrieveImages(queryImage, imageIndex)

imageIDs
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Use custom feature extractor
extractor = @yourOwnExtractor

Create bag of visual words

bag= bagOfFeatures(imgSet, ’CustomExtractor’, extractor)

imgSet = imageSet(trainingImagesFolder) optional

Index images
imageIndex = indexImages(imgSet, bag)imageIndex = indexImages(imgSet)

Search image set

  .
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Retrieval System Workflow

1 Create image set that represents image features for retrieval. Use imageSet
to store the image data. Use a large number of images that represent various
viewpoints of the object. A large and diverse number of images helps train the bag of
visual words and increases the accuracy of the image search.

2 Type of feature. The indexImages function creates the bag of visual words using
the speeded up robust features (SURF). For other types of features, you can use a
custom extractor, and then use bagOfFeatures to create the bag of visual words.
See the “Create Search Index Using Custom Bag of Features” example.

You can use the original imgSet or a different collection of images for the training
set. To use a different collection, create the bag of visual words before creating
the image index, using the bagOfFeatures function. The advantage of using the
same set of images is that the visual vocabulary is tailored to the search set. The
disadvantage of this approach is that the retrieval system must relearn the visual
vocabulary to use on a drastically different set of images. With an independent set,
the visual vocabulary is better able to handle the additions of new images into the
search index.

3 Index the images. The indexImages function creates a search index that maps
visual words to their occurrences in the image collection. When you create the bag
of visual words using an independent or subset collection, include the bag as an
input argument to indexImages. If you do not create an independent bag of visual
words, then the function creates the bag based on the entire imgSet input collection.
You can add and remove images directly to and from the image index using the
addImages and removeImages methods.

4 Search data set for similar images. Use the retrieveImages function to search
the image set for images which are similar to the query image. Use the NumResults
property to control the number of results. For example, to return the top 10 similar
images, set the ROI property to use a smaller region of a query image. A smaller
region is useful for isolating a particular object in an image that you want to search
for.

Evaluate Image Retrieval

Use the evaluateImageRetrieval function to evaluate image retrieval by using a
query image with a known set of results. If the results are not what you expect, you can
modify or augment image features by the bag of visual words. Examine the type of the
features retrieved. The type of feature used for retrieval depends on the type of images
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within the collection. For example, if you are searching an image collection made up of
scenes, such as beaches, cities, or highways, use a global image feature. A global image
feature, such as a color histogram, captures the key elements of the entire scene. To find
specific objects within the image collections, use local image features extracted around
object keypoints instead.

Related Examples
• “Image Search Using Point Features”
• “Image Retrieval Using Customized Bag of Features”
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Image Classification with Bag of Visual Words
You can use the Computer Vision System Toolbox functions for image category
classification by creating a bag of visual words. The process generates a histogram of
visual word occurrences that represent an image. These histograms are used to train an
image category classifier. The steps below describe how to setup your images, create the
bag of visual words, and then train and apply an image category classifier.

Step 1: Set Up Image Category Sets

Organize and partition the images into training and test subsets. Use the imageSet
function to organize categories of images to use for training an image classifier.
Organizing images into categories makes handling large sets of images much easier. You
can use the imageSet.partition method to create subsets of representative images
from each category.

Read the category images and create the image sets.

setDir  = fullfile(toolboxdir('vision'),'visiondata','imageSets');

imgSets = imageSet(setDir,'recursive');

Separate the sets into training and test image subsets. In this example, 30% of the
images are partitioned for training and the remainder for testing.

[trainingSets,testSets] = partition(imgSets,0.3,'randomize');

partition

trainingSets

testSets

imageSets

partition

Step 2: Create Bag of Features

Create a visual vocabulary, or bag of features, by extracting feature descriptors from
representative images of each category.
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The bagOfFeatures object defines the features, or visual words, by using the k-
means clustering algorithm on the feature descriptors extracted from trainingSets. The
algorithm iteratively groups the descriptors into k mutually exclusive clusters. The
resulting clusters are compact and separated by similar characteristics. Each cluster
center represents a feature, or visual word.

You can extract features based on a feature detector, or you can define a grid to extract
feature descriptors. The grid method may lose fine-grained scale information. Therefore,
use the grid for images that do not contain distinct features, such as an image containing
scenery, like the beach. Using speeded up robust features (or SURF) detector provides
greater scale invariance. By default, the algorithm runs the 'grid' method.

...

feature detection
feature vector

clusteringextract keypoints

grid

feature descriptors

...
...

vocabulary visual words

This algorithm workflow analyzes images in their entirety. Images must have
appropriate labels describing the class that they represent. For example, a set of car
images could be labeled cars. The workflow does not rely on spatial information nor on
marking the particular objects in an image. The bag-of-visual-words technique relies on
detection without localization.

Step 3: Train an Image Classifier With Bag of Visual Words

The trainImageCategoryClassifier function returns an image classifier.
The function trains a multiclass classifier using the error-correcting output codes
(ECOC) framework with binary support vector machine (SVM) classifiers. The
trainImageCategoryClassfier function uses the bag of visual words returned by the
bagOfFeatures object to encode images in the image set into the histogram of visual
words. The histogram of visual words are then used as the positive and negative samples
to train the classifier.
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1 Use the bagOfFeatures encode method to encode each image from the training
set. This function detects and extracts features from the image and then uses the
approximate nearest neighbor algorithm to construct a feature histogram for each
image. The function then increments histogram bins based on the proximity of the
descriptor to a particular cluster center. The histogram length corresponds to the
number of visual words that the bagOfFeatures object constructed. The histogram
becomes a feature vector for the image.
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2 Repeat step 1 for each image in the training set to create the training data.
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boats

mugs

hats

3 Evaluate the quality of the classifier. Use the imageCategoryClassifier
evaluate method to test the classifier against the validation image set. The
output confusion matrix represents the analysis of the prediction. A perfect
classification results in a normalized matrix containing 1s on the diagonal. An
incorrect classification results fractional values.
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Step 4: Classify an Image or Image Set

Use the imageCategoryClassifier predict method on a new image to determine its
category.

References

[1] Csurka, G., C. R. Dance, L. Fan, J. Willamowski, and C. Bray. Visual Categorization
with Bags of Keypoints. Workshop on Statistical Learning in Computer Vision.
ECCV 1 (1–22), 1–2.

Related Examples
• “Image Category Classification Using Bag of Features”
• “Image Search Using Point Features”
• “Image Retrieval Using Customized Bag of Features”
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Motion Estimation and Tracking

• “Multiple Object Tracking” on page 6-2
• “Video Mosaicking” on page 6-6
• “Pattern Matching” on page 6-13
• “Pattern Matching” on page 6-20
• “Track an Object Using Correlation” on page 6-24
• “Panorama Creation” on page 6-28
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Multiple Object Tracking

Tracking is the process of locating a moving object or multiple objects over time in a video
stream. Tracking an object is not the same as object detection. Object detection is the
process of locating an object of interest in a single frame. Tracking associates detections
of an object across multiple frames.

Tracking multiple objects requires detection, prediction, and data association.

• Detection: Detect objects of interest in a video frame.
• Prediction: Predict the object locations in the next frame.
• Data association: Use the predicted locations to associate detections across frames

to form tracks.

Detection

Selecting the right approach for detecting objects of interest depends on what you want to
track and whether the camera is stationary.

Detect Objects Using a Stationary Camera

To detect objects in motion with a stationary camera, you can perform background
subtraction using the vision.ForegroundDetector System object. The background
subtraction approach works efficiently but requires the camera to be stationary.

Detect Objects Using a Moving Camera

To detect objects in motion with a moving camera, you can use a sliding-window
detection approach. This approach typically works more slowly than the background
subtraction approach. To detect and track a specific category of object, use the System
objects or functions described in the table.

Select A Detection Algorithm

Type of Object to Track Camera Functionality

Anything that moves Stationary vision.ForegroundDetectorSystem
object

Faces, eyes, nose, mouth,
upper body

Stationary,
Moving

vision.CascadeObjectDetectorSystem
object



 Multiple Object Tracking

6-3

Type of Object to Track Camera Functionality

Pedestrians Stationary,
Moving

vision.PeopleDetectorSystem
object

Custom object category Stationary,
Moving

trainCascadeObjectDetector

function
or
custom sliding window detector
using extractHOGFeatures and
selectStrongestBbox

Prediction

To track an object over time means that you must predict its location in the next frame.
The simplest method of prediction is to assume that the object will be near its last
known location. In other words, the previous detection serves as the next prediction.
This method is especially effective for high frame rates. However, using this prediction
method can fail when objects move at varying speeds, or when the frame rate is low
relative to the speed of the object in motion.

A more sophisticated method of prediction is to use the previously observed motion of
the object. The Kalman filter (vision.KalmanFilter) predicts the next location of an
object, assuming that it moves according to a motion model, such as constant velocity
or constant acceleration. The Kalman filter also takes into account process noise and
measurement noise. Process noise is the deviation of the actual motion of the object from
the motion model. Measurement noise is the detection error.

To make configuring a Kalman filter easier, use configureKalmanFilter. This
function sets up the filter for tracking a physical object moving with constant velocity or
constant acceleration within a Cartesian coordinate system. The statistics are the same
along all dimensions. If you need to configure a Kalman filter with different assumptions,
you need to construct the vision.KalmanFilter object directly.

Data Association

Data association is the process of associating detections corresponding to the same
physical object across frames. The temporal history of a particular object consists of
multiple detections, and is called a track. A track representation can include the entire
history of the previous locations of the object. Alternatively, it can consist only of the
object's last known location and its current velocity.
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Detection to Track Cost Functions

To match a detection to a track, you must establish criteria for evaluating the matches.
Typically, you establish this criteria by defining a cost function. The higher the cost of
matching a detection to a track, the less likely that the detection belongs to the track. A
simple cost function can be defined as the degree of overlap between the bounding boxes
of the predicted and detected objects. The “Tracking Pedestrians from a Moving Car”
example implements this cost function using the bboxOverlapRatio function. You can
implement a more sophisticated cost function, one that accounts for the uncertainty of
the prediction, using the distance method of the vision.KalmanFilter object. You
can also implement a custom cost function than can incorporate information about the
object size and appearance.

Elimination of Unlikely Matches

Gating is a method of eliminating highly unlikely matches from consideration, such as by
imposing a threshold on the cost function. An observation cannot be matched to a track
if the cost exceeds a certain threshold value. Using this threshold method effectively
results in a circular gating region around each prediction, where a matching detection
can be found. An alternative gating technique is to make the gating region large enough
to include the k-nearest neighbors of the prediction.

Assign Detections to Track

Data association reduces to a minimum weight bipartite matching problem, which is a
well-studied area of graph theory. A bipartite graph represents tracks and detections as
vertices. It also represents the cost of matching a detection and a track as a weighted
edge between the corresponding vertices.

The assignDetectionsToTracks function implements the Munkres' variant of the
Hungarian bipartite matching algorithm. Its input is the cost matrix, where the rows
correspond to tracks and the columns correspond to detections. Each entry contains the
cost of assigning a particular detection to a particular track. You can implement gating
by setting the cost of impossible matches to infinity.

Track Management

Data association must take into account the fact that new objects can appear in the field
of view, or that an object being tracked can leave the field of view. In other words, in any
given frame, some number of new tracks might need to be created, and some number of
existing tracks might need to be discarded. The assignDetectionsToTracks function
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returns the indices of unassigned tracks and unassigned detections in addition to the
matched pairs.

One way of handling unmatched detections is to create a new track from each of them.
Alternatively, you can create new tracks from unmatched detections greater than a
certain size, or from detections that have certain locations or appearance. For example,
if the scene has a single entry point, such as a doorway, then you can specify that only
unmatched detections located near the entry point can begin new tracks, and that all
other detections are considered noise.

Another way of handling unmatched tracks is to delete any track that remain unmatched
for a certain number of frames. Alternatively, you can specify to delete an unmatched
track when its last known location is near an exit point.

See Also
vision.KalmanFilter | vision.ForegroundDetector |
vision.PeopleDetector | vision.CascadeObjectDetector |
assignDetectionsToTracks | bboxOverlapRatio | configureKalmanFilter
| extractHOGFeaturesvision.PointTracker | selectStrongestBbox |
trainCascadeObjectDetector

Related Examples
• “Motion-Based Multiple Object Tracking”
• “Tracking Pedestrians from a Moving Car”
• “Using Kalman Filter for Object Tracking”

More About
• “Train a Cascade Object Detector”

External Web Sites
• Detect and Track Multiple Faces

http://www.mathworks.com/matlabcentral/fileexchange/47105-detect-and-track-multiple-faces
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Video Mosaicking
This example shows how to create a mosaic from a video sequence. Video mosaicking is
the process of stitching video frames together to form a comprehensive view of the scene.
The resulting mosaic image is a compact representation of the video data. The Video
Mosaicking block is often used in video compression and surveillance applications.

This example illustrates how to use the Corner Detection block, the Estimate Geometric
Transformation block, the Projective Transform block, and the Compositing block to
create a mosaic image from a video sequence.

Example Model

The following figure shows the Video Mosaicking model:

The Input subsystem loads a video sequence from either a file, or generates a synthetic
video sequence. The choice is user defined. First, the Corner Detection block finds points
that are matched between successive frames by the Corner Matching subsystem. Then
the Estimate Geometric Transformation block computes an accurate estimate of the
transformation matrix. This block uses the RANSAC algorithm to eliminate outlier
input points, reducing error along the seams of the output mosaic image. Finally,
the Mosaicking subsystem overlays the current video frame onto the output image to
generate a mosaic.

Input Subsystem

The Input subsystem can be configured to load a video sequence from a file, or to
generate a synthetic video sequence.
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If you choose to use a video sequence from a file, you can reduce computation time by
processing only some of the video frames. This is done by setting the downsampling rate
in the Frame Rate Downsampling subsystem.

If you choose a synthetic video sequence, you can set the speed of translation and
rotation, output image size and origin, and the level of noise. The output of the synthetic
video sequence generator mimics the images captured by a perspective camera with
arbitrary motion over a planar surface.

Corner Matching Subsystem

The subsystem finds corner features in the current video frame in one of three methods.
The example uses Local intensity comparison (Rosen & Drummond), which is the
fastest method. The other methods available are the Harris corner detection (Harris &
Stephens) and the Minimum Eigenvalue (Shi & Tomasi).
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The Corner Matching Subsystem finds the number of corners, location, and their metric
values. The subsystem then calculates the distances between all features in the current
frame with those in the previous frame. By searching for the minimum distances, the
subsystem finds the best matching features.

Mosaicking Subsystem

By accumulating transformation matrices between consecutive video frames, the
subsystem calculates the transformation matrix between the current and the first video
frame. The subsystem then overlays the current video frame on to the output image. By
repeating this process, the subsystem generates a mosaic image.
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The subsystem is reset when the video sequence rewinds or when the Estimate
Geometric Transformation block does not find enough inliers.

Video Mosaicking Using Synthetic Video

The Corners window shows the corner locations in the current video frame.

The Mosaic window shows the resulting mosaic image.



6 Motion Estimation and Tracking

6-10

Video Mosaicking Using Captured Video

The Corners window shows the corner locations in the current video frame.
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The Mosaic window shows the resulting mosaic image.



6 Motion Estimation and Tracking

6-12



 Pattern Matching

6-13

Pattern Matching
This example shows how to use the 2-D normalized cross-correlation for pattern
matching and target tracking. The example uses predefined or user specified target and
number of similar targets to be tracked. The normalized cross correlation plot shows that
when the value exceeds the set threshold, the target is identified.

Introduction

In this example you use normalized cross correlation to track a target pattern in a video.
The pattern matching algorithm involves the following steps:

• The input video frame and the template are reduced in size to minimize the amount of
computation required by the matching algorithm.

• Normalized cross correlation, in the frequency domain, is used to find a template in
the video frame.

• The location of the pattern is determined by finding the maximum cross correlation
value.

Initialization

Initialize required variables such as the threshold value for the cross correlation and the
decomposition level for Gaussian Pyramid decomposition.

threshold = single(0.99);

level = 2;

Create System object™ to read a video file.

hVideoSrc = vision.VideoFileReader('vipboard.avi', ...

                                   'VideoOutputDataType', 'single',...

                                   'ImageColorSpace', 'Intensity');

Create three gaussian pyramid System objects for decomposing the target template and
decomposing the Image under Test(IUT). The decomposition is done so that the cross
correlation can be computed over a small region instead of the entire original size of the
image.

hGaussPymd1 = vision.Pyramid('PyramidLevel',level);

hGaussPymd2 = vision.Pyramid('PyramidLevel',level);

hGaussPymd3 = vision.Pyramid('PyramidLevel',level);

Create a System object to rotate the image by angle of pi before computing multiplication
with the target in the frequency domain which is equivalent to correlation.
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hRotate1 = vision.GeometricRotator('Angle', pi);

Create two 2-D FFT System objects one for the image under test and the other for the
target.

hFFT2D1 = vision.FFT;

hFFT2D2 = vision.FFT;

Create a System object to perform 2-D inverse FFT after performing correlation
(equivalent to multiplication) in the frequency domain.

hIFFFT2D = vision.IFFT;

Create 2-D convolution System object to average the image energy in tiles of the same
dimension of the target.

hConv2D = vision.Convolver('OutputSize','Valid');

Here you implement the following sequence of operations.

% Specify the target image and number of similar targets to be tracked. By

% default, the example uses a predefined target and finds up to 2 similar

% patterns. Set the variable useDefaultTarget to false to specify a new

% target and the number of similar targets to match.

useDefaultTarget = true;

[Img, numberOfTargets, target_image] = ...

  videopattern_gettemplate(useDefaultTarget);

% Downsample the target image by a predefined factor using the

% gaussian pyramid System object. You do this to reduce the amount of

% computation for cross correlation.

target_image = single(target_image);

target_dim_nopyramid = size(target_image);

target_image_gp = step(hGaussPymd1, target_image);

target_energy = sqrt(sum(target_image_gp(:).^2));

% Rotate the target image by 180 degrees, and perform zero padding so that

% the dimensions of both the target and the input image are the same.

target_image_rot = step(hRotate1, target_image_gp);

[rt, ct] = size(target_image_rot);

Img = single(Img);

Img = step(hGaussPymd2, Img);

[ri, ci]= size(Img);

r_mod = 2^nextpow2(rt + ri);

c_mod = 2^nextpow2(ct + ci);

target_image_p = [target_image_rot zeros(rt, c_mod-ct)];
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target_image_p = [target_image_p; zeros(r_mod-rt, c_mod)];

% Compute the 2-D FFT of the target image

target_fft = step(hFFT2D1, target_image_p);

% Initialize constant variables used in the processing loop.

target_size = repmat(target_dim_nopyramid, [numberOfTargets, 1]);

gain = 2^(level);

Im_p = zeros(r_mod, c_mod, 'single'); % Used for zero padding

C_ones = ones(rt, ct, 'single');      % Used to calculate mean using conv

Create a System object to calculate the local maximum value for the normalized cross
correlation.

hFindMax = vision.LocalMaximaFinder( ...

            'Threshold', single(-1), ...

            'MaximumNumLocalMaxima', numberOfTargets, ...

            'NeighborhoodSize', floor(size(target_image_gp)/2)*2 - 1);

Create a System object to display the tracking of the pattern.

sz = get(0,'ScreenSize');

pos = [20 sz(4)-400 400 300];

hROIPattern = vision.VideoPlayer('Name', 'Overlay the ROI on the target', ...

    'Position', pos);

Initialize figure window for plotting the normalized cross correlation value

hPlot = videopatternplots('setup',numberOfTargets, threshold);

Video Processing Loop

Create a processing loop to perform pattern matching on the input video. This loop uses
the System objects you instantiated above. The loop is stopped when you reach the end of
the input file, which is detected by the VideoFileReader System object.

while ~isDone(hVideoSrc)

    Im = step(hVideoSrc);

    Im_gp = step(hGaussPymd3, Im);

    % Frequency domain convolution.

    Im_p(1:ri, 1:ci) = Im_gp;    % Zero-pad

    img_fft = step(hFFT2D2, Im_p);

    corr_freq = img_fft .* target_fft;

    corrOutput_f = step(hIFFFT2D, corr_freq);

    corrOutput_f = corrOutput_f(rt:ri, ct:ci);
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    % Calculate image energies and block run tiles that are size of

    % target template.

    IUT_energy = (Im_gp).^2;

    IUT = step(hConv2D, IUT_energy, C_ones);

    IUT = sqrt(IUT);

    % Calculate normalized cross correlation.

    norm_Corr_f = (corrOutput_f) ./ (IUT * target_energy);

    xyLocation = step(hFindMax, norm_Corr_f);

    % Calculate linear indices.

    linear_index = sub2ind([ri-rt, ci-ct]+1, xyLocation(:,2),...

        xyLocation(:,1));

    norm_Corr_f_linear = norm_Corr_f(:);

    norm_Corr_value = norm_Corr_f_linear(linear_index);

    detect = (norm_Corr_value > threshold);

    target_roi = zeros(length(detect), 4);

    ul_corner = (gain.*(xyLocation(detect, :)-1))+1;

    target_roi(detect, :) = [ul_corner, fliplr(target_size(detect, :))];

    % Draw bounding box.

    Imf = insertShape(Im, 'Rectangle', target_roi, 'Color', 'green');

    % Plot normalized cross correlation.

    videopatternplots('update',hPlot,norm_Corr_value);

    step(hROIPattern, Imf);

end

release(hVideoSrc);
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Summary

This example shows use of Computer Vision System Toolbox™ to find a user defined
pattern in a video and track it. The algorithm is based on normalized frequency domain
cross correlation between the target and the image under test. The video player window
displays the input video with the identified target locations. Also a figure displays the
normalized correlation between the target and the image which is used as a metric to
match the target. As can be seen whenever the correlation value exceeds the threshold
(indicated by the blue line), the target is identified in the input video and the location is
marked by the green bounding box.

Appendix

The following helper functions are used in this example.

• videopattern_gettemplate.m
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• videopatternplots.m
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Pattern Matching

This example shows how to use the 2-D normalized cross-correlation for pattern
matching and target tracking.

Double-click the Edit Parameters block to select the number of similar targets to detect.
You can also change the pyramiding factor. By increasing it, you can match the target
template to each video frame more quickly. Changing the pyramiding factor might
require you to change the Threshold value.

Additionally, you can double-click the Correlation Method switch to specify the domain in
which to perform the cross-correlation. The relative size of the target to the input video
frame and the pyramiding factor determine which domain computation is faster.

Example Model

The following figure shows the Pattern Matching model:
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Pattern Matching Results

The Match metric window shows the variation of the target match metrics. The model
determines that the target template is present in a video frame when the match metric
exceeds a threshold (cyan line).



6 Motion Estimation and Tracking

6-22

The Cross-correlation window shows the result of cross-correlating the target template
with a video frame. Large values in this window correspond to the locations of the targets
in the input image.

The Overlay window shows the locations of the targets by highlighting them with
rectangular regions of interest (ROIs). These ROIs are present only when the targets are
detected in the video frame.
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Track an Object Using Correlation

You can open the example model by typing

ex_vision_track_object

on the MATLAB command line.

In this example, you use the 2-D Correlation, 2-D Maximum, and Draw Shapes blocks to
find and indicate the location of a sculpture in each video frame:

1 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Read Binary File Computer Vision System Toolbox >

Sources
1

Image Data Type
Conversion

Computer Vision System Toolbox >
Conversions

1

Image From File Computer Vision System Toolbox >
Sources

1

2-D Correlation Computer Vision System Toolbox >
Statistics

1

2-D Maximum Computer Vision System Toolbox >
Statistics

1

Draw Shapes Computer Vision System Toolbox >
Text & Graphics

1

Video Viewer Computer Vision System Toolbox >
Sinks

1

Data Type Conversion Simulink > Signal Attributes 1
Constant Simulink > Sources 1
Mux Simulink > Signal Routing 1

2 Use the Read Binary File block to import a binary file into the model. Set the block
parameters as follows:

• File name = cat_video.bin
• Four character code = GREY
• Number of times to play file = inf
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• Sample time = 1/30
3 Use the Image Data Type Conversion block to convert the data type of the video to

single-precision floating point. Accept the default parameter.
4 Use the Image From File block to import the image of the cat sculpture, which is the

object you want to track. Set the block parameters as follows:

• Main pane, File name = cat_target.png
• Data Types pane, Output data type = single

5 Use the 2-D Correlation block to determine the portion of each video frame that best
matches the image of the cat sculpture. Set the block parameters as follows:

• Output size = Valid
• Select the Normalized output check box.

Because you chose Valid for the Output size parameter, the block outputs only
those parts of the correlation that are computed without the zero-padded edges of
any input.

6 Use the 2-D Maximum block to find the index of the maximum value in each input
matrix. Set the Mode parameter to Index. This block outputs the zero-based
location of the maximum value as a two-element vector of 32-bit unsigned integers at
the Idx port.

7 Use the Data Type Conversion block to change the index values from 32-bit unsigned
integers to single-precision floating-point values. Set the Output data type
parameter to single.

8 Use the Constant block to define the size of the image of the cat sculpture. Set the
Constant value parameter to single([41 41]).

9 Use the Mux block to concatenate the location of the maximum value and the size
of the image of the cat sculpture into a single vector. You use this vector to define a
rectangular region of interest (ROI) that you pass to the Draw Shapes block.

10 Use the Draw Shapes block to draw a rectangle around the portion of each
video frame that best matches the image of the cat sculpture. Accept the default
parameters.

11 Use the Video Viewer block to display the video stream with the ROI displayed on
it. Accept the default parameters. This block automatically displays the video in the
Video Viewer window when you run the model. Because the image is represented by
single-precision floating-point values, a value of 0 corresponds to black and a value of
1 corresponds to white.
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12 Connect the blocks as shown in the following figure.

13 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = inf
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

14 Run the simulation.

The video is displayed in the Video Viewer window and a rectangular box appears
around the cat sculpture. To view the video at its true size, right-click the window
and select Set Display To True Size.
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As the video plays, you can watch the rectangular ROI follow the sculpture as it
moves.

In this example, you used the 2-D Correlation, 2-D Maximum, and Draw Shapes blocks
to track the motion of an object in a video stream. For more information about these
blocks, see the 2-D Correlation, 2-D Maximum, and Draw Shapes block reference pages.

Note This example model does not provide an indication of whether or not the sculpture
is present in each video frame. For an example of this type of model, type vippattern at
the MATLAB command prompt.
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Panorama Creation

This example shows how to create a panorama from a video sequence. The model
calculates the motion vector between two adjacent video frames and uses it to find the
portion of each frame that best matches the previous frame. Then it selects the matching
portion and concatenates it with the previous frame. By repeating this process, it builds a
panoramic image out of the video sequence.

Example Model

The following figure shows the Panorama Creation model:

Motion Estimation Subsystem

This model computes the Sum of Absolute Differences (SAD) using Template Matching
block to estimate the motion between consecutive video frames. Then it computes the
motion vector of a particular block in the current frame with respect to the previous
frame. The model uses this motion vector to align consecutive frames of the video to form
a panoramic picture.
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Panorama Creation Results

The model takes the video sequence in the Input window and creates a panorama, which
it displays in the Panorama window. Note that this method of panoramic picture creation
assumes there is no zooming or rotational variation in the video.
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Available Example Versions

Windows® only: vippanorama_win.slx

Platform independent: vippanorama_all.slx

Some compressed multimedia files are only supported on Windows platforms. The
examples that use these types of files can only be run on Windows.
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Geometric Transformations

• “Rotate an Image” on page 7-2
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• “Crop an Image” on page 7-12
• “Nearest Neighbor, Bilinear, and Bicubic Interpolation Methods” on page 7-16
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Rotate an Image

You can use the Rotate block to rotate your image or video stream by a specified angle. In
this example, you learn how to use the Rotate block to continuously rotate an image.

Note: Running this example requires a DSP System Toolbox license.

ex_vision_rotate_image

1 Define an RGB image in the MATLAB workspace. At the MATLAB command
prompt, type

I = checker_board;

I is a 100-by-100-by-3 array of double-precision values. Each plane of the array
represents the red, green, or blue color values of the image.

2 To view the image this matrix represents, at the MATLAB command prompt, type

imshow(I)

3 Create a new Simulink model, and add to it the blocks shown in the following table.
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Block Library Quantity
Image From Workspace Computer Vision System Toolbox >

Sources
1

Rotate Computer Vision System Toolbox >
Geometric Transformations

1

Video Viewer Computer Vision System Toolbox >
Sinks

2

Gain Simulink > Math Operations 1
Display DSP System Toolbox > Sinks 1
Counter DSP System Toolbox > Signal

Management > Switches and Counters
1

4 Use the Image From Workspace block to import the RGB image from the MATLAB
workspace. On the Main pane, set the Value parameter to I. Each plane of the array
represents the red, green, or blue color values of the image.

5 Use the Video Viewer block to display the original image. Accept the default
parameters.

The Video Viewer block automatically displays the original image in the Video
Viewer window when you run the model. Because the image is represented by
double-precision floating-point values, a value of 0 corresponds to black and a value
of 1 corresponds to white.

6 Use the Rotate block to rotate the image. Set the block parameters as follows:

• Rotation angle source = Input port
• Sine value computation method = Trigonometric function

The Angle port appears on the block. You use this port to input a steadily increasing
angle. Setting the Output size parameter to Expanded to fit rotated input
image ensures that the block does not crop the output.

7 Use the Video Viewer1 block to display the rotating image. Accept the default
parameters.

8 Use the Counter block to create a steadily increasing angle. Set the block parameters
as follows:

• Count event = Free running
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• Counter size = 16 bits
• Output = Count
• Clear the Reset input check box.
• Sample time = 1/30

The Counter block counts upward until it reaches the maximum value that can be
represented by 16 bits. Then, it starts again at zero. You can view its output value on
the Display block while the simulation is running. The Counter block's Count data
type parameter enables you to specify it's output data type.

9 Use the Gain block to convert the output of the Counter block from degrees to
radians. Set the Gain parameter to pi/180.

10 Connect the blocks as shown in the following figure.
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11 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = inf
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

12 Run the model.

The original image appears in the Video Viewer window.
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The rotating image appears in the Video Viewer1 window.
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In this example, you used the Rotate block to continuously rotate your image. For more
information about this block, see the Rotate block reference page in the Computer Vision
System Toolbox Reference. For more information about other geometric transformation
blocks, see the Resize and Shear block reference pages.

Note If you are on a Windows operating system, you can replace the Video Viewer block
with the To Video Display block, which supports code generation.
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Resize an Image

You can use the Resize block to change the size of your image or video stream. In this
example, you learn how to use the Resize block to reduce the size of an image:

ex_vision_resize_image

1 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From File Computer Vision System Toolbox >

Sources
1

Resize Computer Vision System Toolbox >
Geometric Transformations

1

Video Viewer Computer Vision System Toolbox >
Sinks

2

2 Use the Image From File block to import the intensity image. Set the File name
parameter to moon.tif. The tif file is a 537-by-358 matrix of 8-bit unsigned integer
values.

3 Use the Video Viewer block to display the original image. Accept the default
parameters. This block automatically displays the original image in the Video
Viewer window when you run the model.

4 Use the Resize block to shrink the image. Set the Resize factor in % parameter to
50. This shrinks the image to half its original size.

5 Use the Video Viewer1 block to display the modified image. Accept the default
parameters.

6 Connect the blocks as shown in the following figure.
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7 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

8 Run the model.



7 Geometric Transformations

7-10

The original image appears in the Video Viewer window.

The reduced image appears in the Video Viewer1 window.
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In this example, you used the Resize block to shrink an image. For more information
about this block, see the Resize block reference page. For more information about other
geometric transformation blocks, see the Rotate, Apply Geometric Transformation,
Estimate Geometric Transformation, and Translate block reference pages.
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Crop an Image

You can use the Selector block to crop your image or video stream. In this example,
you learn how to use the Selector block to trim an image down to a particular region of
interest:

ex_vision_crop_image

1 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From File Computer Vision System Toolbox >

Sources
1

Video Viewer Computer Vision System Toolbox >
Sinks

2

Selector Simulink > Signal Routing 1

2 Use the Image From File block to import the intensity image. Set the File name
parameter to coins.png. The image is a 246-by-300 matrix of 8-bit unsigned integer
values.

3 Use the Video Viewer block to display the original image. Accept the default
parameters. This block automatically displays the original image in the Video
Viewer window when you run the model.

4 Use the Selector block to crop the image. Set the block parameters as follows:

• Number of input dimensions = 2
• 1

• Index Option = Starting index (dialog)
• Index = 140
• Output Size = 70

• 2

• Index Option = Starting index (dialog)
• Index = 200
• Output Size = 70
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The Selector block starts at row 140 and column 200 of the image and outputs the
next 70 rows and columns of the image.

5 Use the Video Viewer1 block to display the cropped image. This block automatically
displays the modified image in the Video Viewer window when you run the model.

6 Connect the blocks as shown in the following figure.

7 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:
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• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

8 Run the model.

The original image appears in the Video Viewer window.

The cropped image appears in the Video Viewer1 window. The following image is
shown at its true size.



 Crop an Image

7-15

In this example, you used the Selector block to crop an image. For more information
about the Selector block, see the Simulink documentation. For information about the
imcrop function, see the Image Processing Toolbox documentation.
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Nearest Neighbor, Bilinear, and Bicubic Interpolation Methods

In this section...

“Nearest Neighbor Interpolation” on page 7-16
“Bilinear Interpolation” on page 7-17
“Bicubic Interpolation” on page 7-18

Nearest Neighbor Interpolation

For nearest neighbor interpolation, the block uses the value of nearby translated pixel
values for the output pixel values.

For example, suppose this matrix,

1 2 3

4 5 6

7 8 9

represents your input image. You want to translate this image 1.7 pixels in the positive
horizontal direction using nearest neighbor interpolation. The Translate block's nearest
neighbor interpolation algorithm is illustrated by the following steps:

1 Zero pad the input matrix and translate it by 1.7 pixels to the right.

1 2 3 0 0

4 5 6 0 0

7 8 9 0 0

1.7 pixels

Original zero-padded matrix

Translated zero-padded matrix

0 0 1 2 3 0

0 0 4 5 6 0

0 0 7 8 9 0

2 Create the output matrix by replacing each input pixel value with the translated
value nearest to it. The result is the following matrix:
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0 0 1 2 3

0 0 4 5 6

0 0 7 8 9

Note: You wanted to translate the image by 1.7 pixels, but this method translated the
image by 2 pixels. Nearest neighbor interpolation is computationally efficient but not as
accurate as bilinear or bicubic interpolation.

Bilinear Interpolation

For bilinear interpolation, the block uses the weighted average of two translated pixel
values for each output pixel value.

For example, suppose this matrix,

1 2 3

4 5 6

7 8 9

represents your input image. You want to translate this image 0.5 pixel in the positive
horizontal direction using bilinear interpolation. The Translate block's bilinear
interpolation algorithm is illustrated by the following steps:

1 Zero pad the input matrix and translate it by 0.5 pixel to the right.

0 1 1 2 2 3 3 0 0

0 4 4 5 5 6 6 0 0

0 7 7 8 8 9 9 0 0

0.5 pixelOriginal zero-padded matrix

Translated zero-padded matrix
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2 Create the output matrix by replacing each input pixel value with the weighted
average of the translated values on either side. The result is the following matrix
where the output matrix has one more column than the input matrix:

0 5 1 5 2 5 1 5

2 4 5 5 5 3

3 5 7 5 8 5 4 5

. . . .

. .

. . . .

Bicubic Interpolation

For bicubic interpolation, the block uses the weighted average of four translated pixel
values for each output pixel value.

For example, suppose this matrix,

1 2 3

4 5 6

7 8 9

represents your input image. You want to translate this image 0.5 pixel in the
positive horizontal direction using bicubic interpolation. The Translate block's bicubic
interpolation algorithm is illustrated by the following steps:

1 Zero pad the input matrix and translate it by 0.5 pixel to the right.

0 0 0 1 1 2 2 3 3 0 0 0 0

0 0 0 4 4 5 5 6 6 0 0 0 0

0 0 0 7 7 8 8 9 9 0 0 0 0

0.5 pixel
Original zero-padded matrix

Translated zero-padded matrix

2 Create the output matrix by replacing each input pixel value with the weighted
average of the two translated values on either side. The result is the following matrix
where the output matrix has one more column than the input matrix:
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0 375 1 5 3 1 625

1 875 4 875 6 375 3 125

3 375 8 25 9 75 4 625

. . .

. . . .

. . . .
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• “Adjust the Contrast of Intensity Images” on page 8-2
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• “Sharpen an Image” on page 8-16
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Adjust the Contrast of Intensity Images

This example shows you how to modify the contrast in two intensity images using the
Contrast Adjustment and Histogram Equalization blocks.

ex_vision_adjust_contrast_intensity

1 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From File Computer Vision System Toolbox > Sources 2
Contrast Adjustment Computer Vision System Toolbox > Analysis &

Enhancement
1

Histogram
Equalization

Computer Vision System Toolbox > Analysis &
Enhancement

1

Video Viewer Computer Vision System Toolbox > Sinks 4

2 Place the blocks listed in the table above into your new model.
3 Use the Image From File block to import the first image into the Simulink model.

Set the File name parameter to pout.tif.
4 Use the Image From File1 block to import the second image into the Simulink model.

Set the File name parameter to tire.tif.
5 Use the Contrast Adjustment block to modify the contrast in pout.tif. Set the

Adjust pixel values from parameter to Range determined by saturating
outlier pixels. This block adjusts the contrast of the image by linearly scaling
the pixel values between user-specified upper and lower limits.

6 Use the Histogram Equalization block to modify the contrast in tire.tif.
Accept the default parameters. This block enhances the contrast of images by
transforming the values in an intensity image so that the histogram of the output
image approximately matches a specified histogram.

7 Use the Video Viewer blocks to view the original and modified images. Accept the
default parameters.

8 Connect the blocks as shown in the following figure.
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9 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

10 Run the model.

The results appear in the Video Viewer windows.
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In this example, you used the Contrast Adjustment block to linearly scale the pixel
values in pout.tif between new upper and lower limits. You used the Histogram
Equalization block to transform the values in tire.tif so that the histogram of the
output image approximately matches a uniform histogram. For more information, see the
Contrast Adjustment and Histogram Equalization reference pages.
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Adjust the Contrast of Color Images

This example shows you how to modify the contrast in color images using the Histogram
Equalization block.

ex_vision_adjust_contrast_color.mdl

1 Use the following code to read in an indexed RGB image, shadow.tif, and convert
it to an RGB image. The model provided above already includes this code in file
> Model Properties > Model Properties > InitFcn, and executes it prior to
simulation.

[X map] = imread('shadow.tif');

shadow = ind2rgb(X,map);

2 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From
Workspace

Computer Vision System Toolbox > Sources 1

Color Space
Conversion

Computer Vision System Toolbox >
Conversions

2

Histogram
Equalization

Computer Vision System Toolbox > Analysis &
Enhancement

1

Video Viewer Computer Vision System Toolbox > Sinks 2
Constant Simulink > Sources 1
Divide Simulink > Math Operations 1
Product Simulink > Math Operations 1

3 Place the blocks listed in the table above into your new model.
4 Use the Image From Workspace block to import the RGB image from the MATLAB

workspace into the Simulink model. Set the block parameters as follows:

• Value = shadow
• Image signal = Separate color signals

5 Use the Color Space Conversion block to separate the luma information from the
color information. Set the block parameters as follows:

• Conversion = sR'G'B' to L*a*b*
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• Image signal = Separate color signals

Because the range of the L* values is between 0 and 100, you must normalize them
to be between zero and one before you pass them to the Histogram Equalization
block, which expects floating point input in this range.

6 Use the Constant block to define a normalization factor. Set the Constant value
parameter to 100.

7 Use the Divide block to normalize the L* values to be between 0 and 1. Accept the
default parameters.

8 Use the Histogram Equalization block to modify the contrast in the image. This
block enhances the contrast of images by transforming the luma values in the color
image so that the histogram of the output image approximately matches a specified
histogram. Accept the default parameters.

9 Use the Product block to scale the values back to be between the 0 to 100 range.
Accept the default parameters.

10 Use the Color Space Conversion1 block to convert the values back to the sR'G'B' color
space. Set the block parameters as follows:

• Conversion = L*a*b* to sR'G'B'
• Image signal = Separate color signals

11 Use the Video Viewer blocks to view the original and modified images. For each
block, set the Image signal parameter to Separate color signals from the file
menu.

12 Connect the blocks as shown in the following figure.
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13 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

14 Run the model.

As shown in the following figure, the model displays the original image in the Video
Viewer1 window.
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As the next figure shows, the model displays the enhanced contrast image in the
Video Viewer window.
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In this example, you used the Histogram Equalization block to transform the values in a
color image so that the histogram of the output image approximately matches a uniform
histogram. For more information, see the Histogram Equalization reference page.
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Remove Salt and Pepper Noise from Images

Median filtering is a common image enhancement technique for removing salt and
pepper noise. Because this filtering is less sensitive than linear techniques to extreme
changes in pixel values, it can remove salt and pepper noise without significantly
reducing the sharpness of an image. In this topic, you use the Median Filter block to
remove salt and pepper noise from an intensity image:

ex_vision_remove_noise

1 Define an intensity image in the MATLAB workspace and add noise to it by typing
the following at the MATLAB command prompt:

I= double(imread('circles.png'));

I= imnoise(I,'salt & pepper',0.02);

Iis a 256-by-256 matrix of 8-bit unsigned integer values.

The model provided with this example already includes this code in file>Model
Properties>Model Properties>InitFcn, and executes it prior to simulation.

2 To view the image this matrix represents, at the MATLAB command prompt, type

imshow(I)
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The intensity image contains noise that you want your model to eliminate.
3 Create a Simulink model, and add the blocks shown in the following table.

Block Library Quantity
Image From
Workspace

Computer Vision System Toolbox > Sources 1

Median Filter Computer Vision System Toolbox > Filtering 1
Video Viewer Computer Vision System Toolbox > Sinks 2

4 Use the Image From Workspace block to import the noisy image into your model. Set
the Value parameter to I.

5 Use the Median Filter block to eliminate the black and white speckles in the image.
Use the default parameters.
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The Median Filter block replaces the central value of the 3-by-3 neighborhood with
the median value of the neighborhood. This process removes the noise in the image.

6 Use the Video Viewer blocks to display the original noisy image, and the modified
image. Images are represented by 8-bit unsigned integers. Therefore, a value of 0
corresponds to black and a value of 255 corresponds to white. Accept the default
parameters.

7 Connect the blocks as shown in the following figure.

8 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = 0
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• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

9 Run the model.

The original noisy image appears in the Video Viewer window. To view the image at
its true size, right-click the window and select Set Display To True Size.

The cleaner image appears in the Video Viewer1 window. The following image is
shown at its true size.
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You have used the Median Filter block to remove noise from your image. For more
information about this block, see the Median Filter block reference page in the Computer
Vision System Toolbox Reference.
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Sharpen an Image

To sharpen a color image, you need to make the luma intensity transitions more acute,
while preserving the color information of the image. To do this, you convert an R'G'B'
image into the Y'CbCr color space and apply a highpass filter to the luma portion of the
image only. Then, you transform the image back to the R'G'B' color space to view the
results. To blur an image, you apply a lowpass filter to the luma portion of the image.
This example shows how to use the 2-D FIR Filter block to sharpen an image. The prime
notation indicates that the signals are gamma corrected.

ex_vision_sharpen_image

1 Define an R'G'B' image in the MATLAB workspace. To read in an R'G'B' image from
a PNG file and cast it to the double-precision data type, at the MATLAB command
prompt, type

I= im2double(imread('peppers.png')); 

I is a 384-by-512-by-3 array of double-precision floating-point values. Each plane of
this array represents the red, green, or blue color values of the image.

The model provided with this example already includes this code in file>Model
Properties>Model Properties>InitFcn, and executes it prior to simulation.

2 To view the image this array represents, type this command at the MATLAB
command prompt:

imshow(I)
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Now that you have defined your image, you can create your model.
3 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From
Workspace

Computer Vision System Toolbox > Sources 1
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Block Library Quantity
Color Space
Conversion

Computer Vision System Toolbox >
Conversions

2

2-D FIR Filter Computer Vision System Toolbox > Filtering 1
Video Viewer Computer Vision System Toolbox > Sinks 1

4 Use the Image From Workspace block to import the R'G'B' image from the MATLAB
workspace. Set the parameters as follows:

• Main pane, Value = I
• Main pane, Image signal = Separate color signals

The block outputs the R', G', and B' planes of the I array at the output ports.
5 The first Color Space Conversion block converts color information from the R'G'B'

color space to the Y'CbCr color space. Set the Image signal parameter to Separate
color signals

6 Use the 2-D FIR Filter block to filter the luma portion of the image. Set the block
parameters as follows:

• Coefficients = fspecial('unsharp')
• Output size = Same as input port I
• Padding options = Symmetric
• Filtering based on = Correlation

The fspecial('unsharp') command creates two-dimensional highpass filter
coefficients suitable for correlation. This highpass filter sharpens the image by
removing the low frequency noise in it.

7 The second Color Space Conversion block converts the color information from the
Y'CbCr color space to the R'G'B' color space. Set the block parameters as follows:

• Conversion = Y'CbCr to R'G'B'
• Image signal = Separate color signals

8 Use the Video Viewer block to automatically display the new, sharper image in the
Video Viewer window when you run the model. Set the Image signal parameter to
Separate color signals, by selecting File > Image Signal.

9 Connect the blocks as shown in the following figure.
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10 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

11 Run the model.

A sharper version of the original image appears in the Video Viewer window.
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To blur the image, double-click the 2-D FIR Filter block. Set Coefficients
parameter to fspecial('gaussian',[15 15],7) and then click OK. The
fspecial('gaussian',[15 15],7) command creates two-dimensional Gaussian
lowpass filter coefficients. This lowpass filter blurs the image by removing the high
frequency noise in it.

In this example, you used the Color Space Conversion and 2-D FIR Filter blocks to
sharpen an image. For more information, see the Color Space Conversion and 2-D FIR
Filter, and fspecial reference pages.
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Find the Histogram of an Image

The Histogram block computes the frequency distribution of the elements in each input
image by sorting the elements into a specified number of discrete bins. You can use the
Histogram block to calculate the histogram of the R, G, and/or B values in an image. This
example shows you how to accomplish this task:

Note: Running this example requires a DSP System Toolbox license.

You can open the example model by typing

ex_vision_find_histogram

on the MATLAB command line.

1 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From File Computer Vision System Toolbox > Sources 1
Video Viewer Computer Vision System Toolbox > Sinks 1
Matrix Concatenate Simulink > Math Operations 1
Vector Scope DSP System Toolbox > Sinks 1
Histogram DSP System Toolbox > Statistics 3

2 Use the Image From File block to import an RGB image. Set the block parameters as
follows:

• Sample time = inf
• Image signal = Separate color signals
• Output port labels: = R|G|B
• On the Data Types tab, Output data type: = double

3 Use the Video Viewer block to automatically display the original image in the viewer
window when you run the model. Set the Image signal parameter to Separate
color signals from the File menu.

4 Use the Histogram blocks to calculate the histogram of the R, G, and B values in the
image. Set the Main tab block parameters for the three Histogram blocks as follows:
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• Lower limit of histogram: 0
• Upper limit of histogram: 1
• Number of bins: = 256
• Find the histogram over: = Entire Input

The R, G, and B input values to the Histogram block are double-precision floating
point and range between 0 and 1. The block creates 256 bins between the maximum
and minimum input values and counts the number of R, G, and B values in each bin.

5 Use the Matrix Concatenate block to concatenate the R, G, and B column vectors
into a single matrix so they can be displayed using the Vector Scope block. Set the
Number of inputs parameter to 3.

6 Use the Vector Scope block to display the histograms of the R, G, and B values of the
input image. Set the block parameters as follows:

• Scope Properties pane, Input domain = User-defined
• Display Properties pane, clear the Frame number check box
• Display Properties pane, select the Channel legend check box
• Display Properties pane, select the Compact display check box
• Axis Properties pane, clear the Inherit sample increment from input check

box.
• Axis Properties pane, Minimum Y-limit = 0
• Axis Properties pane, Maximum Y-limit = 1
• Axis Properties pane, Y-axis label = Count
• Line Properties pane, Line markers = .|s|d
• Line Properties pane, Line colors = [1 0 0]|[0 1 0]|[0 0 1]

7 Connect the blocks as shown in the following figure.
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8 Open the Configuration dialog box by selecting Model Configuration Parameters
from the Simulation menu. Set the parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = Discrete (no continuous states)

9 Run the model using either the simulation button, or by selecting Simulation >
Start.
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The original image appears in the Video Viewer window.

10 Right-click in the Vector Scope window and select Autoscale.

The scaled histogram of the image appears in the Vector Scope window.
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You have now used the 2-D Histogram block to calculate the histogram of the R, G,
and B values in an RGB image. To open a model that illustrates how to use this block
to calculate the histogram of the R, G, and B values in an RGB video stream, type
viphistogram at the MATLAB command prompt.



 Correct Nonuniform Illumination

9-7

Correct Nonuniform Illumination

Global threshold techniques, which are often the first step in object measurement, cannot
be applied to unevenly illuminated images. To correct this problem, you can change the
lighting conditions and take another picture, or you can use morphological operators to
even out the lighting in the image. Once you have corrected for nonuniform illumination,
you can pick a global threshold that delineates every object from the background. In this
topic, you use the Opening block to correct for uneven lighting in an intensity image:

You can open the example model by typing

ex_vision_correct_uniform

on the MATLAB command line.

1 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From File Computer Vision System Toolbox >

Sources
1

Opening Computer Vision System Toolbox >
Morphological Operations

1

Video Viewer Computer Vision System Toolbox > Sinks 4
Constant Simulink > Sources 1
Sum Simulink > Math Operations 2
Data Type Conversion Simulink > Signal Attributes 1

2 Use the Image From File block to import the intensity image. Set the File name
parameter to rice.png. This image is a 256-by-256 matrix of 8-bit unsigned integer
values.

3 Use the Video Viewer block to view the original image. Accept the default
parameters.

4 Use the Opening block to estimate the background of the image. Set the
Neighborhood or structuring element parameter to strel('disk',15).

The strel function creates a circular STREL object with a radius of 15 pixels. When
working with the Opening block, pick a STREL object that fits within the objects
you want to keep. It often takes experimentation to find the neighborhood or STREL
object that best suits your application.
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5 Use the Video Viewer1 block to view the background estimated by the Opening
block. Accept the default parameters.

6 Use the first Sum block to subtract the estimated background from the original
image. Set the block parameters as follows:

• Icon shape = rectangular
• List of signs = -+

7 Use the Video Viewer2 block to view the result of subtracting the background from
the original image. Accept the default parameters.

8 Use the Constant block to define an offset value. Set the Constant value parameter
to 80.

9 Use the Data Type Conversion block to convert the offset value to an 8-bit unsigned
integer. Set the Output data type mode parameter to uint8.

10 Use the second Sum block to lighten the image so that it has the same brightness as
the original image. Set the block parameters as follows:

• Icon shape = rectangular
• List of signs = ++

11 Use the Video Viewer3 block to view the corrected image. Accept the default
parameters.

12 Connect the blocks as shown in the following figure.
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13 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = discrete (no continuous states)

14 Run the model.

The original image appears in the Video Viewer window.
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The estimated background appears in the Video Viewer1 window.
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The image without the estimated background appears in the Video Viewer2 window.
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The preceding image is too dark. The Constant block provides an offset value that
you used to brighten the image.

The corrected image, which has even lighting, appears in the Video Viewer3 window.
The following image is shown at its true size.
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In this section, you have used the Opening block to remove irregular illumination from
an image. For more information about this block, see the Opening reference page. For
related information, see the Top-hat block reference page. For more information about
STREL objects, see the strel function in the Image Processing Toolbox documentation.
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Count Objects in an Image

In this example, you import an intensity image of a wheel from the MATLAB workspace
and convert it to binary. Then, using the Opening and Label blocks, you count the
number of spokes in the wheel. You can use similar techniques to count objects in other
intensity images. However, you might need to use additional morphological operators
and different structuring elements.

Note: Running this example requires a DSP System Toolbox license.

You can open the example model by typing

ex_vision_count_objects

on the MATLAB command line.

1 Create a new Simulink model, and add to it the blocks shown in the following table.

Block Library Quantity
Image From File Computer Vision System Toolbox >

Sources
1

Opening Computer Vision System Toolbox>
Morphological Operations

1

Label Computer Vision System Toolbox >
Morphological Operations

1

Video Viewer Computer Vision System Toolbox > Sinks 2
Constant Simulink > Sources 1
Relational Operator Simulink > Logic and Bit Operations 1
Display Simulink > Sinks 1

2 Use the Image From File block to import your image. Set the File name parameter
to testpat1.png. This is a 256-by-256 matrix image of 8-bit unsigned integers.

3 Use the Constant block to define a threshold value for the Relational Operator block.
Set the Constant value parameter to 200.

4 Use the Video Viewer block to view the original image. Accept the default
parameters.
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5 Use the Relational Operator block to perform a thresholding operation that converts
your intensity image to a binary image. Set the Relational Operator parameter to
<.

If the input to the Relational Operator block is less than 200, its output is 1;
otherwise, its output is 0. You must threshold your intensity image because the
Label block expects binary input. Also, the objects it counts must be white.

6 Use the Opening block to separate the spokes from the rim and from each other at
the center of the wheel. Use the default parameters.

The strel function creates a circular STREL object with a radius of 5 pixels. When
working with the Opening block, pick a STREL object that fits within the objects
you want to keep. It often takes experimentation to find the neighborhood or STREL
object that best suits your application.

7 Use the Video Viewer1 block to view the opened image. Accept the default
parameters.

8 Use the Label block to count the number of spokes in the input image. Set the
Output parameter to Number of labels.

9 The Display block displays the number of spokes in the input image. Use the default
parameters.

10 Connect the block as shown in the following figure.
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11 Set the configuration parameters. Open the Configuration dialog box by selecting
Model Configuration Parameters from the Simulation menu. Set the
parameters as follows:

• Solver pane, Stop time = 0
• Solver pane, Type = Fixed-step
• Solver pane, Solver = discrete (no continuous states)

12 Run the model.

The original image appears in the Video Viewer1 window. To view the image at its
true size, right-click the window and select Set Display To True Size.
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The opened image appears in the Video Viewer window. The following image is
shown at its true size.
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As you can see in the preceding figure, the spokes are now separate white objects. In
the model, the Display block correctly indicates that there are 24 distinct spokes.
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You have used the Opening and Label blocks to count the number of spokes in an image.
For more information about these blocks, see the Opening and Label block reference
pages in the Computer Vision System Toolbox Reference. If you want to send the number
of spokes to the MATLAB workspace, use the To Workspace block in Simulink. For
more information about STREL objects, see strel in the Image Processing Toolbox
documentation.
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Fixed-Point Signal Processing

In this section...

“Fixed-Point Features” on page 10-2
“Benefits of Fixed-Point Hardware” on page 10-2
“Benefits of Fixed-Point Design with System Toolboxes Software” on page 10-3

Note: To take full advantage of fixed-point support in System Toolbox software, you must
install Fixed-Point Designer™ software.

Fixed-Point Features

Many of the blocks in this product have fixed-point support, so you can design signal
processing systems that use fixed-point arithmetic. Fixed-point support in DSP System
Toolbox software includes

• Signed two's complement and unsigned fixed-point data types
• Word lengths from 2 to 128 bits in simulation
• Word lengths from 2 to the size of a long on the Simulink Coder C code-generation

target
• Overflow handling and rounding methods
• C code generation for deployment on a fixed-point embedded processor, with Simulink

Coder code generation software. The generated code uses all allowed data types
supported by the embedded target, and automatically includes all necessary shift and
scaling operations

Benefits of Fixed-Point Hardware

There are both benefits and trade-offs to using fixed-point hardware rather than floating-
point hardware for signal processing development. Many signal processing applications
require low-power and cost-effective circuitry, which makes fixed-point hardware a
natural choice. Fixed-point hardware tends to be simpler and smaller. As a result, these
units require less power and cost less to produce than floating-point circuitry.

Floating-point hardware is usually larger because it demands functionality and ease of
development. Floating-point hardware can accurately represent real-world numbers, and
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its large dynamic range reduces the risk of overflow, quantization errors, and the need
for scaling. In contrast, the smaller dynamic range of fixed-point hardware that allows
for low-power, inexpensive units brings the possibility of these problems. Therefore,
fixed-point development must minimize the negative effects of these factors, while
exploiting the benefits of fixed-point hardware; cost- and size-effective units, less power
and memory usage, and fast real-time processing.

Benefits of Fixed-Point Design with System Toolboxes Software

Simulating your fixed-point development choices before implementing them in hardware
saves time and money. The built-in fixed-point operations provided by the System
Toolboxes software save time in simulation and allow you to generate code automatically.

This software allows you to easily run multiple simulations with different word length,
scaling, overflow handling, and rounding method choices to see the consequences of
various fixed-point designs before committing to hardware. The traditional risks of fixed-
point development, such as quantization errors and overflow, can be simulated and
mitigated in software before going to hardware.

Fixed-point C code generation with System Toolbox software and Simulink Coder code
generation software produces code ready for execution on a fixed-point processor. All
the choices you make in simulation in terms of scaling, overflow handling, and rounding
methods are automatically optimized in the generated code, without necessitating time-
consuming and costly hand-optimized code.



10 Fixed-Point Design

10-4

Fixed-Point Concepts and Terminology

In this section...

“Fixed-Point Data Types” on page 10-4
“Scaling” on page 10-5
“Precision and Range” on page 10-6

Note: The “Glossary” defines much of the vocabulary used in these sections. For more
information on these subjects, see the “Fixed-Point Designer” documentation.

Fixed-Point Data Types

In digital hardware, numbers are stored in binary words. A binary word is a fixed-length
sequence of bits (1's and 0's). How hardware components or software functions interpret
this sequence of 1's and 0's is defined by the data type.

Binary numbers are represented as either fixed-point or floating-point data types. In this
section, we discuss many terms and concepts relating to fixed-point numbers, data types,
and mathematics.

A fixed-point data type is characterized by the word length in bits, the position of the
binary point, and whether it is signed or unsigned. The position of the binary point is the
means by which fixed-point values are scaled and interpreted.

For example, a binary representation of a generalized fixed-point number (either signed
or unsigned) is shown below:

where

• bi is the ith binary digit.
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• wl is the word length in bits.
• bwl–1 is the location of the most significant, or highest, bit (MSB).
• b0 is the location of the least significant, or lowest, bit (LSB).
• The binary point is shown four places to the left of the LSB. In this example,

therefore, the number is said to have four fractional bits, or a fraction length of four.

Fixed-point data types can be either signed or unsigned. Signed binary fixed-point
numbers are typically represented in one of three ways:

• Sign/magnitude
• One's complement
• Two's complement

Two's complement is the most common representation of signed fixed-point numbers and
is used by System Toolbox software. See “Two's Complement” on page 10-10 for more
information.

Scaling

Fixed-point numbers can be encoded according to the scheme

real world value slope integer bias- = ¥ +( )

where the slope can be expressed as

slope slope adjustment exponent
= ¥ 2

The integer is sometimes called the stored integer. This is the raw binary number, in
which the binary point assumed to be at the far right of the word. In System Toolboxes,
the negative of the exponent is often referred to as the fraction length.

The slope and bias together represent the scaling of the fixed-point number. In a number
with zero bias, only the slope affects the scaling. A fixed-point number that is only scaled
by binary point position is equivalent to a number in the Fixed-Point Designer [Slope
Bias] representation that has a bias equal to zero and a slope adjustment equal to one.
This is referred to as binary point-only scaling or power-of-two scaling:

real world value integerexponent
-  = ¥2
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or

real world value integerfraction length
-  = ¥

-
2

In System Toolbox software, you can define a fixed-point data type and scaling for the
output or the parameters of many blocks by specifying the word length and fraction
length of the quantity. The word length and fraction length define the whole of the data
type and scaling information for binary-point only signals.

All System Toolbox blocks that support fixed-point data types support signals with
binary-point only scaling. Many fixed-point blocks that do not perform arithmetic
operations but merely rearrange data, such as Delay and Matrix Transpose, also support
signals with [Slope Bias] scaling.

Precision and Range

You must pay attention to the precision and range of the fixed-point data types and
scalings you choose for the blocks in your simulations, in order to know whether rounding
methods will be invoked or if overflows will occur.

Range

The range is the span of numbers that a fixed-point data type and scaling can represent.
The range of representable numbers for a two's complement fixed-point number of word
length wl, scaling S, and bias B is illustrated below:

For both signed and unsigned fixed-point numbers of any data type, the number of
different bit patterns is 2wl.

For example, in two's complement, negative numbers must be represented as well as
zero, so the maximum value is 2wl–1. Because there is only one representation for zero,
there are an unequal number of positive and negative numbers. This means there is a
representation for -2wl–1 but not for 2wl –1:
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Overflow Handling

Because a fixed-point data type represents numbers within a finite range, overflows can
occur if the result of an operation is larger or smaller than the numbers in that range.

System Toolbox software does not allow you to add guard bits to a data type on-the-fly
in order to avoid overflows. Any guard bits must be allocated upon model initialization.
However, the software does allow you to either saturate or wrap overflows. Saturation
represents positive overflows as the largest positive number in the range being used, and
negative overflows as the largest negative number in the range being used. Wrapping
uses modulo arithmetic to cast an overflow back into the representable range of the data
type. See “Modulo Arithmetic” on page 10-9 for more information.

Precision

The precision of a fixed-point number is the difference between successive values
representable by its data type and scaling, which is equal to the value of its least
significant bit. The value of the least significant bit, and therefore the precision of the
number, is determined by the number of fractional bits. A fixed-point value can be
represented to within half of the precision of its data type and scaling.

For example, a fixed-point representation with four bits to the right of the binary point
has a precision of 2-4 or 0.0625, which is the value of its least significant bit. Any number
within the range of this data type and scaling can be represented to within (2-4)/2 or
0.03125, which is half the precision. This is an example of representing a number with
finite precision.

Rounding Modes

When you represent numbers with finite precision, not every number in the available
range can be represented exactly. If a number cannot be represented exactly by the
specified data type and scaling, it is rounded to a representable number. Although
precision is always lost in the rounding operation, the cost of the operation and the
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amount of bias that is introduced depends on the rounding mode itself. To provide you
with greater flexibility in the trade-off between cost and bias, DSP System Toolbox
software currently supports the following rounding modes:

• Ceiling rounds the result of a calculation to the closest representable number in the
direction of positive infinity.

• Convergent rounds the result of a calculation to the closest representable number.
In the case of a tie, Convergent rounds to the nearest even number. This is the least
biased rounding mode provided by the toolbox.

• Floor, which is equivalent to truncation, rounds the result of a calculation to the
closest representable number in the direction of negative infinity.

• Nearest rounds the result of a calculation to the closest representable number. In the
case of a tie, Nearest rounds to the closest representable number in the direction of
positive infinity.

• Round rounds the result of a calculation to the closest representable number. In the
case of a tie, Round rounds positive numbers to the closest representable number
in the direction of positive infinity, and rounds negative numbers to the closest
representable number in the direction of negative infinity.

• Simplest rounds the result of a calculation using the rounding mode (Floor or
Zero) that adds the least amount of extra rounding code to your generated code.
For more information, see “Rounding Mode: Simplest” in the Fixed-Point Designer
documentation.

• Zero rounds the result of a calculation to the closest representable number in the
direction of zero.

To learn more about each of these rounding modes, see “Rounding” in the Fixed-Point
Designer documentation.

For a direct comparison of the rounding modes, see “Choosing a Rounding Method” in the
Fixed-Point Designer documentation.
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Arithmetic Operations

In this section...

“Modulo Arithmetic” on page 10-9
“Two's Complement” on page 10-10
“Addition and Subtraction” on page 10-11
“Multiplication” on page 10-12
“Casts” on page 10-14

Note: These sections will help you understand what data type and scaling choices result
in overflows or a loss of precision.

Modulo Arithmetic

Binary math is based on modulo arithmetic. Modulo arithmetic uses only a finite set of
numbers, wrapping the results of any calculations that fall outside the given set back
into the set.

For example, the common everyday clock uses modulo 12 arithmetic. Numbers in this
system can only be 1 through 12. Therefore, in the “clock” system, 9 plus 9 equals 6. This
can be more easily visualized as a number circle:
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Similarly, binary math can only use the numbers 0 and 1, and any arithmetic results
that fall outside this range are wrapped “around the circle” to either 0 or 1.

Two's Complement

Two's complement is a way to interpret a binary number. In two's complement, positive
numbers always start with a 0 and negative numbers always start with a 1. If the
leading bit of a two's complement number is 0, the value is obtained by calculating the
standard binary value of the number. If the leading bit of a two's complement number
is 1, the value is obtained by assuming that the leftmost bit is negative, and then
calculating the binary value of the number. For example,

01 0 2 1

11 2 2 2 1 1

0

1 0

= + =

= - + = - + = -

( )

(( ) ( )) ( )

To compute the negative of a binary number using two's complement,

1 Take the one's complement, or “flip the bits.”
2 Add a 1 using binary math.
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3 Discard any bits carried beyond the original word length.

For example, consider taking the negative of 11010 (-6). First, take the one's complement
of the number, or flip the bits:

11010 00101Æ

Next, add a 1, wrapping all numbers to 0 or 1:

00101

1

00110 6

+

( )

Addition and Subtraction

The addition of fixed-point numbers requires that the binary points of the addends be
aligned. The addition is then performed using binary arithmetic so that no number other
than 0 or 1 is used.

For example, consider the addition of 010010.1 (18.5) with 0110.110 (6.75):

010010 1

0110 110

011001 010

18 5

6 75

25 25

.

.

.

( . )

( . )

( . )

+

Fixed-point subtraction is equivalent to adding while using the two's complement value
for any negative values. In subtraction, the addends must be sign extended to match each
other's length. For example, consider subtracting 0110.110 (6.75) from 010010.1 (18.5):

Most fixed-point DSP System Toolbox blocks that perform addition cast the adder inputs
to an accumulator data type before performing the addition. Therefore, no further
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shifting is necessary during the addition to line up the binary points. See “Casts” on page
10-14 for more information.

Multiplication

The multiplication of two's complement fixed-point numbers is directly analogous to
regular decimal multiplication, with the exception that the intermediate results must be
sign extended so that their left sides align before you add them together.

For example, consider the multiplication of 10.11 (-1.25) with 011 (3):

Multiplication Data Types

The following diagrams show the data types used for fixed-point multiplication in the
System Toolbox software. The diagrams illustrate the differences between the data types
used for real-real, complex-real, and complex-complex multiplication. See individual
reference pages to determine whether a particular block accepts complex fixed-point
inputs.

In most cases, you can set the data types used during multiplication in the block mask.
See Accumulator Parameters, Intermediate Product Parameters, Product Output
Parameters, and Output Parameters. These data types are defined in “Casts” on page
10-14.

Note: The following diagrams show the use of fixed-point data types in multiplication in
System Toolbox software. They do not represent actual subsystems used by the software
to perform multiplication.
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Real-Real Multiplication

The following diagram shows the data types used in the multiplication of two real
numbers in System Toolbox software. The software returns the output of this operation
in the product output data type, as the next figure shows.

Real-Complex Multiplication

The following diagram shows the data types used in the multiplication of a real and a
complex fixed-point number in System Toolbox software. Real-complex and complex-real
multiplication are equivalent. The software returns the output of this operation in the
product output data type, as the next figure shows.

Complex-Complex Multiplication

The following diagram shows the multiplication of two complex fixed-point numbers in
System Toolbox software. Note that the software returns the output of this operation in
the accumulator output data type, as the next figure shows.
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System Toolbox blocks cast to the accumulator data type before performing addition or
subtraction operations. In the preceding diagram, this is equivalent to the C code

acc=ac;

acc-=bd;

for the subtractor, and

acc=ad;

acc+=bc;

for the adder, where acc is the accumulator.

Casts

Many fixed-point System Toolbox blocks that perform arithmetic operations allow you
to specify the accumulator, intermediate product, and product output data types, as
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applicable, as well as the output data type of the block. This section gives an overview of
the casts to these data types, so that you can tell if the data types you select will invoke
sign extension, padding with zeros, rounding, and/or overflow.

Casts to the Accumulator Data Type

For most fixed-point System Toolbox blocks that perform addition or subtraction, the
operands are first cast to an accumulator data type. Most of the time, you can specify
the accumulator data type on the block mask. See Accumulator Parameters. Since the
addends are both cast to the same accumulator data type before they are added together,
no extra shift is necessary to insure that their binary points align. The result of the
addition remains in the accumulator data type, with the possibility of overflow.

Casts to the Intermediate Product or Product Output Data Type

For System Toolbox blocks that perform multiplication, the output of the multiplier is
placed into a product output data type. Blocks that then feed the product output back
into the multiplier might first cast it to an intermediate product data type. Most of the
time, you can specify these data types on the block mask. See Intermediate Product
Parameters and Product Output Parameters.

Casts to the Output Data Type

Many fixed-point System Toolbox blocks allow you to specify the data type and scaling of
the block output on the mask. Remember that the software does not allow mixed types
on the input and output ports of its blocks. Therefore, if you would like to specify a fixed-
point output data type and scaling for a System Toolbox block that supports fixed-point
data types, you must feed the input port of that block with a fixed-point signal. The final
cast made by a fixed-point System Toolbox block is to the output data type of the block.

Note that although you can not mix fixed-point and floating-point signals on the input
and output ports of blocks, you can have fixed-point signals with different word and
fraction lengths on the ports of blocks that support fixed-point signals.

Casting Examples

It is important to keep in mind the ramifications of each cast when selecting these
intermediate data types, as well as any other intermediate fixed-point data types that
are allowed by a particular block. Depending upon the data types you select, overflow
and/or rounding might occur. The following two examples demonstrate cases where
overflow and rounding can occur.
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Cast from a Shorter Data Type to a Longer Data Type

Consider the cast of a nonzero number, represented by a four-bit data type with two
fractional bits, to an eight-bit data type with seven fractional bits:

As the diagram shows, the source bits are shifted up so that the binary point matches
the destination binary point position. The highest source bit does not fit, so overflow
might occur and the result can saturate or wrap. The empty bits at the low end of the
destination data type are padded with either 0's or 1's:

• If overflow does not occur, the empty bits are padded with 0's.
• If wrapping occurs, the empty bits are padded with 0's.
• If saturation occurs,

• The empty bits of a positive number are padded with 1's.
• The empty bits of a negative number are padded with 0's.

You can see that even with a cast from a shorter data type to a longer data type, overflow
might still occur. This can happen when the integer length of the source data type (in
this case two) is longer than the integer length of the destination data type (in this case
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one). Similarly, rounding might be necessary even when casting from a shorter data type
to a longer data type, if the destination data type and scaling has fewer fractional bits
than the source.

Cast from a Longer Data Type to a Shorter Data Type

Consider the cast of a nonzero number, represented by an eight-bit data type with seven
fractional bits, to a four-bit data type with two fractional bits:

As the diagram shows, the source bits are shifted down so that the binary point matches
the destination binary point position. There is no value for the highest bit from the
source, so the result is sign extended to fill the integer portion of the destination
data type. The bottom five bits of the source do not fit into the fraction length of the
destination. Therefore, precision can be lost as the result is rounded.

In this case, even though the cast is from a longer data type to a shorter data type, all
the integer bits are maintained. Conversely, full precision can be maintained even if you
cast to a shorter data type, as long as the fraction length of the destination data type is
the same length or longer than the fraction length of the source data type. In that case,
however, bits are lost from the high end of the result and overflow might occur.
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The worst case occurs when both the integer length and the fraction length of the
destination data type are shorter than those of the source data type and scaling. In that
case, both overflow and a loss of precision can occur.
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Fixed-Point Support for MATLAB System Objects

In this section...

“Getting Information About Fixed-Point System Objects” on page 10-19
“Displaying Fixed-Point Properties” on page 10-20
“Setting System Object Fixed-Point Properties” on page 10-21

For information on working with Fixed-Point features, refer to the “Fixed-Point” topic.

Getting Information About Fixed-Point System Objects

System objects that support fixed-point data processing have fixed-
point properties, which you can display for a particular object by typing
vision.<ObjectName>.helpFixedPoint at the command line.

See “Displaying Fixed-Point Properties” on page 10-20 to set the display of System
object fixed-point properties.

The following Computer Vision System Toolbox objects support fixed-point data
processing.

Fixed-Point Data Processing Support
vision.AlphaBlender

vision.Autocorrelator

vision.Autothresholder

vision.BlobAnalysis

vision.BlockMatcher

vision.ContrastAdjuster

vision.Convolver

vision.CornerDetector

vision.Crosscorrelator

vision.DCT

vision.Deinterlacer

vision.DemosaicInterpolator

vision.EdgeDetector

vision.FFT

vision.GeometricRotator
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vision.GeometricScaler

vision.GeometricTranslator

vision.Histogram

vision.HoughLines

vision.HoughTransform

vision.IDCT

vision.IFFT

vision.ImageDataTypeConverter

vision.ImageFilter

vision.MarkerInserter

vision.Maximum

vision.Mean

vision.Median

vision.MedianFilter

vision.Minimum

vision.OpticalFlow

vision.PSNR

vision.Pyramid

vision.SAD

vision.ShapeInserter

vision.Variance

Displaying Fixed-Point Properties

You can control whether the software displays fixed-point properties with either of the
following commands:

• matlab.system.showFixedPointProperties

• matlab.system.hideFixedPointProperties

at the MATLAB command line. These commands set the Show fixed-point properties
display option. You can also set the display option directly via the MATLAB preferences
dialog box. Select the Preferences icon from the MATLAB desktop, and then select
System Objects. Finally, select or deselect Show fixed-point properties.
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If an object supports fixed-point data processing, its fixed-point properties are active
regardless of whether they are displayed or not.

Setting System Object Fixed-Point Properties

A number of properties affect the fixed-point data processing used by a System object.
Objects perform fixed-point processing and use the current fixed-point property settings
when they receive fixed-point input.

You change the values of fixed-point properties in the same way as you change any
System object property value. You also use the Fixed-Point Designer numerictype
object to specify the desired data type as fixed-point, the signedness, and the word- and
fraction-lengths.
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In the same way as for blocks, the data type properties of many System objects can set
the appropriate word lengths and scalings automatically by using full precision. System
objects assume that the target specified on the Configuration Parameters Hardware
Implementation target is ASIC/FPGA.

If you have not set the property that activates a dependent property and you attempt
to change that dependent property, a warning message displays. For example, for
the vision.EdgeDetector object, before you set CustomProductDataType to
numerictype(1,16,15) you must set ProductDataType to 'Custom'.

Note: System objects do not support fixed-point word lengths greater than 128 bits.

For any System object provided in the Toolbox, the fimath settings for any fimath
attached to a fi input or a fi property are ignored. Outputs from a System object never
have an attached fimath.
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Specify Fixed-Point Attributes for Blocks

In this section...

“Fixed-Point Block Parameters” on page 10-23
“Specify System-Level Settings” on page 10-26
“Inherit via Internal Rule” on page 10-27
“Specify Data Types for Fixed-Point Blocks” on page 10-37

Fixed-Point Block Parameters

System Toolbox blocks that have fixed-point support usually allow you to specify fixed-
point characteristics through block parameters. By specifying data type and scaling
information for these fixed-point parameters, you can simulate your target hardware
more closely.

Note: Floating-point inheritance takes precedence over the settings discussed in this
section. When the block has floating-point input, all block data types match the input.

You can find most fixed-point parameters on the Data Types pane of System Toolbox
blocks. The following figure shows a typical Data Types pane.
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All System Toolbox blocks with fixed-point capabilities share a set of common
parameters, but each block can have a different subset of these fixed-point parameters.
The following table provides an overview of the most common fixed-point block
parameters.

Fixed-Point Data Type
Parameter

Description

Rounding Mode Specifies the rounding mode for the block to use when the
specified data type and scaling cannot exactly represent the
result of a fixed-point calculation.

See “Rounding Modes” on page 10-7 for more information on
the available options.

Overflow Mode Specifies the overflow mode to use when the result of a fixed-
point calculation does not fit into the representable range of
the specified data type.

See “Overflow Handling” on page 10-7 for more information on
the available options.
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Fixed-Point Data Type
Parameter

Description

Intermediate Product Specifies the data type and scaling of the intermediate product
for fixed-point blocks. Blocks that feed multiplication results
back to the input of the multiplier use the intermediate
product data type.

See the reference page of a specific block to learn about the
intermediate product data type for that block.

Product Output Specifies the data type and scaling of the product output for
fixed-point blocks that must compute multiplication results.

See the reference page of a specific block to learn about the
product output data type for that block. For or complex-
complex multiplication, the multiplication result is in the
accumulator data type. See “Multiplication Data Types”
on page 10-12 for more information on complex fixed-point
multiplication in System toolbox software.

Accumulator Specifies the data type and scaling of the accumulator (sum)
for fixed-point blocks that must hold summation results for
further calculation. Most such blocks cast to the accumulator
data type before performing the add operations (summation).

See the reference page of a specific block for details on the
accumulator data type of that block.

Output Specifies the output data type and scaling for blocks.

Using the Data Type Assistant

The Data Type Assistant is an interactive graphical tool available on the Data Types
pane of some fixed-point System Toolbox blocks.

To learn more about using the Data Type Assistant to help you specify block data type
parameters, see the following section of the Simulink documentation:
“Specify Data Types Using Data Type Assistant”
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Checking Signal Ranges

Some fixed-point System Toolbox blocks have Minimum and Maximum parameters on
the Data Types pane. When a fixed-point data type has these parameters, you can use
them to specify appropriate minimum and maximum values for range checking purposes.

To learn how to specify signal ranges and enable signal range checking, see “Signal
Ranges” in the Simulink documentation.

Specify System-Level Settings

You can monitor and control fixed-point settings for System Toolbox blocks at a system or
subsystem level with the Fixed-Point Tool. For additional information on these subjects,
see

• The fxptdlg reference page — A reference page on the Fixed-Point Tool in the
Simulink documentation

• “Fixed-Point Tool” — A tutorial that highlights the use of the Fixed-Point Tool in the
Fixed-Point Designer software documentation

Logging

The Fixed-Point Tool logs overflows, saturations, and simulation minimums and
maximums for fixed-point System Toolbox blocks. The Fixed-Point Tool does not log
overflows and saturations when the Data overflow line in the Diagnostics > Data
Integrity pane of the Configuration Parameters dialog box is set to None.

Autoscaling

You can use the Fixed-Point Tool autoscaling feature to set the scaling for System
Toolbox fixed-point data types.

Data type override

System Toolbox blocks obey the Use local settings, Double, Single, and
Off modes of the Data type override parameter in the Fixed-Point Tool. The
Scaled double mode is also supported for System Toolboxes source and byte-shuffling
blocks, and for some arithmetic blocks such as Difference and Normalization.
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Inherit via Internal Rule

Selecting appropriate word lengths and scalings for the fixed-point parameters in your
model can be challenging. To aid you, an Inherit via internal rule choice is often
available for fixed-point block data type parameters, such as the Accumulator and
Product output signals. The following sections describe how the word and fraction
lengths are selected for you when you choose Inherit via internal rule for a fixed-
point block data type parameter in System Toolbox software:

• “Internal Rule for Accumulator Data Types” on page 10-27
• “Internal Rule for Product Data Types” on page 10-28
• “Internal Rule for Output Data Types” on page 10-28
• “The Effect of the Hardware Implementation Pane on the Internal Rule” on page

10-28
• “Internal Rule Examples” on page 10-30

Note: In the equations in the following sections, WL = word length and FL = fraction
length.

Internal Rule for Accumulator Data Types

The internal rule for accumulator data types first calculates the ideal, full-precision
result. Where N is the number of addends:

WL WL Nideal accumulator input to accumulator= + -floor(log ( )2 1 )) +1

FL FLideal accumulator input to accumulator=

For example, consider summing all the elements of a vector of length 6 and data type
sfix10_En8. The ideal, full-precision result has a word length of 13 and a fraction length
of 8.

The accumulator can be real or complex. The preceding equations are used for both the
real and imaginary parts of the accumulator. For any calculation, after the full-precision
result is calculated, the final word and fraction lengths set by the internal rule are
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affected by your particular hardware. See “The Effect of the Hardware Implementation
Pane on the Internal Rule” on page 10-28 for more information.

Internal Rule for Product Data Types

The internal rule for product data types first calculates the ideal, full-precision result:

WL WL WLideal product input 1 input 2= +

FL FL FLideal product input 1 input 2= +

For example, multiplying together the elements of a real vector of length 2 and data type
sfix10_En8. The ideal, full-precision result has a word length of 20 and a fraction length
of 16.

For real-complex multiplication, the ideal word length and fraction length is used for
both the complex and real portion of the result. For complex-complex multiplication, the
ideal word length and fraction length is used for the partial products, and the internal
rule for accumulator data types described above is used for the final sums. For any
calculation, after the full-precision result is calculated, the final word and fraction
lengths set by the internal rule are affected by your particular hardware. See “The Effect
of the Hardware Implementation Pane on the Internal Rule” on page 10-28 for more
information.

Internal Rule for Output Data Types

A few System Toolbox blocks have an Inherit via internal rule choice available
for the block output. The internal rule used in these cases is block-specific, and the
equations are listed in the block reference page.

As with accumulator and product data types, the final output word and fraction lengths
set by the internal rule are affected by your particular hardware, as described in “The
Effect of the Hardware Implementation Pane on the Internal Rule” on page 10-28.

The Effect of the Hardware Implementation Pane on the Internal Rule

The internal rule selects word lengths and fraction lengths that are appropriate for your
hardware. To get the best results using the internal rule, you must specify the type of
hardware you are using on the Hardware Implementation pane of the Configuration
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Parameters dialog box. You can open this dialog box from the Simulation menu in your
model.

ASIC/FPGA

On an ASIC/FPGA target, the ideal, full-precision word length and fraction length
calculated by the internal rule are used. If the calculated ideal word length is larger than
the largest allowed word length, you receive an error. The largest word length allowed for
Simulink and System Toolbox software is 128 bits.

Other targets

For all targets other than ASIC/FPGA, the ideal, full-precision word length calculated
by the internal rule is rounded up to the next available word length of the target. The
calculated ideal fraction length is used, keeping the least-significant bits.

If the calculated ideal word length for a product data type is larger than the largest
word length on the target, you receive an error. If the calculated ideal word length for an
accumulator or output data type is larger than the largest word length on the target, the
largest target word length is used.
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Internal Rule Examples

The following sections show examples of how the internal rule interacts with the
Hardware Implementation pane to calculate accumulator data types and product data
types.

Accumulator Data Types

Consider the following model ex_internalRule_accumExp.

In the Difference blocks, the Accumulator parameter is set to Inherit: Inherit
via internal rule, and the Output parameter is set to Inherit: Same as
accumulator. Therefore, you can see the accumulator data type calculated by the
internal rule on the output signal in the model.
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In the preceding model, the Device type parameter in the Hardware Implementation
pane of the Configuration Parameters dialog box is set to ASIC/FPGA. Therefore, the
accumulator data type used by the internal rule is the ideal, full-precision result.

Calculate the full-precision word length for each of the Difference blocks in the model:

WL WL numbideal accumulator input to accumulator= + floor(log (2 eer of  accumulations

WLideal accumulator

))

floor(log (2

+

= +

1

9 1))) +

= + + =

=

1

9 0 1 10

1

WL

WL WL

ideal accumulator

ideal accumulator inpput to accumulator number of  accumulations1 + +floor(log ( ))2 11

16 1 11WL

WL

ideal accumulator

ideal accumula

= + +floor(log ( ))2

ttor

ideal accumulator input to accumulatorWL WL

1

2

16 0 1 17= + + =

= 22 1+ +floor(log ( ))2 number of  accumulations

WLideal accumulatoor

ideal accumulatorWL

2

2

127 1 1

127 0 1 128

= + +

= + + =

floor(log ( ))2

Calculate the full-precision fraction length, which is the same for each Matrix Sum block
in this example:

FL FL

FL

ideal accumulator input to accumulator

ideal accumula

=

ttor = 4

Now change the Device type parameter in the Hardware Implementation pane
of the Configuration Parameters dialog box to 32–bit Embedded Processor, by
changing the parameters as shown in the following figure.
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As you can see in the dialog box, this device has 8-, 16-, and 32-bit word lengths
available. Therefore, the ideal word lengths of 10, 17, and 128 bits calculated by the
internal rule cannot be used. Instead, the internal rule uses the next largest available
word length in each case You can see this if you rerun the model, as shown in the
following figure.
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Product Data Types

Consider the following model ex_internalRule_prodExp.

In the Array-Vector Multiply blocks, the Product Output parameter is set to Inherit:
Inherit via internal rule, and the Output parameter is set to Inherit: Same
as product output. Therefore, you can see the product output data type calculated
by the internal rule on the output signal in the model. The setting of the Accumulator
parameter does not matter because this example uses real values.

For the preceding model, the Device type parameter in the Hardware
Implementation pane of the Configuration Parameters dialog box is set to ASIC/FPGA.
Therefore, the product data type used by the internal rule is the ideal, full-precision
result.

Calculate the full-precision word length for each of the Array-Vector Multiply blocks in
the model:
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WL WL WL

WL

W

ideal product input a input b

ideal product

= +

= + =7 5 12

LL WL WL

WL

ideal product input a input b

ideal product

1

1 16 15

= +

= + == 31

Calculate the full-precision fraction length, which is the same for each Array-Vector
Multiply block in this example:

FL FL

FL

ideal accumulator input to accumulator

ideal accumula

=

ttor = 4

Now change the Device type parameter in the Hardware Implementation pane of
the Configuration Parameters dialog box to 32–bit Embedded Processor, as shown in
the following figure.
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As you can see in the dialog box, this device has 8-, 16-, and 32-bit word lengths
available. Therefore, the ideal word lengths of 12 and 31 bits calculated by the internal
rule cannot be used. Instead, the internal rule uses the next largest available word
length in each case. You can see this if you rerun the model, as shown in the following
figure.



 Specify Fixed-Point Attributes for Blocks

10-37

Specify Data Types for Fixed-Point Blocks

The following sections show you how to use the Fixed-Point Tool to select appropriate
data types for fixed-point blocks in the ex_fixedpoint_tut model:

• “Prepare the Model” on page 10-37
• “Use Data Type Override to Find a Floating-Point Benchmark” on page 10-42
• “Use the Fixed-Point Tool to Propose Fraction Lengths” on page 10-43
• “Examine the Results and Accept the Proposed Scaling” on page 10-43

Prepare the Model

1 Open the model by typing ex_fixedpoint_tut at the MATLAB command line.
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This model uses the Cumulative Sum block to sum the input coming from the Fixed-
Point Sources subsystem. The Fixed-Point Sources subsystem outputs two signals
with different data types:

• The Signed source has a word length of 16 bits and a fraction length of 15 bits.
• The Unsigned source has a word length of 16 bits and a fraction length of 16 bits.

2 Run the model to check for overflow. MATLAB displays the following warnings at
the command line:

Warning: Overflow occurred. This originated from

'ex_fixedpoint_tut/Signed Cumulative Sum'. 

Warning: Overflow occurred. This originated from

'ex_fixedpoint_tut/Unsigned Cumulative Sum'. 

According to these warnings, overflow occurs in both Cumulative Sum blocks.
3 To investigate the overflows in this model, use the Fixed-Point Tool. You can

open the Fixed-Point Tool by selecting Tools > Fixed-Point > Fixed-Point Tool
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from the model menu. Turn on logging for all blocks in your model by setting the
Fixed-point instrumentation mode parameter to Minimums, maximums and
overflows.

4 Now that you have turned on logging, rerun the model by clicking the Simulation
button.
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5 The results of the simulation appear in a table in the central Contents pane of the
Fixed-Point Tool. Review the following columns:

• Name — Provides the name of each signal in the following format: Subsystem
Name/Block Name: Signal Name.

• SimDT — The simulation data type of each logged signal.
• SpecifiedDT — The data type specified on the block dialog for each signal.
• SimMin — The smallest representable value achieved during simulation for each

logged signal.
• SimMax — The largest representable value achieved during simulation for each

logged signal.
• OverflowWraps — The number of overflows that wrap during simulation.

For more information on each of the columns in this table, see the “Contents Pane”
section of the Simulink fxptdlg function reference page.

You can also see that the SimMin and SimMax values for the Accumulator data
types range from 0 to .9997. The logged results indicate that 8,192 overflows
wrapped during simulation in the Accumulator data type of the Signed Cumulative
Sum block. Similarly, the Accumulator data type of the Unsigned Cumulative Sum
block had 16,383 overflows wrap during simulation.

To get more information about each of these data types, highlight them in the

Contents pane, and click the Show details for selected result button ( )
6 Assume a target hardware that supports 32-bit integers, and set the Accumulator

word length in both Cumulative Sum blocks to 32. To do so, perform the following
steps:

1 Right-click the Signed Cumulative Sum: Accumulator row in the Fixed-
Point Tool pane, and select Highlight Block In Model.

2 Double-click the block in the model, and select the Data Types pane of the
dialog box.

3 Open the Data Type Assistant for Accumulator by clicking the Assistant

button ( ) in the Accumulator data type row.
4 Set the Mode to Fixed Point. To see the representable range of the current

specified data type, click the Fixed-point details link. The tool displays the
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representable maximum and representable minimum values for the current data
type.

5 Change the Word length to 32, and click the Refresh details button in the
Fixed-point details section to see the updated representable range. When you
change the value of the Word length parameter, the data type string in the
Data Type edit box automatically updates.

6 Click OK on the block dialog box to save your changes and close the window.
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7 Set the word length of the Accumulator data type of the Unsigned Cumulative
Sum block to 32 bits. You can do so in one of two ways:

• Type the data type string fixdt([],32,0) directly into Data Type edit box
for the Accumulator data type parameter.

• Perform the same steps you used to set the word length of the Accumulator
data type of the Signed Cumulative Sum block to 32 bits.

7 To verify your changes in word length and check for overflow, rerun your model. To
do so, click the Simulate button in the Fixed-Point Tool.

The Contents pane of the Fixed-Point Tool updates, and you can see that no
overflows occurred in the most recent simulation. However, you can also see that the
SimMin and SimMax values range from 0 to 0. This underflow happens because
the fraction length of the Accumulator data type is too small. The SpecifiedDT
cannot represent the precision of the data values. The following sections discuss how
to find a floating-point benchmark and use the Fixed-Point Tool to propose fraction
lengths.

Use Data Type Override to Find a Floating-Point Benchmark

The Data type override feature of the Fixed-Point tool allows you to override the data
types specified in your model with floating-point types. Running your model in Double
override mode gives you a reference range to help you select appropriate fraction lengths
for your fixed-point data types. To do so, perform the following steps:

1 Open the Fixed-Point Tool and set Data type override to Double.
2 Run your model by clicking the Run simulation and store active results button.
3 Examine the results in the Contents pane of the Fixed-Point Tool. Because you ran

the model in Double override mode, you get an accurate, idealized representation of
the simulation minimums and maximums. These values appear in the SimMin and
SimMax parameters.

4 Now that you have an accurate reference representation of the simulation minimum
and maximum values, you can more easily choose appropriate fraction lengths.
Before making these choices, save your active results to reference so you can use
them as your floating-point benchmark. To do so, select Results > Move Active
Results To Reference from the Fixed-Point Tool menu. The status displayed in the
Run column changes from Active to Reference for all signals in your model.
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Use the Fixed-Point Tool to Propose Fraction Lengths

Now that you have your Double override results saved as a floating-point reference, you
are ready to propose fraction lengths.

1 To propose fraction lengths for your data types, you must have a set of Active
results available in the Fixed-Point Tool. To produce an active set of results,
simply rerun your model. The tool now displays both the Active results and the
Reference results for each signal.

2 Select the Use simulation min/max if design min/max is not available check
box. You did not specify any design minimums or maximums for the data types
in this model. Thus, the tool uses the logged information to compute and propose
fraction lengths. For information on specifying design minimums and maximums,
see “Signal Ranges” in the Simulink documentation.

3

Click the Propose fraction lengths button ( ). The tool populates the proposed
data types in the ProposedDT column of the Contents pane. The corresponding
proposed minimums and maximums are displayed in the ProposedMin and
ProposedMax columns.

Examine the Results and Accept the Proposed Scaling

Before accepting the fraction lengths proposed by the Fixed-Point Tool, it is important
to look at the details of that data type. Doing so allows you to see how much of your data
the suggested data type can represent. To examine the suggested data types and accept
the proposed scaling, perform the following steps:

1 In the Contents pane of the Fixed-Point Tool, you can see the proposed fraction
lengths for the data types in your model.

• The proposed fraction length for the Accumulator data type of both the Signed
and Unsigned Cumulative Sum blocks is 17 bits.

• To get more details about the proposed scaling for a particular data type,
highlight the data type in the Contents pane of the Fixed-Point Tool.

• Open the Autoscale Information window for the highlighted data type by clicking

the Show autoscale information for the selected result button ( ).
2 When the Autoscale Information window opens, check the Value and Percent

Proposed Representable columns for the Simulation Minimum and
Simulation Maximum parameters. You can see that the proposed data type can
represent 100% of the range of simulation data.
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3 To accept the proposed data types, select the check box in the Accept column for
each data type whose proposed scaling you want to keep. Then, click the Apply

accepted fraction lengths button ( ). The tool updates the specified data types
on the block dialog boxes and the SpecifiedDT column in the Contents pane.

4 To verify the newly accepted scaling, set the Data type override parameter back
to Use local settings, and run the model. Looking at Contents pane of the Fixed-
Point Tool, you can see the following details:

• The SimMin and SimMax values of the Active run match the SimMin and
SimMax values from the floating-point Reference run.

• There are no longer any overflows.
• The SimDT does not match the SpecifiedDT for the Accumulator data type of

either Cumulative Sum block. This difference occurs because the Cumulative
Sum block always inherits its Signedness from the input signal and only allows
you to specify a Signedness of Auto. Therefore, the SpecifiedDT for both
Accumulator data types is fixdt([],32,17). However, because the Signed
Cumulative Sum block has a signed input signal, the SimDT for the Accumulator
parameter of that block is also signed (fixdt(1,32,17)). Similarly, the SimDT
for the Accumulator parameter of the Unsigned Cumulative Sum block inherits
its Signedness from its input signal and thus is unsigned (fixdt(0,32,17)).
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Code Generation in MATLAB

Several Computer Vision System Toolbox functions have been enabled to generate C/C++
code. To use code generation with computer vision functions, follow these steps:

• Write your Computer Vision System Toolbox function or application as you would
normally, using functions from the Computer Vision System Toolbox.

• Add the %#codegen compiler directive to your MATLAB code.
• Open the MATLAB Coder app, create a project, and add your file to the project. Once

in MATLAB Coder, you can check the readiness of your code for code generation. For
example, your code may contain functions that are not enabled for code generation.
Make any modifications required for code generation.

• Generate code by clicking Build on the Build tab of the MATLAB Coder app. You can
choose to build a MEX file, a C/C++ shared library, a C/C++ dynamic library, or a C/C
++ executable.

Even if you addressed all readiness issues identified by MATLAB Coder, you might
still encounter build issues. The readiness check only looks at function dependencies.
When you try to generate code, MATLAB Coder might discover coding patterns
that are not supported for code generation. View the error report and modify your
MATLAB code until you get a successful build.

For more information about code generation, see the MATLAB Coder documentation and
the “Introduction to Code Generation with Feature Matching and Registration” example.

Note: To generate code from MATLAB code that contains Computer Vision System
Toolbox functionality, you must have the MATLAB Coder software.

When working with generated code, note the following:

• For some Computer Vision System Toolbox functions, code generation includes
creation of a shared library.

• Refer to the “Code Generation Support, Usage Notes, and Limitations” on page
11-3 for supported functionality, usages, and limitations.
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Code Generation Support, Usage Notes, and Limitations

Code Generation Support, Usage Notes, and Limitations for Functions, Classes, and
System Objects

To generate code from MATLAB code that contains Computer Vision System Toolbox
functions, classes, or System objects, you must have the MATLAB Coder software.

Name Remarks and Limitations

Feature Detection, Extraction, and Matching
BRISKPoints Supports MATLAB Function block: No

To index locations with this object, use
the syntax: points.Location(idx,:),
for points object. See
visionRecovertformCodeGeneration_kernel.m,
which is used in the “Introduction to Code
Generation with Feature Matching and
Registration” example.

cornerPoints Supports MATLAB Function block: No
To index locations with this object, use
the syntax: points.Location(idx,:),
for points object. See
visionRecovertformCodeGeneration_kernel.m,
which is used in the “Introduction to Code
Generation with Feature Matching and
Registration” example.

detectBRISKFeatures Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.

detectFASTFeatures Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.

detectHarrisFeatures Compile-time constant input: 'FilterSize'
Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.

detectMinEigenFeatures Compile-time constant input: 'FilterSize'

http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
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Name Remarks and Limitations

Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.

detectMSERFeatures Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.
For code generation, the function outputs
regions.PixelList as an array. The region sizes
are defined in regions.Lengths.

detectSURFFeatures Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.

extractFeatures Generates platform-dependent library: Yes for
BRISK, FREAK, and SURF methods only.
Compile-time constant input restrictions:
'Method'
Supports MATLAB Function block: Yes for Block
method only.
Generated code for this function uses a
precompiled platform-specific shared library.

extractHOGFeatures Supports MATLAB Function block: No
matchFeatures Generates platform-dependent library: Yes for

MATLAB host.
Generates portable C code for non-host target.
Compile-time constant input: 'Method‘ and
'Metric'.
Supports MATLAB Function block: Yes

MSERRegions Supports MATLAB Function block: Yes
For code generation, you must specify both
the pixellist cell array and the length of each
array, as the second input. The object outputs,
regions.PixelList as an array. The region sizes
are defined in regions.Lengths.
Generated code for this function uses a
precompiled platform-specific shared library.

http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
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Name Remarks and Limitations

SURFPoints Supports MATLAB Function block: No
To index locations with this object, use
the syntax: points.Location(idx,:),
for points object. See
visionRecovertformCodeGeneration_kernel.m,
which is used in the “Introduction to Code
Generation with Feature Matching and
Registration” example.

vision.BoundaryTracer Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.EdgeDetector Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

Image Registration and Geometric Transformations
estimateGeometricTransform Supports MATLAB Function block: No
vision.GeometricRotator Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.GeometricScaler Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.GeometricShearer Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.GeometricTransformer Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.GeometricTranslator Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
Object Detection and Recognition
ocr Compile-time constant input: 'TextLayout',

'Language', and 'CharacterSet'.
Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.

ocrText Supports MATLAB Function block: No

http://www.mathworks.com/support/sysreq/current_release/
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Name Remarks and Limitations

vision.PeopleDetector Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.
“System Objects in MATLAB Code Generation”

vision.CascadeObjectDetector Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.
“System Objects in MATLAB Code Generation”

Tracking and Motion Estimation
assignDetectionsToTracks Supports MATLAB Function block: Yes
opticalFlowHS Supports MATLAB Function block: No

Generated code for this function uses a
precompiled platform-specific shared library.

opticalFlowLKDoG Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.

opticalFlowLK Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.

opticalFlow Supports MATLAB Function block: Yes
vision.BlockMatcher Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.ForegroundDetector Supports MATLAB Function block: No

Generates platform-dependent library: Yes for
MATLAB host.
Generates portable C code for non-host target.
Generated code for this function uses a
precompiled platform-specific shared library.
“System Objects in MATLAB Code Generation”

vision.HistogramBasedTracker Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.KalmanFilter Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
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Name Remarks and Limitations

vision.PointTracker Supports MATLAB Function block: No
“System Objects in MATLAB Code Generation”

vision.TemplateMatcher Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

Camera Calibration and Stereo Vision
bboxOverlapRatio Supports MATLAB Function block: No
disparity Compile-time constant input restriction:

'Method'.
Supports MATLAB Function block: No
Generated code for this function uses a
precompiled platform-specific shared library.

cameraMatrix Supports MATLAB Function block: No
cameraParameters Supports MATLAB Function block: No
epipolarline Supports MATLAB Function block: Yes
estimateFundamentalMatrix Compile-time constant input restriction:

'Method', 'OutputClass', 'DistanceType', and
'ReportRuntimeError'.
Supports MATLAB Function block: Yes

estimateUncalibratedRectification Supports MATLAB Function block: Yes
Only accepts input points as M-by-2 matrices for
C code generation

extrinsics Supports MATLAB Function block: No
isEpipoleInImage Supports MATLAB Function block: Yes
lineToBorderPoints Supports MATLAB Function block: Yes
reconstructScene Supports MATLAB Function block: No
rectifyStereoImages Compile-time constant input restriction: 'interp'

and 'OutputView'
Supports MATLAB Function block: No

selectStrongestBbox Supports MATLAB Function block: No
stereoParameters Supports MATLAB Function block: No
triangulate Supports MATLAB Function block: No

http://www.mathworks.com/support/sysreq/current_release/
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Name Remarks and Limitations

undistortImage Compile-time constant input restriction: 'interp'
and 'OutputView'
Supports MATLAB Function block: No

Statistics
vision.Autocorrelator Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.BlobAnalysis Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.Crosscorrelator Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.Histogram Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.LocalMaximaFinder Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.Maximum Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.Mean Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.Median Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.Minimum Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.PSNR Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.StandardDeviation Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.Variance Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
Morphological Operations
vision.ConnectedComponentLabeler Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
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Name Remarks and Limitations

vision.MorphologicalBottomHat Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.MorphologicalClose Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.MorphologicalDilate Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.MorphologicalErode Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.MorphologicalOpen Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.MorphologicalTopHat Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

Filters, Transforms, and Enhancements
integralImage Supports MATLAB Function block: Yes
vision.Convolver Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.ContrastAdjuster Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.DCT Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.Deinterlacer Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.EdgeDetector Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.FFT Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.HistogramEqualizer Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.HoughLines Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.HoughTransform Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
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Name Remarks and Limitations

vision.IDCT Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.IFFT Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.ImageFilter Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.MedianFilter Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.Pyramid Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

Video Loading, Saving, and Streaming
vision.DeployableVideoPlayer Supports MATLAB Function block: Yes

Generated code for this function uses a
precompiled platform-specific shared library.
“System Objects in MATLAB Code Generation”

vision.VideoFileReader Supports MATLAB Function block: Yes
Generated code for this function uses a
precompiled platform-specific shared library.
“System Objects in MATLAB Code Generation”

Does not generate code for reading compressed
images on the Mac.

vision.VideoFileWriter Supports MATLAB Function block: Yes
Generated code for this function uses a
precompiled platform-specific shared library.
“System Objects in MATLAB Code Generation”

Color Space Formatting and Conversions
vision.Autothresholder Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.ChromaResampler Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”
vision.ColorSpaceConverter Supports MATLAB Function block: Yes

“System Objects in MATLAB Code Generation”

http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
http://www.mathworks.com/support/sysreq/current_release/
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Name Remarks and Limitations

vision.DemosaicInterpolator Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.GammaCorrector Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.ImageComplementer Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.ImageDataTypeConverter Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.ImagePadder Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

Graphics
insertMarker Compile-time constant input: 'Shape' and 'Color'

Supports MATLAB Function block: Yes
insertShape Compile-time constant input: 'Color' and

'SmoothEdges'
Supports MATLAB Function block: Yes

vision.AlphaBlender Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.MarkerInserter Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.ShapeInserter Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”

vision.TextInserter Supports MATLAB Function block: Yes
“System Objects in MATLAB Code Generation”
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Simulink Shared Library Dependencies

In general, the code you generate from Computer Vision System Toolbox blocks is
portable ANSI® C code. After you generate the code, you can deploy it on another
machine. For more information on how to do so, see “Relocate Code to Another
Development Environment” in the Simulink Coder documentation.

There are a few Computer Vision System Toolbox blocks that generate code with limited
portability. These blocks use precompiled shared libraries, such as DLLs, to support I/
O for specific types of devices and file formats. To find out which blocks use precompiled
shared libraries, open the Computer Vision System Toolbox Block Support Table. You
can identify blocks that use precompiled shared libraries by checking the footnotes
listed in the Code Generation Support column of the table. All blocks that use shared
libraries have the following footnote:

Host computer only. Excludes Simulink Desktop Real-Time™ target.

.

Simulink Coder provides functions to help you set up and manage the build information
for your models. For example, one of the Build Information functions that Simulink
Coder provides is getNonBuildFiles. This function allows you to identify the shared
libraries required by blocks in your model. If your model contains any blocks that use
precompiled shared libraries, you can install those libraries on the target system. The
folder that you install the shared libraries in must be on the system path. The target
system does not need to have MATLAB installed, but it does need to be supported by
MATLAB.
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Accelerating Simulink Models

The Simulink software offer Accelerator and Rapid Accelerator simulation
modes that remove much of the computational overhead required by Simulink models.
These modes compile target code of your model. Through this method, the Simulink
environment can achieve substantial performance improvements for larger models.
The performance gains are tied to the size and complexity of your model. Therefore,
large models that contain Computer Vision System Toolbox blocks run faster in Rapid
Accelerator or Accelerator mode.

To change between Rapid Accelerator, Accelerator, and Normal mode, use the
drop-down list at the top of the model window.

For more information on the accelerator modes in Simulink, see “Choosing a Simulation
Mode”.
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Define New System Objects

• “Summary List of Methods for Defining New System Objects” on page 12-3
• “Define Basic System Objects” on page 12-5
• “Change Number of Step Inputs or Outputs” on page 12-7
• “Specify System Block Input and Output Names” on page 12-11
• “Validate Property and Input Values” on page 12-13
• “Initialize Properties and Setup One-Time Calculations” on page 12-16
• “Set Property Values at Construction Time” on page 12-19
• “Reset Algorithm State” on page 12-21
• “Define Property Attributes” on page 12-23
• “Hide Inactive Properties” on page 12-27
• “Limit Property Values to Finite String Set” on page 12-29
• “Process Tuned Properties” on page 12-32
• “Release System Object Resources” on page 12-34
• “Define Composite System Objects” on page 12-36
• “Define Finite Source Objects” on page 12-39
• “Save System Object” on page 12-41
• “Load System Object” on page 12-45
• “Clone System Object” on page 12-49
• “Define System Object Information” on page 12-50
• “Define System Block Icon” on page 12-52
• “Add Header to System Block Dialog” on page 12-54
• “Add Property Groups to System Object and Block Dialog” on page 12-56
• “Control Simulation Type in System Block Dialog” on page 12-61
• “Add Button to System Block Dialog Box” on page 12-63
• “Specify Locked Input Size” on page 12-66
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• “Set Output Size” on page 12-68
• “Set Output Data Type” on page 12-70
• “Set Output Complexity” on page 12-72
• “Specify Whether Output Is Fixed- or Variable-Size” on page 12-74
• “Specify Discrete State Output Specification” on page 12-76
• “Use Update and Output for Nondirect Feedthrough” on page 12-78
• “Enable For Each Subsystem Support” on page 12-81
• “Methods Timing” on page 12-83
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
• “What Are Mixin Classes?” on page 12-87
• “Best Practices for Defining System Objects” on page 12-88
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Summary List of Methods for Defining New System Objects

The following Impl methods comprise the System objects API for defining new System
objects. For more information see “Define System Objects”.

• cloneImpl

• getDiscreteStateImpl

• getDiscreteStateSpecificationImpl

• getHeaderImpl

• getIconImpl

• getInputNamesImpl

• getNumInputsImpl

• getNumOutputsImpl

• getOutputDataTypeImpl

• getOutputNamesImpl

• getOutputSizeImpl

• getPropertyGroupsImpl

• getSimulateUsingImpl

• infoImpl

• isInactivePropertyImpl

• isInputDirectFeedthroughImpl

• isOutputComplexImpl

• isOutputFixedSizeImpl

• loadObjectImpl

• outputImpl

• processTunedPropertiesImpl

• propagatedInputComplexity

• propagatedInputDataType

• propagatedInputFixedSize

• propagatedInputSize

• releaseImpl
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• resetImpl

• saveObjectImpl

• setProperties

• setupImpl

• showSimulateUsingImpl

• stepImpl

• supportsMultipleInstanceImpl

• updateImpl

• validateInputsImpl

• validatePropertiesImpl
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Define Basic System Objects

This example shows how to create a basic System object that increments a number by
one.

The class definition file contains the minimum elements required to define a System
object.

Create the Class Definition File

1 Create a MATLAB file named AddOne.m to contain the definition of your System
object.

edit AddOne.m

2 Subclass your object from matlab.System. Insert this line as the first line of your
file.

classdef AddOne < matlab.System

3 Add the stepImpl method, which contains the algorithm that runs when users call
the step method on your object. You always set the stepImpl method access to
protected because it is an internal method that users do not directly call or run.

All methods, except static methods, expect the System object handle as the first
input argument. You can use any name for your System object handle.

In this example, instead of passing in the object handle, ~ is used to indicate that
the object handle is not used in the function. Using ~ instead of an object handle
prevents warnings about unused variables from occurring.

By default, the number of inputs and outputs are both one. To change the number
of inputs or outputs, use the getNumInputsImpl or getNumOutputsImpl method,
respectively.

methods (Access = protected)

   function y = stepImpl(~,x)

      y = x + 1;

   end

end

Note: Instead of manually creating your class definition file, you can use an option on
the New > System Object menu to open a template. The Basic template opens a simple
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System object template. The Advanced template includes more advanced features of
System objects, such as backup and restore. The Simulink Extension template includes
additional customizations of the System object for use in the Simulink MATLAB System
block. You then can edit the template file, using it as guideline, to create your own
System object.

Complete Class Definition File for Basic System Object

classdef AddOne < matlab.System

% ADDONE Compute an output value one greater than the input value

  

  % All methods occur inside a methods declaration.

  % The stepImpl method has protected access

  methods (Access = protected)

    

    function y = stepImpl(~,x)

      y = x + 1;

    end

  end

end

See Also
matlab.System | getNumInputsImpl | getNumOutputsImpl | stepImpl

Related Examples
• “Change Number of Step Inputs or Outputs” on page 12-7

More About
• “System Design and Simulation in MATLAB”
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Change Number of Step Inputs or Outputs
This example shows how to specify two inputs and two outputs for the step method.

If you specify the inputs and outputs to the stepImpl method, you do not need to
specify the getNumInputsImpl and getNumOutputsImpl methods. If you have
a variable number of inputs or outputs (using varargin or varargout), include the
getNumInputsImpl or getNumOutputsImpl method, respectively, in your class
definition file.

Note: You should only use getNumInputsImpl or getNumOutputsImpl methods to
change the number of System object inputs or outputs. Do not use any other handle
objects within a System object to change the number of inputs or outputs.

You always set the getNumInputsImpl and getNumOutputsImpl methods access to
protected because they are internal methods that users do not directly call or run.

Update the Algorithm for Multiple Inputs and Outputs

Update the stepImpl method to specify two inputs and two outputs. You do not need to
implement associated getNumInputsImpl or getNumOutputsImpl methods.

methods (Access = protected)

   function [y1,y2] = stepImpl(~,x1,x2)

      y1 = x1 + 1

      y2 = x2 + 1;

   end

end

Update the Algorithm and Associated Methods

Update the stepImpl method to use varargin and varargout. In this case, you must
implement the associated getNumInputsImpl and getNumOutputsImpl methods to
specify two or three inputs and outputs.

methods (Access = protected)

   function varargout = stepImpl(obj,varargin)

      varargout{1} = varargin{1}+1;

      varargout{2} = varargin{2}+1;

      if (obj.numInputsOutputs = 3)

         varargout{3} = varargin{3}+1;

      end
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   end

   function validatePropertiesImpl(obj)

      if ~((obj.numInputsOutputs == 2) ||...

           (obj.numInputsOutputs == 3))

         error('Only 2 or 3 input and outputs allowed.');

      end

   end

   function numIn = getNumInputsImpl(obj)

      numIn = 3;

      if (obj.numInputsOutputs == 2)

         numIn = 2;

      end

   end

   function numOut = getNumOutputsImpl(obj)

      numOut = 3;

      if (obj.numInputsOutputs == 2)

         numOut = 2;

      end

   end

end

Use this syntax to run the algorithm with two inputs and two outputs.

x1 = 3;

x2 = 7;

[y1,y2] = step(AddOne,x1,x2);

To change the number of inputs or outputs, you must release the object before rerunning
it.

release(AddOne)

x1 = 3;

x2 = 7;

x3 = 10

[y1,y2,y3] = step(AddOne,x1,x2,x3);

Complete Class Definition File with Multiple Inputs and Outputs

 classdef AddOne < matlab.System

% ADDONE Compute output values one greater than the input values

  

   % This property is nontunable and cannot be changed
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   % after the setup or step method has been called.

   properties (Nontunable)

      numInputsOutputs = 3;   % Default value

     end

   % All methods occur inside a methods declaration.

   % The stepImpl method has protected access

   methods (Access = protected)

      function varargout = stepImpl(obj,varargin)

         if (obj.numInputsOutputs == 2)

            varargout{1} = varargin{1}+1;

            varargout{2} = varargin{2}+1;

         else

            varargout{1} = varargin{1}+1;

            varargout{2} = varargin{2}+1;

            varargout{3} = varargin{3}+1;

         end

      end

      function validatePropertiesImpl(obj)

         if ~((obj.numInputsOutputs == 2) ||...

              (obj.numInputsOutputs == 3))

            error('Only 2 or 3 input and outputs allowed.');

         end

      end

      function numIn = getNumInputsImpl(obj)

         numIn = 3;

         if (obj.numInputsOutputs == 2)

            numIn = 2;

         end

      end

      function numOut = getNumOutputsImpl(obj)

         numOut = 3;

         if (obj.numInputsOutputs == 2)

            numOut = 2;

         end

      end

   end
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end

See Also
getNumInputsImpl | getNumOutputsImpl

Related Examples
• “Validate Property and Input Values” on page 12-13
• “Define Basic System Objects” on page 12-5

More About
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Specify System Block Input and Output Names

This example shows how to specify the names of the input and output ports of a System
object–based block implemented using a MATLAB System block.

Define Input and Output Names

This example shows how to use getInputNamesImpl and getOutputNamesImpl to
specify the names of the input port as “source data” and the output port as “count.”

If you do not specify the getInputNamesImpl and getOutputNamesImpl methods, the
object uses the stepImpl method input and output variable names for the input and
output port names, respectively. If the stepImpl method uses varargin and varargout
instead of variable names, the port names default to empty strings.

methods (Access = protected)

   function inputName = getInputNamesImpl(~)

          inputName = 'source data';

   end

   

   function outputName = getOutputNamesImpl(~)

          outputName = 'count';

   end

end

Complete Class Definition File with Named Inputs and Outputs

classdef MyCounter < matlab.System

  

   % MyCounter Count values above a threshold

     

    properties

       Threshold = 1

    end

    properties (DiscreteState)

       Count

    end

 

    methods

       function obj = MyCounter(varargin)

          setProperties (obj,nargin,varargin{:});

       end

    end
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    methods (Access = protected)

       function setupImpl(obj)

          obj.Count = 0;

       end

       function resetImpl(obj)

          obj.Count = 0;

       end

       function y = stepImpl(obj,u)

          if (u > obj.Threshold)

             obj.Count = obj.Count + 1;

          end

          y = obj.Count;

       end

       function inputName = getInputNamesImpl(~)

          inputName = 'source data';

       end

       function outputName = getOutputNamesImpl(~)

          outputName = 'count';

       end

    end

end

See Also
getInputNamesImpl | getNumInputsImpl | getNumOutputsImpl |
getOutputNamesImpl

Related Examples
• “Change Number of Step Inputs or Outputs” on page 12-7

More About
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Validate Property and Input Values

This example shows how to verify that the user’s inputs and property values are valid.

Validate Properties

This example shows how to validate the value of a single property using
set.PropertyName syntax. In this case, the PropertyName is Increment.

 methods

    % Validate the properties of the object

    function set.Increment(obj,val)

        if val >= 10

          error('The increment value must be less than 10');

        end

        obj.Increment = val;

    end

  end

  

This example shows how to validate the value of two interdependent properties using the
validatePropertiesImpl method. In this case, the UseIncrement property value
must be true and the WrapValue property value must be less than the Increment
property value.

 methods (Access = protected)

    function validatePropertiesImpl(obj)

        if obj.UseIncrement && obj.WrapValue > obj.Increment

          error('Wrap value must be less than increment value');

        end

    end

 end

Validate Inputs

This example shows how to validate that the first input is a numeric value.

methods (Access = protected)

   function validateInputsImpl(~,x)

      if ~isnumeric(x)

         error('Input must be numeric');

      end

   end
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end        

Complete Class Definition File with Property and Input Validation

classdef AddOne < matlab.System

% ADDONE Compute an output value by incrementing the input value

  

  % All properties occur inside a properties declaration.

  % These properties have public access (the default)

  properties (Logical)

    UseIncrement = true

  end

  properties (PositiveInteger)

    Increment = 1

    WrapValue = 10

  end

  methods

    % Validate the properties of the object

    function set.Increment(obj,val)

        if val >= 10

          error('The increment value must be less than 10');

        end

        obj.Increment = val;

    end

  end

  

  methods (Access = protected)

    function validatePropertiesImpl(obj)

        if obj.UseIncrement && obj.WrapValue > obj.Increment

          error('Wrap value must be less than increment value');

        end

    end

    

    % Validate the inputs to the object

    function validateInputsImpl(~,x)

        if ~isnumeric(x)

          error('Input must be numeric');

        end

    end

        

    function out = stepImpl(obj,in)

      if obj.UseIncrement

        out = in + obj.Increment;
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      else

        out = in + 1;

      end

    end    

  end

end

Note: All inputs default to variable-size inputs. See “Change Input Complexity or
Dimensions” for more information.

See Also
validateInputsImpl | validatePropertiesImpl

Related Examples
• “Define Basic System Objects” on page 12-5

More About
• “Methods Timing” on page 12-83
• “Property Set Methods”
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Initialize Properties and Setup One-Time Calculations

This example shows how to write code to initialize and set up a System object.

In this example, you allocate file resources by opening the file so the System object can
write to that file. You do these initialization tasks one time during setup, rather than
every time you call the step method.

Define Public Properties to Initialize

In this example, you define the public Filename property and specify the value of that
property as the nontunable string, default.bin. Users cannot change nontunable
properties after the setup method has been called. Refer to the Methods Timing section
for more information.

properties (Nontunable)

  Filename = 'default.bin'

end

Define Private Properties to Initialize

Users cannot access private properties directly, but only through methods of the System
object. In this example, you define the pFileID property as a private property. You also
define this property as hidden to indicate it is an internal property that never displays to
the user.

properties (Hidden,Access = private)

  pFileID;

end

Define Setup

You use the setupImpl method to perform setup and initialization tasks. You should
include code in the setupImpl method that you want to execute one time only. The
setupImpl method is called once during the first call to the step method. In this
example, you allocate file resources by opening the file for writing binary data.

methods

  function setupImpl(obj)

    obj.pFileID = fopen(obj.Filename,'wb');

    if obj.pFileID < 0

       error('Opening the file failed');
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    end

  end

end

Although not part of setup, you should close files when your code is done using them. You
use the releaseImpl method to release resources.

Complete Class Definition File with Initialization and Setup

classdef MyFile < matlab.System

% MyFile write numbers to a file

    % These properties are nontunable. They cannot be changed

    % after the setup or step  method has been called.

    properties (Nontunable)

        Filename = 'default.bin' % the name of the file to create

    end

    % These properties are private. Customers can only access

    % these properties through methods on this object

    properties (Hidden,Access = private)

        pFileID; % The identifier of the file to open

    end

    methods (Access = protected)

        % In setup allocate any resources, which in this case

        % means opening the file.

        function setupImpl(obj)

            obj.pFileID = fopen(obj.Filename,'wb');

            if obj.pFileID < 0

                error('Opening the file failed');

            end

        end

        % This System object™ writes the input to the file.

        function stepImpl(obj,data)

            fwrite(obj.pFileID,data);

        end

        % Use release to close the file to prevent the

        % file handle from being left open.

        function releaseImpl(obj)

            fclose(obj.pFileID);

        end

    end
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end

See Also
releaseImpl | setupImpl | stepImpl

Related Examples
• “Release System Object Resources” on page 12-34
• “Define Property Attributes” on page 12-23

More About
• “Methods Timing” on page 12-83



 Set Property Values at Construction Time

12-19

Set Property Values at Construction Time

This example shows how to define a System object constructor and allow it to accept
name-value property pairs as input.

Set Properties to Use Name-Value Pair Input

Define the System object constructor, which is a method that has the same name as
the class (MyFile in this example). Within that method, you use the setProperties
method to make all public properties available for input when the user constructs the
object. nargin is a MATLAB function that determines the number of input arguments.
varargin indicates all of the object’s public properties.

methods 

   function obj = MyFile(varargin)

      setProperties(obj,nargin,varargin{:});

   end

end

Complete Class Definition File with Constructor Setup

classdef MyFile < matlab.System

% MyFile write numbers to a file

    % These properties are nontunable. They cannot be changed

    % after the setup or step method has been called.

    properties (Nontunable)

        Filename ='default.bin' % the name of the file to create

        Access = 'wb' % The file access string (write, binary)

    end

    % These properties are private. Customers can only access

    % these properties through methods on this object

    properties (Hidden,Access = private)

        pFileID; % The identifier of the file to open

    end

    methods 

        % You call setProperties in the constructor to let 

        % a user specify public properties of object as 

        % name-value pairs.

        function obj = MyFile(varargin)

          setProperties(obj,nargin,varargin{:});

        end



12 Define New System Objects

12-20

    end

    methods (Access = protected)

        % In setup allocate any resources, which in this case is

        % opening the file.

        function setupImpl(obj)

            obj.pFileID = fopen(obj.Filename,obj.Access);

            if obj.pFileID < 0

                error('Opening the file failed');

            end

        end

        % This System object™ writes the input to the file.

        function stepImpl(obj,data)

            fwrite(obj.pFileID,data);

        end

        % Use release to close the file to prevent the

        % file handle from being left open.

        function releaseImpl(obj)

            fclose(obj.pFileID);

        end

    end

end

See Also
nargin | setProperties

Related Examples
• “Define Property Attributes” on page 12-23
• “Release System Object Resources” on page 12-34
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Reset Algorithm State

This example shows how to reset an object state.

Reset Counter to Zero

pCount is an internal counter property of the System object obj. The user calls the
reset method on the locked object, which calls the resetImpl method. In this example ,
pCount resets to 0.

Note: When resetting an object’s state, make sure you reset the size, complexity, and
data type correctly.

methods (Access = protected)

   function resetImpl(obj)

      obj.pCount = 0; 

   end

end 

Complete Class Definition File with State Reset

classdef Counter < matlab.System

% Counter System object™ that increments a counter

   properties (Access = private)

      pCount

   end

   

   methods (Access = protected)

      % In step, increment the counter and return 

      % its value as an output

      function c = stepImpl(obj)

          obj.pCount = obj.pCount + 1;

          c = obj.pCount;

      end

      % Reset the counter to zero.

      function resetImpl(obj)

         obj.pCount = 0; 

      end

   end 
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end

See “Methods Timing” on page 12-83 for more information.

See Also
resetImpl

More About
• “Methods Timing” on page 12-83
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Define Property Attributes

This example shows how to specify property attributes.

Property attributes, which add details to a property, provide a layer of control to your
properties. In addition to the MATLAB property attributes, System objects can use these
three additional attributes—nontunable, logical, and positiveInteger. To specify
multiple attributes, separate them with commas.

Specify Property as Nontunable

Use the nontunable attribute for a property when the algorithm depends on the value
being constant once data processing starts. Defining a property as nontunable may
improve the efficiency of your algorithm by removing the need to check for or react to
values that change. For code generation, defining a property as nontunable allows the
memory associated with that property to be optimized. You should define all properties
that affect the number of input or output ports as nontunable.

System object users cannot change nontunable properties after the setup or step
method has been called. In this example, you define the InitialValue property, and set
its value to 0.

properties (Nontunable)

   InitialValue = 0;

end

Specify Property as Logical

Logical properties have the value, true or false. System object users can enter 1 or
0 or any value that can be converted to a logical. The value, however, displays as true
or false. You can use sparse logical values, but they must be scalar values. In this
example, the Increment property indicates whether to increase the counter. By default,
Increment is tunable property. The following restrictions apply to a property with the
Logical attribute,

• Cannot also be Dependent or PositiveInteger
• Default value must be true or false. You cannot use 1 or 0 as a default value.

properties (Logical)

   Increment = true 

end
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Specify Property as Positive Integer

In this example, the private property MaxValue is constrained to accept only real,
positive integers. You cannot use sparse values. The following restriction applies to a
property with the PositiveInteger attribute,

• Cannot also be Dependent or Logical

properties (PositiveInteger)

   MaxValue

end

         

Specify Property as DiscreteState

If your algorithm uses properties that hold state, you can assign those properties the
DiscreteState attribute . Properties with this attribute display their state values
when users call getDiscreteStateImpl via the getDiscreteState method. The
following restrictions apply to a property with the DiscreteState attribute,

• Numeric, logical, or fi value, but not a scaled double fi value
• Does not have any of these attributes: Nontunable, Dependent, Abstract,

Constant, or Transient.
• No default value
• Not publicly settable
• GetAccess = Public by default
• Value set only using the setupImpl method or when the System object is locked

during resetImpl or stepImpl

In this example, you define the Count property.

properties (DiscreteState)

   Count;

end

Complete Class Definition File with Property Attributes

classdef Counter < matlab.System

% Counter Increment a counter to a maximum value

  % These properties are nontunable. They cannot be changed 

  % after the setup or step method has been called.

  properties (Nontunable)
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      % The inital value of the counter

      InitialValue = 0

  end

  properties (Nontunable, PositiveInteger)

      % The maximum value of the counter

      MaxValue = 3

  end

  

  properties (Logical)

      % Whether to increment the counter

      Increment = true

  end

   

  properties (DiscreteState)

      % Count state variable

      Count

  end

      

  methods (Access = protected)

      % In step, increment the counter and return its value

      % as an output

  

      function c = stepImpl(obj)

          if obj.Increment && (obj.Count < obj.MaxValue)

              obj.Count = obj.Count + 1;

          else

              disp(['Max count, ' num2str(obj.MaxValue) ',reached'])            

          end

          c = obj.Count;

      end

      

      % Setup the Count state variable

      function setupImpl(obj)

          obj.Count = 0;

      end

      

      % Reset the counter to one.

      function resetImpl(obj)

          obj.Count = obj.InitialValue;

      end

  end
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end

More About
• “Class Attributes”
• “Property Attributes”
• “What You Cannot Change While Your System Is Running”
• “Methods Timing” on page 12-83
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Hide Inactive Properties

This example shows how to hide the display of a property that is not active for a
particular object configuration.

Hide an inactive property

You use the isInactivePropertyImpl method to hide a property from displaying. If
the isInactiveProperty method returns true to the property you pass in, then that
property does not display.

methods (Access = protected)

  function flag = isInactivePropertyImpl(obj,propertyName)

    if strcmp(propertyName,'InitialValue')

      flag = obj.UseRandomInitialValue;

    else

      flag = false;

    end

  end

end

Complete Class Definition File with Hidden Inactive Property

classdef Counter < matlab.System

  % Counter Increment a counter

  

  % These properties are nontunable. They cannot be changed

  % after the setup or step method has been called.

  properties (Nontunable)

    % Allow the user to set the initial value

    UseRandomInitialValue = true

    InitialValue = 0

  end

  

  % The private count variable, which is tunable by default

  properties (Access = private)

    pCount

  end

  

  methods (Access = protected)

    % In step, increment the counter and return its value 

    % as an output

    function c = stepImpl(obj)

      obj.pCount = obj.pCount + 1;
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      c = obj.pCount;

    end

    % Reset the counter to either a random value or the initial

    % value.

    function resetImpl(obj)

      if obj.UseRandomInitialValue

        obj.pCount = rand();

      else

        obj.pCount = obj.InitialValue;

      end

    end

    % This method controls visibility of the object's properties

    function flag = isInactivePropertyImpl(obj,propertyName)

      if strcmp(propertyName,'InitialValue')

        flag = obj.UseRandomInitialValue;

      else

        flag = false;

      end

    end

  end

end

See Also
isInactivePropertyImpl
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Limit Property Values to Finite String Set

This example shows how to limit a property to accept only a finite set of string values.

Specify a Set of Valid String Values

String sets use two related properties. You first specify the user-visible property name
and default string value. Then, you specify the associated hidden property by appending
“Set” to the property name. You must use a capital “S” in “Set.”

In the “Set” property, you specify the valid string values as a cell array of the
matlab.system.Stringset class. This example uses Color and ColorSet as the
associated properties.

properties

   Color = 'blue'

end

properties (Hidden,Transient)

   ColorSet = matlab.system.StringSet({'red','blue','green'});

end

Complete Class Definition File with String Set

classdef Whiteboard < matlab.System

% Whiteboard Draw lines on a figure window

%

% This System object™ illustrates the use of StringSets

   properties

     Color = 'blue'

   end

    

   properties (Hidden,Transient)

     % Let them choose a color

     ColorSet = matlab.system.StringSet({'red','blue','green'});

   end

   methods (Access = protected)

     function stepImpl(obj)

         h = Whiteboard.getWhiteboard();

         plot(h, ...

           randn([2,1]),randn([2,1]), ...

           'Color',obj.Color(1));



12 Define New System Objects

12-30

     end

     function releaseImpl(obj)

         cla(Whiteboard.getWhiteboard());

         hold on

     end

   end

    

   methods (Static)

     function a = getWhiteboard()

         h = findobj('tag','whiteboard');

         if isempty(h)

           h = figure('tag','whiteboard');

           hold on

         end

         a = gca;

     end

   end

end

String Set System Object Example

%%

% Each call to step draws lines on a whiteboard

%% Construct the System object  

hGreenInk = Whiteboard;

hBlueInk  = Whiteboard;

% Change the color

% Note: Press tab after typing the first single quote to 

% display all enumerated values.

hGreenInk.Color = 'green';

hBlueInk.Color  = 'blue';

% Take a few steps

for i=1:3

  hGreenInk.step();

  hBlueInk.step();

end

%% Clear the whiteboard

hBlueInk.release();

%% Display System object used in this example
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type('Whiteboard.m');

See Also
matlab.system.StringSet
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Process Tuned Properties

This example shows how to specify the action to take when a tunable property value
changes during simulation.

The processTunedPropertiesImpl method is useful for managing actions to prevent
duplication. In many cases, changing one of multiple interdependent properties causes
an action. With the processTunedPropertiesImpl method, you can control when that
action is taken so it is not repeated unnecessarily.

Control When a Lookup Table Is Generated

This example of processTunedPropertiesImpl causes the pLookupTable to be
regenerated when either the NumNotes or MiddleC property changes.

methods  (Access = protected)

   function processTunedPropertiesImpl(obj)

      propChange = isChangedProperty(obj,obj.NumNotes)||...

         isChangedProperty(obj,obj.MiddleC)

      if propChange

         obj.pLookupTable = obj.MiddleC *...

           (1+log(1:obj.NumNotes)/log(12));

      end

    endend

Complete Class Definition File with Tuned Property Processing

classdef TuningFork < matlab.System

  % TuningFork Illustrate the processing of tuned parameters

  %

  

  properties

    MiddleC = 440

    NumNotes = 12

  end

  

  properties (Access = private)

    pLookupTable

  end

  

  methods (Access = protected)

    function resetImpl(obj)

      obj.MiddleC = 440;

      obj.pLookupTable = obj.MiddleC * ...
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         (1+log(1:obj.NumNotes)/log(12));

    end

    

    function hz = stepImpl(obj,noteShift)

      % A noteShift value of 1 corresponds to obj.MiddleC

      hz = obj.pLookupTable(noteShift);

    end

    

    function processTunedPropertiesImpl(obj)

      propChange = isChangedProperty(obj,obj.NumNotes)||...

         isChangedProperty(obj,obj.MiddleC)

      if propChange

         obj.pLookupTable = obj.MiddleC *...

           (1+log(1:obj.NumNotes)/log(12));

      end

  end

end

See Also
processTunedPropertiesImpl
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Release System Object Resources

This example shows how to release resources allocated and used by the System object.
These resources include allocated memory, files used for reading or writing, etc.

Release Memory by Clearing the Object

This method allows you to clear the axes on the Whiteboard figure window while keeping
the figure open.

methods

   function releaseImpl(obj)

      cla(Whiteboard.getWhiteboard());

      hold on

   end

end

Complete Class Definition File with Released Resources

classdef Whiteboard < matlab.System

% Whiteboard Draw lines on a figure window

%

% This System object™ shows the use of StringSets

%

   properties

     Color = 'blue'

   end

   properties (Hidden)

     % Let user choose a color

     ColorSet = matlab.system.StringSet({'red','blue','green'});

   end

   methods (Access = protected)

     function stepImpl(obj)

         h = Whiteboard.getWhiteboard();

         plot(h, ...

           randn([2,1]), randn([2,1]), ...

           'Color',obj.Color(1));

     end

     function releaseImpl(obj)

         cla(Whiteboard.getWhiteboard());

         hold on
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     end

   end

   methods (Static)

     function a = getWhiteboard()

         h = findobj('tag','whiteboard');

         if isempty(h)

           h = figure('tag','whiteboard');

           hold on

         end

         a = gca;

     end

   end

end

See Also
releaseImpl

Related Examples
• “Initialize Properties and Setup One-Time Calculations” on page 12-16
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Define Composite System Objects

This example shows how to define System objects that include other System objects.

This example defines a filter System object from an FIR System object and an IIR System
object.

Store System Objects in Properties

To define a System object from other System objects, store those objects in your class
definition file as properties. In this example, FIR and IIR are separate System objects
defined in their own class-definition files. You use those two objects to calculate the pFir
and pIir property values.

properties (Nontunable, Access = private)

   pFir % Store the FIR filter

   pIir % Store the IIR filter

end

    

methods

   function obj = Filter(varargin)

      setProperties(obj,nargin,varargin{:});

      obj.pFir = FIR(obj.zero);

      obj.pIir = IIR(obj.pole);

   end

end

Complete Class Definition File of Composite System Object

classdef Filter < matlab.System

% Filter System object with a single pole and a single zero

%

% This System object illustrates composition by 

% composing an instance of itself.

%

    properties (Nontunable)

      zero = 0.01

      pole = 0.5

    end

    

    properties (Nontunable,Access = private)

      pZero % Store the FIR filter

      pPole % Store the IIR filter
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    end

    

    methods

        function obj = Filter(varargin)

            setProperties(obj,nargin,varargin{:});

            % Create instances of FIR and IIR as 

            % private properties

            obj.pZero = Zero(obj.zero);

            obj.pPole = Pole(obj.pole);

        end

    end

    

    methods (Access = protected)

        function setupImpl(obj,x)

            setup(obj.pZero,x);

            setup(obj.pPole,x);

        end

        function resetImpl(obj)

            reset(obj.pZero);

            reset(obj.pPole);

        end

        function y = stepImpl(obj,x)

            y = step(obj.pZero,x) + step(obj.pPole,x);

        end

        function releaseImpl(obj)

            release(obj.pZero);

            release(obj.pPole);

        end

    end    

end

Class Definition File for IIR Component of Filter

classdef Pole < matlab.System

   

  properties

    Den = 1

  end

  

  properties (Access = private)

    tap = 0

  end
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  methods

    function obj = Pole(varargin)

      setProperties(obj,nargin,varargin{:},'Den');

    end

  end

  

  methods (Access = protected)

    function y = stepImpl(obj,x)

      y = x + obj.tap * obj.Den;

      obj.tap = y;

    end

  end

  

end

Class Definition File for FIR Component of Filter

classdef Zero < matlab.System

  

  properties

    Num = 1

  end

  

  properties (Access = private)

    tap = 0

  end

  

  methods

    function obj = Zero(varargin)

      setProperties(obj,nargin,varargin{:},'Num');

    end

  end

  

  methods (Access = protected)

    function y = stepImpl(obj,x)

      y = x + obj.tap * obj.Num;

      obj.tap = x;

    end

  end

  

end

See Also
nargin
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Define Finite Source Objects

This example shows how to define a System object that performs a specific number of
steps or specific number of reads from a file.

Use the FiniteSource Class and Specify End of the Source

1 Subclass from finite source class.

 classdef RunTwice < matlab.System & ...

    matlab.system.mixin.FiniteSource

2 Specify the end of the source with the isDoneImpl method. In this example, the
source has two iterations.

 methods (Access = protected)

   function bDone = isDoneImpl(obj)

      bDone = obj.NumSteps==2

   end

Complete Class Definition File with Finite Source

classdef RunTwice < matlab.System & ...

    matlab.system.mixin.FiniteSource

  % RunTwice System object that runs exactly two times

  %  

  properties (Access = private)

    NumSteps

  end

  

  methods (Access = protected)

    function resetImpl(obj)

      obj.NumSteps = 0;

    end

    function y = stepImpl(obj)

      if ~obj.isDone()

        obj.NumSteps = obj.NumSteps + 1;

        y = obj.NumSteps;

      else

        y = 0;

      end

    end

    function bDone = isDoneImpl(obj)
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      bDone = obj.NumSteps==2;

    end

  end

end

See Also
matlab.system.mixin.FiniteSource

More About
• “What Are Mixin Classes?” on page 12-87
• “Subclassing Multiple Classes”
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Save System Object

This example shows how to save a System object.

Save System Object and Child Object

Define a saveObjectImpl method to specify that more than just public properties
should be saved when the user saves a System object. Within this method, use the
default saveObjectImpl@matlab.System to save public properties to the struct,
s. Use the saveObject method to save child objects. Save protected and dependent
properties, and finally, if the object is locked, save the object’s state.

methods (Access = protected)

  function s = saveObjectImpl(obj)      

    s = saveObjectImpl@matlab.System(obj);

    s.child = matlab.System.saveObject(obj.child);

    s.protectedprop = obj.protectedprop;

    s.pdependentprop = obj.pdependentprop;

    if isLocked(obj)

      s.state = obj.state;

    end

  end

end

Complete Class Definition Files with Save and Load

The Counter class definition file sets up an object with a count property. This counter is
used in the MySaveLoader class definition file to count the number of child objects.

classdef Counter < matlab.System

  properties(DiscreteState)

    Count

  end

  methods (Access=protected)

    function setupImpl(obj, ~)

      obj.Count = 0;

    end

    function y = stepImpl(obj, u)

      if u > 0

        obj.Count = obj.Count + 1;

      end

      y = obj.Count;

    end
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  end

end

classdef MySaveLoader < matlab.System

 

  properties (Access = private)

    child

    pdependentprop = 1

  end

  

  properties (Access = protected)

    protectedprop = rand;

  end

  

  properties (DiscreteState = true)

    state

  end

  

  properties (Dependent)

    dependentprop

  end

      

  methods

    function obj = MySaveLoader(varargin)

      obj@matlab.System();

      setProperties(obj,nargin,varargin{:});

    end

    

    function set.dependentprop(obj, value)

      obj.pdependentprop = min(value, 5);

    end

    

    function value = get.dependentprop(obj)

      value = obj.pdependentprop;

    end

  end

  

  methods (Access = protected)

    function setupImpl(obj)

      obj.state = 42;

      obj.child = Counter;

    end

    function out = stepImpl(obj,in)

      obj.state = in + obj.state + obj.protectedprop + obj.pdependentprop;

      out = step(obj.child, obj.state);
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    end

  end

  

  % Serialization

  methods (Access = protected)

    function s = saveObjectImpl(obj)      

      % Call the base class method

      s = saveObjectImpl@matlab.System(obj);

      

      % Save the child System objects

      s.child = matlab.System.saveObject(obj.child);

      

      % Save the protected & private properties

      s.protectedprop = obj.protectedprop;

      s.pdependentprop = obj.pdependentprop;

      

      % Save the state only if object locked

      if isLocked(obj)

        s.state = obj.state;

      end

    end

    

    function loadObjectImpl(obj,s,wasLocked)

      % Load child System objects

      obj.child = matlab.System.loadObject(s.child);

      % Load protected and private properties

      obj.protectedprop = s.protectedprop;

      obj.pdependentprop = s.pdependentprop;

      

      % Load the state only if object locked

      if wasLocked

        obj.state = s.state;

      end

      % Call base class method to load public properties

      loadObjectImpl@matlab.System(obj,s,wasLocked);

    end    

  end

end

See Also
loadObjectImpl | saveObjectImpl
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Related Examples
• “Load System Object” on page 12-45
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Load System Object

This example shows how to load and save a System object.

Load System Object and Child Object

Define a loadObjectImpl method to load a previously saved System object. Within
this method, use the matlab.System.loadObject to load the child System object,
load protected and private properties, load the state if the object is locked, and use
loadObjectImpl from the base class to load public properties.

methods (Access = protected)

  function loadObjectImpl(obj,s,wasLocked)

    obj.child = matlab.System.loadObject(s.child);

    

    obj.protectedprop = s.protectedprop;

    obj.pdependentprop = s.pdependentprop;

    

    if wasLocked

      obj.state = s.state;

    end

    

    loadObjectImpl@matlab.System(obj,s,wasLocked);

  end    

end

Complete Class Definition Files with Save and Load

The Counter class definition file sets up an object with a count property. This counter is
used in the MySaveLoader class definition file to count the number of child objects.

classdef Counter < matlab.System

  properties(DiscreteState)

    Count

  end

  methods (Access=protected)

    function setupImpl(obj, ~)

      obj.Count = 0;

    end

    function y = stepImpl(obj, u)

      if u > 0

        obj.Count = obj.Count + 1;

      end

      y = obj.Count;
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    end

  end

end

classdef MySaveLoader < matlab.System

 

  properties (Access = private)

    child

    pdependentprop = 1

  end

  

  properties (Access = protected)

    protectedprop = rand;

  end

  

  properties (DiscreteState = true)

    state

  end

  

  properties (Dependent)

    dependentprop

  end

      

  methods

    function obj = MySaveLoader(varargin)

      obj@matlab.System();

      setProperties(obj,nargin,varargin{:});

    end

    

    function set.dependentprop(obj, value)

      obj.pdependentprop = min(value, 5);

    end

    

    function value = get.dependentprop(obj)

      value = obj.pdependentprop;

    end

  end

  

  methods (Access = protected)

    function setupImpl(obj)

      obj.state = 42;

      obj.child = Counter;

    end

    function out = stepImpl(obj,in)

      obj.state = in + obj.state + obj.protectedprop + obj.pdependentprop;
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      out = step(obj.child, obj.state);

    end

  end

  

  % Serialization

  methods (Access = protected)

    function s = saveObjectImpl(obj)      

      % Call the base class method

      s = saveObjectImpl@matlab.System(obj);

      

      % Save the child System objects

      s.child = matlab.System.saveObject(obj.child);

      

      % Save the protected & private properties

      s.protectedprop = obj.protectedprop;

      s.pdependentprop = obj.pdependentprop;

      

      % Save the state only if object locked

      if isLocked(obj)

        s.state = obj.state;

      end

    end

    

    function loadObjectImpl(obj,s,wasLocked)

      % Load child System objects

      obj.child = matlab.System.loadObject(s.child);

      % Load protected and private properties

      obj.protectedprop = s.protectedprop;

      obj.pdependentprop = s.pdependentprop;

      

      % Load the state only if object locked

      if wasLocked

        obj.state = s.state;

      end

      % Call base class method to load public properties

      loadObjectImpl@matlab.System(obj,s,wasLocked);

    end    

  end
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end

See Also
loadObjectImpl | saveObjectImpl

Related Examples
• “Save System Object” on page 12-41



 Clone System Object

12-49

Clone System Object

This example shows how to clone a System object.

Clone System Object

You can define your own clone method, which is useful for copying objects without saving
their state. The default cloneImpl method copies both a System object™ and its current
state. If an object is locked, the default cloneImpl creates a cloned object that is also
locked. An example of when you may want to write your own clone method is for cloning
objects that handle resources. These objects cannot allocate resources twice and you
would not want to save their states. To write your clone method, use the saveObject
and loadObject methods to perform the clone within the cloneImpl method.

methods (Access = protected)

   function obj2 = cloneImpl(obj1)

      s = saveObject (obj1);

      obj2 = loadObject(s);

   end

end

Complete Class Definition File with Clone

classdef PassThrough < matlab.System

  methods (Access = protected)

    function y = stepImpl(~,u)

        y = u;

    end

    function obj2 = cloneImpl(obj1)

        s = matlab.System.saveObject(obj1);

        obj2 = matlab.System.loadObject(s);

    end

  end

end

See Also
cloneImpl | loadObjectImpl | saveObjectImpl
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Define System Object Information

This example shows how to define information to display for a System object.

Define System Object Info

You can define your own info method to display specific information for your
System object. The default infoImpl method returns an empty struct. This
infoImpl method returns detailed information when the info method is called using
info(x,'details') or only count information if it is called using info(x).

methods (Access = protected)

   function s = infoImpl(obj,varargin)

      if nargin>1 && strcmp('details',varargin(1))

         s = struct('Name','Counter',...

             'Properties', struct('CurrentCount', ...

              obj.pCount,'Threshold',obj.Threshold));

      else

         s = struct('Count',obj.pCount);

      end

   end

end

Complete Class Definition File with InfoImpl

classdef Counter < matlab.System

   % Counter Count values above a threshold

   

   properties

      Threshold = 1

   end

   

   properties (DiscreteState)

      Count

   end

   

   methods (Access = protected)

      function setupImpl(obj)

         obj.Count = 0;

      end

       

      function resetImpl(obj)

         obj.Count = 0;

      end
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      function y = stepImpl(obj,u)

         if (u > obj.Threshold)

            obj.Count = obj.Count + 1;

         end

         y = obj.Count;

      end

     

      function s = infoImpl(obj,varargin)

         if nargin>1 && strcmp('details',varargin(1))

            s = struct('Name','Counter',...

            'Properties', struct('CurrentCount', ...

            obj.pCount,'Threshold',obj.Threshold));

         else

            s = struct('Count',obj.pCount);

      end

   end

end

See Also
infoImpl
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Define System Block Icon

This example shows how to define the block icon of a System object–based block
implemented using a MATLAB System block.

Use the CustomIcon Class and Define the Icon

1 Subclass from custom icon class.

 classdef MyCounter < matlab.System & ...

   matlab.system.mixin.CustomIcon

2 Use getIconImpl to specify the block icon as New Counter with a line break (\n)
between the two words.

methods (Access = protected)

   function icon = getIconImpl(~)

      icon = sprintf('New\nCounter');

   end

end

Complete Class Definition File with Defined Icon

classdef MyCounter < matlab.System & ...

   matlab.system.mixin.CustomIcon

  

   % MyCounter Count values above a threshold

     

    properties

       Threshold = 1

    end

    properties (DiscreteState)

       Count

    end

 

    methods

       function obj = MyCounter(varargin)

          setProperties(obj,nargin,varargin{:});

       end

    end

 

    methods (Access = protected)

       function setupImpl(obj)

          obj.Count = 0;

       end
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       function resetImpl(obj)

          obj.Count = 0;

       end

       function y = stepImpl(obj,u)

          if (u > obj.Threshold)

             obj.Count = obj.Count + 1;

          end

          y = obj.Count;

       end

       function icon = getIconImpl(~)

          icon = sprintf('New\nCounter');

       end

    end

end

See Also
matlab.system.mixin.CustomIcon | getIconImpl

More About
• “What Are Mixin Classes?” on page 12-87
• “Subclassing Multiple Classes”
• “System Object Input Arguments and ~ in Code Examples” on page 12-86



12 Define New System Objects

12-54

Add Header to System Block Dialog

This example shows how to add a header panel to a System object–based block
implemented using a MATLAB System block.

Define Header Title and Text

This example shows how to use getHeaderImpl to specify a panel title and text for the
MyCounter System object.

If you do not specify the getHeaderImpl, the block does not display any title or text for
the panel.

You always set the getHeaderImpl method access to protected because it is an
internal method that end users do not directly call or run.

methods (Static, Access = protected)

   function header = getHeaderImpl

      header = matlab.system.display.Header('MyCounter',...

        'Title','My Enhanced Counter');

   end

end

Complete Class Definition File with Defined Header

 classdef MyCounter < matlab.System

  

   % MyCounter Count values

     

    properties

       Threshold = 1

    end

    properties (DiscreteState)

       Count

    end

 

    methods (Static, Access = protected)

      function header = getHeaderImpl

         header = matlab.system.display.Header('MyCounter',...

           'Title','My Enhanced Counter',...

           'Text', 'This counter is an enhanced version.');

      end

    end
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    methods (Access = protected)

       function setupImpl(obj,u)

          obj.Count = 0;

       end

       function y = stepImpl(obj,u)

          if (u > obj.Threshold)

             obj.Count = obj.Count + 1;

          end

          y = obj.Count;

       end

       function resetImpl(obj)

          obj.Count = 0;

       end

    end

end

See Also
matlab.system.display.Header | getHeaderImpl
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Add Property Groups to System Object and Block Dialog

This example shows how to define property sections and section groups for System object
display. The sections and section groups display as panels and tabs, respectively, in the
MATLAB System block dialog.

Define Section of Properties

This example shows how to use matlab.system.display.Section and
getPropertyGroupsImpl to define two property group sections by specifying their
titles and property lists.

If you do not specify a property in getPropertyGroupsImpl, the block does not display
that property.

 methods (Static, Access = protected)

    function groups = getPropertyGroupsImpl

       valueGroup = matlab.system.display.Section(...

            'Title','Value parameters',...

            'PropertyList',{'StartValue','EndValue'});

 

       thresholdGroup = matlab.system.display.Section(...

            'Title','Threshold parameters',...

            'PropertyList',{'Threshold','UseThreshold'});

       groups = [valueGroup,thresholdGroup];

    end

 end

Define Group of Sections

This example shows how to use matlab.system.display.SectionGroup,
matlab.system.display.Section, and getPropertyGroupsImpl to define two
tabs, each containing specific properties.

methods (Static, Access = protected)

   function groups = getPropertyGroupsImpl

      upperGroup = matlab.system.display.Section(...

           'Title', 'Upper threshold', ...

           'PropertyList',{'UpperThreshold'});

      lowerGroup = matlab.system.display.Section(...

           'Title','Lower threshold', ...

           'PropertyList',{'UseLowerThreshold','LowerThreshold'});

           

      thresholdGroup = matlab.system.display.SectionGroup(...
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           'Title', 'Parameters', ...

           'Sections',  [upperGroup,lowerGroup]);

           

      valuesGroup = matlab.system.display.SectionGroup(...

           'Title', 'Initial conditions', ...

           'PropertyList',  {'StartValue'});

          

      groups = [thresholdGroup, valuesGroup];

   end

end

Complete Class Definition File with Property Group and Separate Tab

classdef EnhancedCounter < matlab.System 

   % EnhancedCounter  Count values considering thresholds

    

   properties

      UpperThreshold = 1;

      LowerThreshold = 0;

   end

   

   properties (Nontunable)

      StartValue = 0; 

   end

    

   properties(Logical,Nontunable)

      % Count values less than lower threshold

      UseLowerThreshold = true; 

   end

        

   properties (DiscreteState)

      Count;

   end

        

   methods (Static, Access = protected)

      function groups = getPropertyGroupsImpl

         upperGroup = matlab.system.display.Section(...

              'Title', 'Upper threshold', ...

              'PropertyList',{'UpperThreshold'});

         lowerGroup = matlab.system.display.Section(...

              'Title','Lower threshold', ...

              'PropertyList',{'UseLowerThreshold','LowerThreshold'});

           

         thresholdGroup = matlab.system.display.SectionGroup(...

              'Title', 'Parameters', ...
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              'Sections',  [upperGroup,lowerGroup]);

           

         valuesGroup = matlab.system.display.SectionGroup(...

              'Title', 'Initial conditions', ...

              'PropertyList',  {'StartValue'});

           

         groups = [thresholdGroup, valuesGroup];

      end

   end

    

   methods (Access = protected)

      function setupImpl(obj)

         obj.Count = obj.StartValue;

      end

        

      function y = stepImpl(obj,u)

         if obj.UseLowerThreshold

            if (u > obj.UpperThreshold) || ...

                  (u <  obj.LowerThreshold)

               obj.Count = obj.Count + 1;

            end

         else

            if (u > obj.UpperThreshold)

               obj.Count = obj.Count + 1;

            end

         end

         y = obj.Count;

      end

      function resetImpl(obj)

         obj.Count = obj.StartValue;

      end

        

               

      function flag = isInactivePropertyImpl(obj, prop)

         flag = false;

         switch prop

            case 'LowerThreshold'

               flag = ~obj.UseLowerThreshold;

         end

      end

   end
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end
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See Also
matlab.system.display.Section | matlab.system.display.SectionGroup |
getPropertyGroupsImpl

More About
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Control Simulation Type in System Block Dialog

This example shows how to specify a simulation type and whether theSimulate using
parameter appears on the Simulink MATLAB System block dialog box. The simulation
options are 'Code generation' and 'Interpreted mode'.

If you do not include the getSimulateUsingImpl method in your class definition file,
the System object allows both simulation modes and defaults to 'Code generation'.
If you do not include the showSimulateUsingImpl method, the Simulate using
parameter appears on the block dialog box.

You must set the getSimulateUsingImpl and showSimulateUsingImpl methods to
static and the access for these methods to protected.

Use getSimulateUsingImpl to specify that only interpreted execution is allowed for
the System object.

methods(Static,Access = protected)

   function simMode = getSimulateUsingImpl

       simMode = 'Interpreted execution';

    end

end

View the method in the complete class definition file.

classdef PlotRamp < matlab.System

  % Display a button to launch a plot figure.

        

  properties (Nontunable)

    RampLimit = 10;

  end

    

  methods(Static, Access=protected)

    function group = getPropertyGroupsImpl

      group = matlab.system.display.Section(mfilename('class'));

      group.Actions = matlab.system.display.Action(@(~,obj)...

            visualize(obj),'Label','Visualize');

    end

    function simMode = getSimulateUsingImpl

      simMode = 'Interpreted execution';

    end

  end
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  methods

    function obj = ActionDemo(varargin)

      setProperties(obj,nargin,varargin{:});

    end

        

    function visualize(obj)

      figure;

      d = 1:obj.RampLimit;

      plot(d);

    end

   methods(Static,Access = protected)

   end

  end

end

See Also
getSimulateUsingImp | showSimulateUsingImpl

More About
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Add Button to System Block Dialog Box

This example shows how to add a button to the MATLAB System block dialog box. This
button launches a figure that plots a ramp function.

Define Action for Dialog Button

This example shows how to use matlab.system.display.Action to define the
MATLAB function or code associated with a button in the MATLAB System block dialog.
The example also shows how to set button options.

methods(Static,Access = protected)

  function group = getPropertyGroupsImpl

  group = matlab.system.display.Section(mfilename('class'));

  group.Actions = matlab.system.display.Action(@(~,obj)...

       visualize(obj),'Label','Visualize');

  end

end

    

methods

  function obj = ActionDemo(varargin)

    setProperties(obj,nargin,varargin{:});

  end

        

  function visualize(obj)

    figure;

    d = 1:obj.RampLimit;

    plot(d);

  end

end

Complete Class Definition File for Dialog Button

Define a property group and a second tab in the class definition file.

classdef PlotRamp < matlab.System

  % Display a button to launch a plot figure.

        

  properties (Nontunable)

    RampLimit = 10;

  end

    

  methods(Static, Access=protected)
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    function group = getPropertyGroupsImpl

    group = matlab.system.display.Section(mfilename('class'));

    group.Actions = matlab.system.display.Action(@(~,obj)...

            visualize(obj),'Label','Visualize');

    end

  end

    

  methods

    function obj = ActionDemo(varargin)

      setProperties(obj,nargin,varargin{:});

    end

        

    function visualize(obj)

      figure;

      d = 1:obj.RampLimit;

      plot(d);

    end

  end

end

See Also
getPropertyGroupsImpl
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More About
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Specify Locked Input Size

This example shows how to specify whether the size of a System object input is locked.
The size of a locked input cannot change until the System object is unlocked. Use the
step method and run the object to lock it. Use release to unlock the object.

For information on locking and unlocking, see “What You Cannot Change While Your
System Is Running”.

Use the isInputSizeLockedImpl method to specify that the input size is locked.

methods (Access = protected)

  function flag = isInputSizeLockedImpl(~,~)

    flag = true;

  end

end

View the method in the complete class definition file.

classdef Counter < matlab.System 

  %Counter Count values above a threshold

 

  properties

    Threshold = 1

  end

  

  properties (DiscreteState)

    Count

  end

  

  methods

    function obj = Counter(varargin)

      setProperties(obj,nargin,varargin{:});

    end

  end

  

  methods (Access=protected)

    function resetImpl(obj)

      obj.Count = 0;

    end

    

    function y = stepImpl(obj, u1)

      if (any(u1 >= obj.Threshold))

        obj.Count = obj.Count + 1;
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      end

      y = obj.Count;

    end

    

    function flag = isInputSizeLockedImpl(~,~)

      flag = true;

    end

  end

end

See Also
isInputSizeLockedImpl
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Set Output Size

This example shows how to specify the size of a System object output using the
getOutputSizeImpl method. Use this method when Simulink cannot infer the output
size from the inputs during model compilation.

Subclass from both the matlab.System base class and the Propagates mixin class.

 classdef CounterReset < matlab.System & ...

     matlab.system.mixin.Propagates

Use the getOutputSizeImpl method to specify the output size.

methods (Access = protected)

   function sizeout = getOutputSizeImpl(~)

      sizeout = [1 1];

   end

end

View the method in the complete class definition file.

classdef CounterReset < matlab.System & matlab.system.mixin.Propagates

   % CounterReset Count values above a threshold

    

   properties

      Threshold = 1

   end

  

   properties (DiscreteState)

      Count

   end

  

   methods (Access = protected)

      function setupImpl(obj)

         obj.Count = 0;

      end

    

      function y = stepImpl(obj,u1,u2)

         % Add to count if u1 is above threshold

         % Reset if u2 is true

         if (u2)

            obj.Count = 0;

         elseif (u1 > obj.Threshold)

            obj.Count = obj.Count + 1;
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         end

         y = obj.Count;

      end

    

      function resetImpl(obj)

         obj.Count = 0;

      end

    

      function [sz,dt,cp] = getDiscreteStateSpecificationImpl(~,name)

         if strcmp(name,'Count')

            sz = [1 1];

            dt = 'double';

            cp = false;

         else

            error(['Error: Incorrect State Name: 'name'.']);

         end

      end

      function dataout = getOutputDataTypeImpl(~)

         dataout = 'double';

      end

      function sizeout = getOutputSizeImpl(~)

         sizeout = [1 1];

      end

      function cplxout = isOutputComplexImpl(~)

         cplxout = false;

      end

      function fixedout = isOutputFixedSizeImpl(~)

         fixedout = true;

      end

   end

end

See Also
matlab.system.mixin.Propagates | getOutputSizeImpl

More About
• “What Are Mixin Classes?” on page 12-87
• “Subclassing Multiple Classes”
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Set Output Data Type

This example shows how to specify the data type of a System object output using the
getOutputDataTypeImpl method. Use this method when Simulink cannot infer the
data type from the inputs during model compilation.

Subclass from both the matlab.System base class and the Propagates mixin class.

 classdef CounterReset < matlab.System & ...

     matlab.system.mixin.Propagates

Use the getOutputDataTypeImpl method to specify the output data type as a double.

methods (Access = protected)

   function dataout = getOutputDataTypeImpl(~)

      dataout = 'double';

   end

end

View the method in the complete class definition file.

classdef CounterReset < matlab.System & matlab.system.mixin.Propagates

   % CounterReset Count values above a threshold

    

   properties

      Threshold = 1

   end

  

   properties (DiscreteState)

      Count

   end

  

   methods (Access = protected)

      function setupImpl(obj)

         obj.Count = 0;

      end

    

      function resetImpl(obj)

         obj.Count = 0;

      end

    

      function y = stepImpl(obj,u1,u2)

         % Add to count if u1 is above threshold

         % Reset if u2 is true
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         if (u2)

            obj.Count = 0;

         elseif (u1 > obj.Threshold)

            obj.Count = obj.Count + 1;

         end

         y = obj.Count;

      end

    

      function [sz,dt,cp] = getDiscreteStateSpecificationImpl(~,name)

         if strcmp(name,'Count')

            sz = [1 1];

            dt = 'double';

            cp = false;

         else

            error(['Error: Incorrect State Name: 'name'.']);

         end

      end

      function dataout = getOutputDataTypeImpl(~)

         dataout = 'double';

      end

      function sizeout = getOutputSizeImpl(~)

         sizeout = [1 1];

      end

      function cplxout = isOutputComplexImpl(~)

         cplxout = false;

      end

      function fixedout = isOutputFixedSizeImpl(~)

         fixedout = true;

      end

   end

end

See Also
matlab.system.mixin.Propagates | getOutputDataTypeImpl

More About
• “What Are Mixin Classes?” on page 12-87
• “Subclassing Multiple Classes”
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Set Output Complexity

This example shows how to specify whether a System object output is complex or real
using the isOutputComplexImpl method. Use this method when Simulink cannot infer
the output complexity from the inputs during model compilation.

Subclass from both the matlab.System base class and the Propagates mixin class.

 classdef CounterReset < matlab.System & ...

     matlab.system.mixin.Propagates

Use the isOutputComplexImpl method to specify that the output is real.

methods (Access = protected)

   function cplxout = isOutputComplexImpl(~)

      cplxout = false;

   end

end

View the method in the complete class definition file.

classdef CounterReset < matlab.System & matlab.system.mixin.Propagates

   % CounterReset Count values above a threshold

    

   properties

      Threshold = 1

   end

  

   properties (DiscreteState)

      Count

   end

  

   methods (Access = protected)

      function setupImpl(obj)

         obj.Count = 0;

      end

    

      function resetImpl(obj)

         obj.Count = 0;

      end

    

      function y = stepImpl(obj,u1,u2)

         % Add to count if u1 is above threshold

         % Reset if u2 is true
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         if (u2)

            obj.Count = 0;

         elseif (u1 > obj.Threshold)

            obj.Count = obj.Count + 1;

         end

         y = obj.Count;

      end

    

      function [sz,dt,cp] = getDiscreteStateSpecificationImpl(~,name)

         if strcmp(name,'Count')

            sz = [1 1];

            dt = 'double';

            cp = false;

         else

            error(['Error: Incorrect State Name: 'name'.']);

         end

      end

      function dataout = getOutputDataTypeImpl(~)

         dataout = 'double';

      end

      function sizeout = getOutputSizeImpl(~)

         sizeout = [1 1];

      end

      function cplxout = isOutputComplexImpl(~)

         cplxout = false;

      end

      function fixedout = isOutputFixedSizeImpl(~)

         fixedout = true;

      end

   end

end

See Also
matlab.system.mixin.Propagates | isOutputComplexImpl

More About
• “What Are Mixin Classes?” on page 12-87
• “Subclassing Multiple Classes”
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Specify Whether Output Is Fixed- or Variable-Size

This example shows how to specify whether a System object output is fixed- or variable-
size. Use the isOutputFixedSizeImpl method when Simulink cannot infer the output
type from the inputs during model compilation.

Subclass from both the matlab.System base class and the Propagates mixin class.

 classdef CounterReset < matlab.System & ...

     matlab.system.mixin.Propagates

Use the isOutputFixedSizeImpl method to specify that the output is fixed size.

methods (Access = protected)

   function fixedout = isOutputFixedSizeImpl(~)

      fixedout = true;

   end

end

View the method in the complete class definition file.

classdef CounterReset < matlab.System & matlab.system.mixin.Propagates

   % CounterReset Count values above a threshold

    

   properties

      Threshold = 1

   end

  

   properties (DiscreteState)

      Count

   end

  

   methods (Access = protected)

      function setupImpl(obj)

         obj.Count = 0;

      end

    

      function resetImpl(obj)

         obj.Count = 0;

      end

    

      function y = stepImpl(obj,u1,u2)

         % Add to count if u1 is above threshold

         % Reset if u2 is true
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         if (u2)

            obj.Count = 0;

         elseif (u1 > obj.Threshold)

            obj.Count = obj.Count + 1;

         end

         y = obj.Count;

      end

    

      function [sz,dt,cp] = getDiscreteStateSpecificationImpl(~,name)

         if strcmp(name,'Count')

            sz = [1 1];

            dt = 'double';

            cp = false;

         else

            error(['Error: Incorrect State Name: 'name'.']);

         end

      end

      function dataout = getOutputDataTypeImpl(~)

         dataout = 'double';

      end

      function sizeout = getOutputSizeImpl(~)

         sizeout = [1 1];

      end

      function cplxout = isOutputComplexImpl(~)

         cplxout = false;

      end

      function fixedout = isOutputFixedSizeImpl(~)

         fixedout = true;

      end

   end

end

See Also
matlab.system.mixin.Propagates | isOutputFixedSizeImpl

More About
• “What Are Mixin Classes?” on page 12-87
• “Subclassing Multiple Classes”
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Specify Discrete State Output Specification

This example shows how to specify the size, data type, and complexity of a discrete
state property using the getDiscreteStateSpecificationImpl method. Use this
method when your System object has a property with the DiscreteState attribute and
Simulink cannot infer the output specifications during model compilation.

Subclass from both the matlab.System base class and from the Propagates mixin
class.

 classdef CounterReset < matlab.System & ...

     matlab.system.mixin.Propagates

Use the getDiscreteStateSpecificationImpl method to specify the size and data
type. Also specify the complexity of a discrete state property, which is used in the counter
reset example.

methods (Access = protected)

   function [sz,dt,cp] = getDiscreteStateSpecificationImpl(~,name)

      sz = [1 1];

      dt = 'double';

      cp = false;

   end

end

View the method in the complete class definition file.

classdef CounterReset < matlab.System & matlab.system.mixin.Propagates

   % CounterReset Count values above a threshold

    

   properties

      Threshold = 1

   end

  

   properties (DiscreteState)

      Count

   end

  

   methods (Access = protected)

      function setupImpl(obj)

         obj.Count = 0;

      end

    

      function resetImpl(obj)
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         obj.Count = 0;

      end

    

      function y = stepImpl(obj,u1,u2)

         % Add to count if u1 is above threshold

         % Reset if u2 is true

         if (u2)

            obj.Count = 0;

         elseif (u1 > obj.Threshold)

            obj.Count = obj.Count + 1;

         end

         y = obj.Count;

      end

    

      function [sz,dt,cp] = getDiscreteStateSpecificationImpl(~,name)

         sz = [1 1];

         dt = 'double';

         cp = false;

      end

      function dataout = getOutputDataTypeImpl(~)

         dataout = 'double';

      end

      function sizeout = getOutputSizeImpl(~)

         sizeout = [1 1];

      end

      function cplxout = isOutputComplexImpl(~)

         cplxout = false;

      end

      function fixedout = isOutputFixedSizeImpl(~)

         fixedout = true;

      end

   end

end

See Also
matlab.system.mixin.Propagates | getDiscreteStateSpecificationImpl

More About
• “What Are Mixin Classes?” on page 12-87
• “Subclassing Multiple Classes”
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Use Update and Output for Nondirect Feedthrough

This example shows how to implement nondirect feedthrough for a System object using
the updateImpl, outputImpl and isInputDirectFeedthroughImpl methods.
In nondirect feedthrough, the object’s outputs depend only on the internal states and
properties of the object, rather than the input at that instant in time. You use these
methods to separate the output calculation from the state updates of a System object.
This enables you to use that object in a feedback loop and prevent algebraic loops.

Subclass from the Nondirect Mixin Class

To use the updateImpl, outputImpl, and isInputDirectFeedthroughImpl
methods, you must subclass from both the matlab.System base class and the
Nondirect mixin class.

 classdef IntegerDelaySysObj < matlab.System & ...

   matlab.system.mixin.Nondirect

Implement Updates to the Object

Implement an updateImpl method to update the object with previous inputs.

methods (Access = protected)

   function updateImpl(obj,u)

      obj.PreviousInput = [u obj.PreviousInput(1:end-1)]; 

   end

end

Implement Outputs from Object

Implement an outputImpl method to output the previous, not the current input.

methods (Access = protected)

   function [y] = outputImpl(obj,~)

      y = obj.PreviousInput(end);

   end

end

Implement Whether Input Is Direct Feedthrough

Implement an isInputDirectFeedthroughImpl method to indicate that the input is
nondirect feedthrough.

methods (Access = protected)
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   function flag = isInputDirectFeedthroughImpl(~,~)

      flag = false;

   end

end

Complete Class Definition File with Update and Output

classdef intDelaySysObj < matlab.System &...

     matlab.system.mixin.Nondirect &...

     matlab.system.mixin.CustomIcon

   % intDelaySysObj Delay input by specified number of samples.

   properties

      InitialOutput = 0;

   end

   properties (Nontunable)

      NumDelays = 1;

   end

   properties (DiscreteState)

      PreviousInput;

   end

   methods (Access = protected)

      function validatePropertiesImpl(obj)

         if ((numel(obj.NumDelays)>1) || (obj.NumDelays <= 0))

            error('Number of delays must be positive non-zero scalar value.');

         end

         if (numel(obj.InitialOutput)>1)

            error('Initial Output must be scalar value.');

         end

      end

      function setupImpl(obj)

         obj.PreviousInput = ones(1,obj.NumDelays)*obj.InitialOutput;

      end

      

      function resetImpl(obj)

         obj.PreviousInput = ones(1,obj.NumDelays)*obj.InitialOutput;

      end

      

      function [y] = outputImpl(obj,~)

         y = obj.PreviousInput(end);

      end

      function updateImpl(obj, u)

         obj.PreviousInput = [u obj.PreviousInput(1:end-1)]; 
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      end

      function flag = isInputDirectFeedthroughImpl(~,~)

         flag = false;

      end

   end

end 

See Also
matlab.system.mixin.Nondirect | isInputDirectFeedthroughImpl |
outputImpl | updateImpl

More About
• “What Are Mixin Classes?” on page 12-87
• “Subclassing Multiple Classes”
• “System Object Input Arguments and ~ in Code Examples” on page 12-86
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Enable For Each Subsystem Support

This example shows how to enable using a System object in a Simulink For Each
subsystem. Include the supportsMultipleInstanceImpl method in your class
definition file. This method applies only when the System object is used in Simulink via
the MATLAB System block.

Use the supportsMultipleInstanceImpl method and have it return true to indicate
that the System object supports multiple calls in a Simulink For Each subsystem.

methods (Access = protected)

   function flag = supportsMultipleInstanceImpl(obj)

       flag = true;

   end

end

View the method in the complete class definition file.

classdef RandSeed < matlab.System

% RANDSEED Random noise with seed for use in For Each subsystem

  

    properties (DiscreteState)

       count;

    end

    

    properties (Nontunable)

       seed = 20;

    end

    

    properties (Nontunable,Logical)

       useSeed = false;

    end

   methods (Access = protected)

       function y = stepImpl(obj,u1)

         % Initial use after reset/setup 

         % and use the seed

         if (obj.useSeed && ~obj.count)

             rng(obj.seed);

         end

         obj.count = obj.count + 1;

         [m,n] = size(u1);

         % Uses default rng seed

         y = rand(m,n) + u1;
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       end

      

      function setupImpl(obj)

          obj.count = 0;

      end

      function resetImpl(obj)

          obj.count = 0;

      end

       

       function flag = supportsMultipleInstanceImpl(obj)

         flag = obj.useSeed;

       end

   end

end

See Also
matlab.System | supportsMultipleInstanceImpl



 Methods Timing

12-83

Methods Timing

In this section...

“Setup Method Call Sequence” on page 12-83
“Step Method Call Sequence” on page 12-83
“Reset Method Call Sequence” on page 12-84
“Release Method Call Sequence” on page 12-85

Setup Method Call Sequence

This hierarchy shows the actions performed when you call the setup method.

Step Method Call Sequence

This hierarchy shows the actions performed when you call the step method.
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Reset Method Call Sequence

This hierarchy shows the actions performed when you call the reset method.
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Release Method Call Sequence

This hierarchy shows the actions performed when you call the release method.

See Also
releaseImpl | resetImpl | setupImpl | stepImpl

Related Examples
• “Release System Object Resources” on page 12-34
• “Reset Algorithm State” on page 12-21
• “Set Property Values at Construction Time” on page 12-19
• “Define Basic System Objects” on page 12-5

More About
• “What Are System Object Methods?”
• “The Step Method”
• “Common Methods”
• “Common Methods”
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System Object Input Arguments and ~ in Code Examples

All methods, except static methods, expect the System object handle as the first input
argument. You can use any name for your System object handle. In many examples,
instead of passing in the object handle, ~ is used to indicate that the object handle is
not used in the function. Using ~ instead of an object handle prevents warnings about
unused variables.
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What Are Mixin Classes?

Mixin classes are partial classes that you can combine in various combinations to form
desired behaviors using multiple inheritance. System objects are composed of a base
class, matlab.System and may include one or more mixin classes. You specify the base
class and mixin classes on the first line of your class definition file.

The following mixin classes are available for use with System objects.

• matlab.system.mixin.CustomIcon — Defines a block icon for System objects in
the MATLAB System block

• matlab.system.mixin.FiniteSource — Adds the isDone method to System
objects that are sources

• matlab.system.mixin.Nondirect — Allows the System object, when used in the
MATLAB System block, to support nondirect feedthrough by making the runtime
callback functions, output and update available

• matlab.system.mixin.Propagates — Enables System objects to operate in the
MATLAB System block using the interpreted execution
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Best Practices for Defining System Objects

A System object is a specialized kind of MATLAB object that is optimized for iterative
processing. Use System objects when you need to call the step method multiple times
or process data in a loop. When defining your own System object, use the following
suggestions to help your code run efficiently.

• Define all one-time calculations in the setupImpl method and cache the results in a
private property. Use the stepImpl method for repeated calculations.

• If properties are accessed more than once in the stepImpl method, cache those
properties as local variables inside the method. A typical example of multiple property
access is a loop. Iterative calculations using cached local variables run faster than
calculations that must access the properties of an object. When the calculations for
the method complete, you can save the local cached results back to the properties of
that System object. Copy frequently used tunable properties into private properties.
This best practice also applies to the updateImpl and outputImpl methods.

In this example, k is accessed multiple times in each loop iteration, but is saved to the
object property only once.

function y = stepImpl(obj,x) 

  k = obj.MyProp; 

  for p=1:100 

    y = k * x; 

    k = k + 0.1; 

  end 

  obj.MyProp = k; 

end 

• Do not use string comparisons or string-based switch statements in the stepImpl
method. Instead, create a method handle in setupImpl. This handle points to a
method in the same class definition file. Use that handle in a loop in stepImpl.

This example shows how to use method handles and cached local variables in a loop
to implement an efficient object. In setupImpl, choose myMethod1 or myMethod2
based on a string comparison and assign the method handle to the pMethodHandle
property. Because there is a loop in stepImpl, assign the pMethodHandle property
to a local method handle, myFun, and then use myFun inside the loop.

classdef MyClass < matlab.System

  function setupImpl(obj)

    if strcmp(obj.Method, 'Method1')
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      obj.pMethodHandle = @myMethod1;

    else

      obj.pMethodHandle = @myMethod2;

    end

  end

  function y = stepImpl(obj,x)

    myFun = obj.pMethodHandle;

      for p=1:1000

        y = myFun(obj,x)

      end

    end

  end

  function y = myMethod1(x)

    y = x+1;

  end

  function y = myMethod2(x)

    y = x-1;

  end

end

• If the number of System object inputs does not change, do not implement the
getNumInputsImpl method. Also do not implement the getNumInputsImpl
method when you explicitly list the inputs in the stepImpl method instead of using
varargin. The same caveats apply to the getNumOutputsImpl and varargout
outputs.

• For the getNumInputsImpl and getNumOutputsImpl methods, if you set the return
argument from an object property, that object property must have the Nontunable
attribute.

• If the variables in a method do not need to retain their values between calls use local
scope for those variables in that method.

• For properties that do not change, define them in as Nontunable properties.
Tunable properties have slower access times than Nontunable properties

• Use the protected or private attribute instead of the public attribute for a
property, whenever possible. Some public properties have slower access times than
protected and private properties.

• Avoid using customized step, get, or set methods, whenever possible.
• Avoid using string comparisons within customized step, get, or set methods,

whenever possible. Use setupImpl for string comparisons instead.




